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Ben Hawkins, Editor

80 Discover why primes 

are best for portraits 

30 Use a wider range of 

techniques for wildlife 

112 Six high-resolution 

cameras go head to head

Choose from print, digital and combo 

deals and get Practical Photography

delivered to your door for less p54

Subscribe now &  
get 13 issues free! 

Learn 
from 
the 
best

Tejas Soni
Believing you can 

only shoot nature 

once you’ve become 

one with it, Tejas’ 

gorgeous flamingo 

image required 

hours of fieldcraft.  

Turn to p66

Dina Belenko
A conceptual still life 

photographer with a 

love of lists, Dina has 

created a portfolio 

of magical images 

inspired by her vivid 

imagination. Step 

into her world on p48

Olivia Acland
Olivia’s personal 

photo project is 

helping homeless 

children in Sierra 

Leone to receive a 

better standard of 

life and education.  

Turn to p92

H
ow many times have you 
looked at another photographer’s 
work and said, “I wish I’d taken 
that”? I must say it a hundred 
times while working on every 
new issue, and it’s a common 

thread that runs through the one you’re reading 
now. This month’s centrepiece, Build your own 
wildlife portfolio (page 30), features an entire 
gallery’s worth of ‘I wish I’d taken that’ images, 

courtesy of the world’s most talented wildlife photographers. It also 
dispels the myth that wildlife is an impenetrable subject for us mere 
mortals. It’s not, and we’ve identified the key techniques that will 
allow you to master every conceivable type of shot, from leaping 
squirrels to minibeast close-ups. Elsewhere in this issue we’ve got an 
incredibly powerful My photo project (page 92), which will tug at your 
heartstrings and hopefully encourage you to dig deep. Over to you...

Meet this month’s 

world-class experts
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If the CD is damaged or contains the wrong 
content, please return the disc to: Practical 
Photography, Bauer Media, Media House, Lynch 
Wood, Peterborough, Cambs, PE2 6EA. Email us 
at practical.photography@bauermedia.co.uk

Contact us if you have
issues with your disc

YourFreeCD

1Behind the scenes 
Georgie demonstrates how to get 
natural-looking candids, as a model 

gets ready for a fashion shoot at the beach. 

2 Vintage fashion  
Louise uses retro props and an 
85mm prime lens to infuse a stylish 

portrait shoot with a suitably 1960s vibe. 

3 Summer triptych  
Ben gets the hair dryer out (!) as he 
photographs melting ice lollies to 

create a colourful summer-themed series.

4 Bad weather challenge 
We’re not always blessed with 
glorious sunshine in the UK, so Tim 

goes off-piste on a soggy scenic shoot to 
tackle a more creative challenge instead.

Interactive Guide

Over 45 minutes of expert hands-on photo lessons 
and tutorials to help you shoot better pictures...

Plus More amazing free gifts on your CD
Complete 
Camera Guide
We’ve completely 
revamped our buyer’s 
guide, which features 
prices, key specs and 
concise reviews of 
every interchangeable 
lens camera on the 
market. This guide is 
updated every issue 
and will help you buy 
the best cameras. 

Photoshop Actions
Sharpen your images in a single click with this 
month’s exclusive Photoshop Actions bundle. 
There are 16 presets to choose from!

Photoshop tutorial
Learn how to add impact to your wildlife 
pics by increasing the size of the subject 
while maintaining sharpness and detail. 

Expert tuition

Shooting advice Pro hints & tips

Camera skills

Watch exclusive videos in the full print & 

iPad editions of Practical Photography 

magazine – Available now priced £3.99

Please note: Accompanying video content is only available on 

the iPad and Kindle Fire HD versiosn of Practical Photography 

as sold via the Apple and Amazon App Stores / Newsstands, 

or alternatively it is available on the free CD accompanying 

each monthly print magazine. Video content is not currently 

available on or for the Practical Photography digital editions, 

as sold on these platforms: Google Play Newsstand;  

Google Play Apps; Zinio; Readly; Kobo. Subsequently, please 

note that the ‘Lite’ digital versions on these platforms are 

discounted to take this into account.

If you have any questions about any of our digital editions 

please email digitalsupport@bauermedia.co.uk and we will 

endeavour to answer as quickly as possible.



Amongst the mire, nestled 

firmly in the bosom of 

innovation, is a small tripod 

solution from Stagsden, 

England, furiously clawing 

at the edge of aspiration, 

wading through a field of 

curmudgeonly used-to-be’s, 

inhabiting a disparate planet 

of free-thinkers.

Built to enable. Created to inspire.

So put down your 

flagging has-beens, 

look up from your 

disillusion, and see what 

we have achieved, 

with nothing more than 

a desire to be better, to 

be truer to our industry. 

It is time, without 

question, to embrace a 

new dawn, for we are 

here to stay.

Designed & 

Engineered in 

Stagsden, England

The Equinox Range

www.3leggedthing.com

Not all tripods are the same...

Product shown is 3 Legged Thing Equinox Albert Kit



The story behind the world’s greatest shots
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Strawberry greenhouses
by Leyla Emektar

l a few years ago i was walking around 
my home village and we came across some 
colourful strawberry greenhouses. I recently 
organised a trip to a different area to shoot the 
greenhouses there, but they didn’t have the 
same colours. When I was editing the pictures 
I changed the colours in order to match what 
I had originally been hoping to shoot.
Canon 7D | 70mm | 1/250sec | f/13 | ISO 100 

Leyla Emektar is a visual arts 

teacher in Kandira, Turkey. She 

has achieved several national  

and international awards with  

her photography. 

500px.com/leylaemektar
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Tunisian mausoleum
by Nabil Zouari

l  this photo shows a part of the 
mausoleum of Sidi Ali Ariane in Testour, 
Tunisia. These mausoleums, which exist 
everywhere in Tunisia, house the tombs of 
good pious people or patron saints. These 
saints are famous for their great worship and 
charity, which is why they gain people’s 
affection and admiration. People still visit 
these tombs believing that they’ll be blessed. 
Nikon D5100 | 38mm | 1/640sec | f/4.5 | ISO 200 

Nabil Zouari is a photographer 

from Bizerte, Tunisia. He enjoys 

shooting environmental 

portraiture, landscapes and 

architecture photography. 

500px.com/nabilos007
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Inle Lake fisherman
by Zay Yar Lin

l i love travelling and inle lake is a 
beautiful scenic spot for photography in 
Myanmar. It’s best to shoot in winter time, 
because the lake is misty and the light is so 
dramatic. My friend took me to this place 
where there is a high bamboo stage for 
photographers. I got there early in the 
morning and saw some fishermen preparing 
for their day. As the sun rose, the scene 
became more alive and I took this shot of a 
man fishing in the beautiful mist.
Nikon D750 | 23mm | 1/320sec | f/4 | ISO 200 

Zay Yar Lin is a freelance 

photographer from Myanmar.  

He enjoys several kinds of 

photography, but his speciality  

is travel photography. 

500px.com/jz007007
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Fragile sky
by Amelie Satzger

l i took this photo when i was on holiday 
in France last year. I was lucky enough to have 
an abandoned villa right next to the place 
where we were staying. I found this broken 
window that was made out of mirror, so I took 
a self-portrait there. For me, this picture 
stands for breaking through the beautiful 
illusion of someone or something – to break 
free and see the true colours instead of the 
glorification you had in your mind.
Canon 60D | 35mm | 1/2500sec | f/2 | ISO 200 

Amelie Satzger is a 20-year-old 

photographer from Munich in 

Germany. She enjoys exploring the 

connection between nature and 

man in her own conceptual world. 

ameliesatzger.com
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10Clicks
What to shoot with your camera right now

l The summer months bring 

with them an explosion of 

colour, as the natural world 

bursts vividly into life. This 

phenomenon happens every 

year, but sometimes all the 

elements align at once to 

produce unusually jaw-dropping 

landscapes that take your 

breath away. When nature is  

in full bloom it’s the perfect 

opportunity to grab your 

camera and shoot some 

colour-rich landscape images, 

like this vibrant and striking 

shot by Lisa Holloway.

“This image was taken as 

part of a shoot I did with my 

daughter, in an amazing field of 

wild flowers in the Arizona 

desert. The conditions have to 

be just right to get a bloom this 

magnificent, and these were 

just amazing! 

“I shot it with my Canon 5D 

MkIII and 85mm f/1.2L lens at 

f/2.2. Most of the images I took 

at this location were captured 

using a 200mm lens, but I 

wanted to go a little wider for 

some of the shots in order to 

give a better view of this 

spectacular field of flowers. 

This image was captured at 

sunset and I only used the 

natural light. 

“I shot one exposure for my 

subject and foreground and 

another to capture the sun 

setting in the sky, then 

combined them in Photoshop 

for the composite you see here. 

After this, I enhanced the 

colour and contrast. 

“My work is heavily inspired 

by the colours and textures in 

nature, so this scene was just 

amazingly beautiful to me.”

Lisa Holloway is an internationally 

published and award-winning fine art 

photographer who resides in 

north-west Arizona in the US. She 

particularly enjoys capturing portraits.

ljhollowayphotography.com

1 Capture a riot of colour
Fill your frame with magnificent summer blooms

What you need

85mm lens  

Shallow depth- 

of-field

How to do it

While 85mm lenses 

are a great option for 

head-and-shoulders 

portraits, they can 

also be used for wider environmental 

portraits like Lisa’s. The narrow aperture 

gives this image a sense of depth that 

wouldn’t have been so obvious with a 

larger depth-of-field. In order to draw 

attention to your subject like Lisa has 

done, you must make sure that your focal 

point is perfectly in focus.
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What you need

Bath Reflector 50mm prime lens 

How to do it

You can use your bath at home to produce images like 

Gabriele’s. However, bathrooms don’t often have a lot of 

natural light, so use a reflector to avoid unwanted shadows in 

your image. There are a variety of lenses that work really well 

for portrait photography, and if you’re on a budget, try 

investing in a relatively cheap 50mm prime lens. This will help 

ensure maximum sharpness in your image without breaking the bank.

Find hidden depths 
Use water creatively to suggest emotions

2
l the human face is one of the best 
tools a photographer can use. With its 
ability to express a wide range of 
emotions, there’s nothing quite like it. By 
incorporating extra elements into your 
photography, like Gabriele Corni, you 
can take a great portrait to the next level. 

“The images I capture are intended to 
be true snapshots of individuals, where 
the water that surrounds them 
represents everyday life and the parts of 
it that can confuse and take the breath 
away. The subjects I photograph are 
people of any age and background, from 
professionals to students to refugees. 

“One of the things I was inspired by 
was the drive to portray people as 

breathless. I believe that when we’re 
without breath we are forced to abandon 
every perfect projection of ourselves. 
The awareness of a portrait being taken 
vanishes completely because of the 
compelling and fundamental desire to 
breathe.” By using water in his work 
Gabriele was able to coach his models to 
access their deeper emotions in a way 
they may not have done under normal 
circumstances. 

Gabriele Corni is an 

advertising and fashion 

photographer from Bologna, 

Italy. He is currently working 

on his apnea project.

lelecorni.com
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What you need

70-200mm zoom lens Fast shutter speed

How to do it

Shooting a fast-moving object is hard enough, but when your 

subject is smaller than your hand then the real difficulty starts. 

Smaller mammals tend to be skittish and easily spooked, so it’s 

likely that you will be waiting for a while for them to appear. 

However, this means that you have the time to perfect your 

settings. One of the reasons Matt’s shot is so successful is that 

there are no distracting factors intruding on his image – he used 

a shallow depth-of-field to throw all of the attention on the 

mouse. Another way to show off your subject is to try using a 

relatively fast shutter speed like 1/250sec. This will let you 

freeze the animal, while still capturing a sense of dynamic 

movement, just like the dandelion seeds in Matt’s image. 

l with so much exotic wildlife on 
offer in lands closer to the equator, it 
may feel like British animals can pale in 
comparison to their flamboyantly 
colourful or thrillingly dangerous 
counterparts. However, Matt Binstead 
has set out to prove that British wildlife 
shouldn’t be discounted just yet...

“I’m the head keeper of the British 
Wildlife Centre in Surrey, and I’m 
always looking for new ways to 
photograph our animals to show British 
wildlife at its beautiful best. I thought it 
would be nice to photograph a harvest 
mouse sat on top of a dandelion, in order 
to show how light Britain’s smallest 
mammal really is. I placed the mouse at 
the base of the stem, as I knew he would 
climb up. I set him up in natural light and 
used my 70-200mm lens at full length 
and set my aperture to f/5.6 to really blur 
the background. As he reached the seeds 
and climbed through they started to fall. 
I waited until his head appeared out of 
the top of the seeds and then took a few 
shots. I was lucky that one of the seeds 
was still falling, adding to the image and 
showing that the mouse had disturbed 
them. I think it’s these little differences 
that make a photograph stand out.”   

Matt Binstead is the head 

keeper at the British Wildlife 

Centre, where he lives and 

works looking after a range 

of animals found living wild 

in Great Britain. 

500px.com/sweetmart

Celebrate
local nature
Look closer to home  

3
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l spending days on end searching for the 
perfect location may not always be the most 
thrilling aspect of photography, but it can 
ultimately turn out to be time well spent. 
Eric Dufour has been working as a full-time 
photographer for many years and has a 
wealth of tips and tricks on how to capture 
the perfect architecture shot.

“I like to work in major European cities, 
especially in Germany, Italy, Denmark and 
France, where I can discover many examples 
of modern architecture. 

“When it comes to photographing 
buildings, location scouting is a necessary 
step. It’s also very important to find the best 
angle and distance in order to avoid distorting 
the perspective as much as possible. Even 
with a specialist tilt & shift lens it’s best to 
avoid tilting the camera up. I find that field
scouting can take anything from a few hours 
to many days. 

“Another important thing to consider is to 
avoid high noon sun coming from above, 
because it’s preferable to have uniform light 

on the facade. The use of repetition, symmetry 
and geometric shapes are all important 
elements for a successful shot. In my own 
photography I often seek simplicity that has 
a graphic aspect and a minimalist aesthetic.”

Eric Dufour is a self-taught 

photographer who has had a 

taste for photography since 

childhood. He enjoys taking 

minimalist architectural shots.  

500px.com/ericd

Shoot geometric architecture
Turn modern cityscapes into your own photographic playground 4
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What you need

70-200mm lens

Multiple visits 

How to do it

When location scouting, you 

may think that you have 

found the most magnificent 

building and you can’t wait to 

photograph it. However, don’t 

rush into taking shots before 

you’ve considered what the 

building will look like in all 

kinds of different light. As Eric advises: “Do not 

hesitate to visit at different times, to try to 

make the best of the subject that is to be 

photographed.” Use a 70-200mm zoom lens to 

reduce distortion and to get closer to your 

subject without physically moving. 

lWhen you’re dealing with nervous 

animals like wild boar, it’s best to put as 

much preparation and planning into 

your shot as possible, like Edwin Kats.

“Since I was a kid I have always been 

fascinated by wild boar – and there are 

certainly a lot of them where I live in the 

Netherlands. However, while there are 

plenty around, the wild boar is not an 

easy animal to photograph. By feeding 

them a few handfuls of corn every day 

at the same time I was able to lure them 

into my preferred spot, where the 

foreground and background made a 

nice soft frame around the animal. 

“When I’d first picked my spot I’d 

built my hide and left an old coat so that 

they could get used to the smell of a 

human. It normally takes about two 

weeks for the boars to get used to me. 

Once they’re pretty calm around my 

presence they can come as close as 3ft. 

I always shoot wide open at f/4 to 

create that soft background and get the 

fastest shutter speed available.”

Plan for success
Spend time upfront to get the perfect shot

5
What you need

Camouflage net

Telephoto lens  

How to do it

Just like Edwin, your main 

priority should be to get the 

animals used to your presence, 

but once you have them in your 

sights you will want a good 

telephoto lens to capture them 

with. Edwin uses a 500mm lens 

to get even closer to the action. 

While these lenses can be on 

the expensive side, it’s worth 

renting one out for a weekend to 

see if it’s worth the investment. 

Edwin Kats is a 

Netherlands-based and 

regularly published 

photographer. He sells 

his images worldwide 

and leads photo trips.

edwinkatsphotography.com
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What you need

ND filter  

Long shutter speed 

How to do it

If you’re interested in shooting landscapes, an ND 

filter will become a necessary tool in your kit bag. By 

slowing down your shutter speed you will be able to 

create that milky effect that you can often see in 

modern waterscape photography. In Hengki’s shot, 

the ship immediately grabs your attention. By getting 

rid of any definition in the sky and water, Hengki has 

ensured that the rich tones of the ship stand out 

clearly from the greyscale of the sea.

Create a sense of atmosphere
Use long exposures to produce minimalist skies and serene results

6
l there’s always the temptation
to pull out all the stops for your
images, but you’ll often find that the
simpler and more minimalist your
photo is, the better it looks. Hengki
Koentjoro (hengki-koentjoro.com)
created this clean image by using an
ND filter to slow down the elements,
so the ship could shine through.

“This image was taken at Java
Island in Indonesia. I had to wait for
the low tide so that I could get close
to the ship, as I only had an 80mm

lens on me at the time.
“Iwantedtocreateanatmospheric

photograph filled with tranquillity.
To achieve this mood I used a long
exposure technique, which made the
surface of the water very smooth.
A 16-stop ND filter was used to slow
the exposure down to 1 minute. This
was long enough to smooth the
surface of the water, especially with
a calm ocean.

“I love this style, as it really shows
that less is more.”

l Capturing the hollow of a wave is on a lot of 

photographers’ wishlists, but Dylan Fox (dylanfox.com.au) 

added an extra dimension by using the setting sun to 

backlight an overhead wave. “Swimming with underwater 

housing is challenging and so is holding a position where 

you will get under the wave just before it breaks. Ideally I 

end up in the hollow of the wave as it breaks, but strong 

backwash and rips can make that tricky most days.” 

Catch a wave
...for powerful results

7

What you need

Experience swimming in the sea

How to do it

If you want to shoot in the sea you need to be a 

strong swimmer. Sea conditions can change quickly 

and catch out even those with plenty of experience. 
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What you need

Plain-coloured clothing

Photoshop  

How to do it

When you’re sourcing items of clothing for a shoot like this you’ll 

want to be on the lookout for plain clothes without any logos or 

patterns. Try visiting charity shops for some low-budget options. 

Remember that you can always turn up the saturation levels on 

your camera for punchier results. 

l when it comes to the art of 
camouflage, Bo Bruegelmans has 
perfected it. Usually your model 
disappearing into the background 
would be a cause for concern, but
Bo has cleverly flipped our usual 
assumptions on their head to 
create this unusual photo series.

“These images are part of a 
conceptual series made for a 
school assignment. It’s inspired 
by the idea of society pressuring 
us to be unique. Yet we don’t 
want to be an outsider, so we 
adapt ourselves to the norms and 
values of our communities. We 
often express ourselves by the 
clothes we wear, but a lot of 
people still just seem to disappear 
into the crowd –despite their 
efforts to be unique. 

“The first thing I did was 

location scouting. The buildings 
needed to have a good colour 
scheme and it had to be possible 
to put people in front of them. 
After that, the models and I went 
through their wardrobe to find 
clothes that  matched the 
buildings. Positioning the models 
was a bit tricky sometimes. It
wasn’t easy to get a good angle
while aligning the colours of 
their clothes with those of the 
building. In post-processing 
I just adjusted the colours a bit.”

Experiment with quirky portraits 
Help your model stand out by making them blend in with their surroundings

8

Bo Bruegelmans is a 

photography student 

who enjoys 

capturing landscape 

and portraiture 

photography. 

500px.com/bobreugelmans

10Clicks
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l  when it comes to the 
British summer, we all know that 
a few months of solid and 
glorious sunshine isn’t quite on 
the cards! However, don’t let 
rainy weather stop you from
experimenting with your 
photography. Darren Lee Marsh 
didn’t... “I spend my summer 
holidays in Santander, Spain 
every year. It’s a gorgeous city, 
but as it’s on the North Atlantic 

coast it rains all year round, even 
in the summer. A few years ago, 
holed up in our apartment and 
bored during a particularly damp 
spell, I decided to put on a rain 
mac and photograph the tourists 
who were wandering around in 
the drizzle trying to make the 
best of it. Now, whenever my 
beach plans are disrupted by 
rain, I dodge the puddles while 
trying to keep my camera dry as 

I hunt for pictures. Strangely, I’ve
even got to the stage where I
hope we get a few days of heavy 
rain in August just so I can go out 
and take more rain photographs!”

Make the most of rainy days
Don’t let bad weather keep you from your shots!9

What you need

Camera protection

How to do it

Shooting in the rain can get 

you some great photos, but 

make sure you keep your 

equipment dry. If you’re 

looking to create a regular 

project like Darren, you 

might want to invest in a 

waterproof casing. However, 

these can cost up to £125, 

so if you’re looking for a 

cheaper alternative for a 

more casual shoot you may 

want to try a one-use 

raincover. You can find a 

twin-pack for just £6.

Darren Lee Marsh is 

a portrait, reportage 

and wedding 

photographer who 

is based in 

Bedfordshire.  

darrenleemarsh.net

10

10Clicks

l In the age of Photoshop it almost seems like photos can’t be trusted 

anymore, but Philip Overbuary (philipoverbuary.com) has created an 

abstract image without the use of post-processing. “I’m very curious by 

nature, and can spend hours researching new chemicals or metals for my 

own personal interest. I stumbled across the magnetic fluid Ferrofluid last 

year and I used it to create something that didn’t look like a standard 

photograph. I wanted to provoke the world’s lack of trust in photography 

and do something that people wouldn’t believe was real.”

Defy expectations
...with unusual macro images 

What you need

Ferrofluid Macro lens  

How to do it

Philip used a Schneider Kreuznach 120mm macro 

lens mounted on a Phase One 645DF to shoot the 

Ferrofluid, which gave him a large resolution. He 

cropped his images afterwards, which meant that he 

didn’t have to worry about interfering with the light 

sources by being too physically close.



Bring out the beautyBring out the beauty
OCF Beauty Dish

The new OCF Beauty Dish is a collapsible and more portable
version of the classic Profoto Beauty Dish. When is comes to
bringing out the beauty of your subject, it is second to none.

Learn more: profoto.com/offcameraflashLearn more: profoto.com/offcameraflash
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O
ver the last few years 
I’ve learned that the 
success of my endeavours 
isn’t solely down to me. It’s 
a c t u a l l y  a l l  a b o u t 
teamwork. You see, it 

doesn’t matter how creative, enthusiastic or 
skillful I am if the people in front of the 
camera aren’t 100% on board. You might 
wonder why anyone would pay for a 
professional if they didn’t truly want to be 
photographed, but it’s very common for 
people to dread the process or 
for there to be one person who 
isn’t as interested as the rest (the 
groom/an impatient toddler...). 

So much of the success of 
portrait photography lies in the 
expression or body language of the subject. 
Photographers seem to think that they’re 
responsible for everything – l ight, 
composition and mood – which to a large 
extent they are. But it takes a very willing 
actor to mask boredom or self-consciousness. 

Luckily many of my clients these days are 
photographers. Initially I found the prospect 
of shooting for another pro daunting, but now 
I love it! I’m all for full collaboration, sharing 
of ideas and pushing the point that the results 
will be down to the success of the team.  

Take Jess and Rob, for example. I met Jess 
a couple of years ago when she contacted me 
about some mentoring and I helped her get 
her photography business off the ground. 
Rob, her boyfriend, is a cinematographer like 
my husband, Brent, so we have a lot in 
common and have quite a lot of fun when we 
get together. They got in touch to book a 
shoot for various reasons, but largely because 
they spend their time creating memories for 
everyone else and have very few images of 
them as a couple.

As we shared ideas and discussed the 
shoot it became clear that we were all on the 
same page. They wanted a real mix of styles – 
from very natural lifestyle to some shots with 
a more editorial edge. I was watching the 
weather leading up to the day and the forecast 
was very mixed, with the promise of both sun 
and rain. As a result we planned the shoot 
carefully and headed out early in the morning 
to make the most of the sun while it was still 
low enough in the sky. 

Directing them both was straightforward 

because I’m able to explain exactly what I’m 
after and they just get it. They both understand 
the importance of expressing love and 
intimacy on camera in a natural and genuine 
way. After an hour or so we headed indoors 
and focused on images that were more 
editorial and had an entirely different feel.  

Towards the end of the shoot I knew that 
I wanted to make a suggestion that would 
involve them getting both cold and wet. 
Although I joke with my clients that working 
with me can be a health and safety hazard, 

I’m actually very careful to not 
push people beyond a comfort 
zone. Not so on this shoot.

When I told them what I 
wanted, they looked at each 
other and said, ‘Only if you let 

us have a hot shower and make us a cup of 
tea’. Which I did. For those that are interested, 
the rain image was shot at about 3pm on a 
May afternoon, with two off-camera flashes. 

As it turns out, my next four shoots are 
with photographers, so it looks like there will 
be plenty of adventures ahead!

“It doesn’t matter how creative I am 
if my subjects aren’t 100% on board”

Kate Hopewell-Smith
Adventures of a lifestyle photographer Teamwork

Kate Hopewell-Smith is one of the UK’s leading 

lifestyle and wedding photographers, as well as 

a Nikon ambassador. katehopewellsmith.com 

& trainingbylumiere.co.uk 
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W
h y  b u g s ?  i t ’s  a 
question I’m often 
asked and I understand 
why. Let ’s face it , 
creepy crawlies aren’t 
generally considered to 

be the most photogenic or glamorous of 
subjects. Invertebrates will never have the 
popularity or appeal of things feathered or 
furred, so why do I shoot them? Well, in 
close-up, insects are actually pretty cool, and 
range from stunningly beautiful and vividly 
colourful, to grotesque and 
alien-like. In close-up you can 
reveal exquisite detail and design 
that we’re otherwise oblivious to. 

As a kid, it was never my 
intention to shoot close-ups – 
I had my sights set on bigger things. However, 
without the budget to buy a long lens, I had 
no option but to give it a go. I started out using 
a close-up filter, costing five quid, attached to 
a standard 50mm lens and the results were 
fine. You don’t have to go to the Masai Mara 
to find great subjects – you’ll find plenty in 
your own back garden or a local pond.   

The problem with insects is that it’s much 
harder to capture interesting shots. With 
larger wildlife, you can capture all types of 
behaviour, for example, courtship, flight or 

predation. You can capture expression, fear, 
elegance, pride and aggression – the list goes 
on. In contrast, bugs don’t really do much. 
They’re often inanimate and not renowned 
for their personalities. When they do move, 
they’re so blooming small and fast that 
capturing action shots is close to impossible 
without an elaborate, costly and immobile 
high-speed flash setup. When you add to this 
that depth-of-field is inherently shallow at 
higher magnifications, it’s no wonder that a 
good number of insect images are rather 

ordinary-looking. What do I mean by this? 
Well, most insect shots are simple studies of 
a bug clinging to a grass or flower – technically 
decent, but maybe failing to convey emotion 
or the subject’s true beauty. That’s not aimed 
as a criticism – the majority of my insect shots 
are like this too. I guess it’s just a reflection of 
how challenging the genre is. Which is why 
over the past couple of years I’ve attempted 
to shift the emphasis of my close-up work 
away from simple studies towards images that 
are aesthetically more beautiful and flowing.

In short, I want to portray my subjects in 
a different light in the hope my audience will 
make a connection with my shots – to look a 
while longer and appreciate small things big. 
How do you do this? Use of light is key, but 
the ability to capture context and to highlight 
a subject’s shape, form and delicacy is also 
significant. I’ve found backlighting is a great 
way to do this – either natural or using one of 
Manfrotto’s Lumie LED devices. I’ve also 
found inspiration in Sandra Bartocha’s work, 
as she’s a master of light, fluidity, diffusion 

and colour.  Her  images 
encouraged me to play with my 
Nikon D810’s  in- camera 
multiple exposure facility. 
While the technique is often 
hit-or-miss, it can help you 

generate truly ethereal-looking results. 
Given the technical considerations and 

subject traits, it’s pretty tricky to be innovative 
when shooting close-ups of bugs. I’m still 
learning, but I’m enjoying the journey. I’ll let 
you know how I get on…

Ross Hoddinott is an award-winning natural 

world photographer based in Cornwall. He’s 

written eight books on the subject and has won 

the inaugural British Wildlife Photography 

Awards. rosshoddinott.co.uk 

“Close-up, insects are pretty cool, 
from beautiful to alien-like”

Ross Hoddinott
Adventures of a natural world photographer A bug’s life
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PORTFOLIO

BUILD YOUR OWN

If you love photographing animals but find 

your images are lacking in variety or technical 

sophistication, maybe it’s time to rethink your 

strategy and start developing a new creative 

style. To build a portfolio that really stands out 

from the crowd, you’ll need to diversify your 

approach and start using a much wider range 

of techniques, experimenting with focal length, 

lenses, aperture, shutter speed & composition. 

Whether you’re off on a safari holiday this 

summer to capture images of lions and 

elephants, or just plan to photograph garden 

birds at home, here we’ll show you five very 

different approaches that will help you build a 

more distinctive and inventive body of work. 

With some practice, you’ll soon learn when 

to use each for the very best effect...  

WILDLIFE

Learn to freeze
the action P32

Crop in for
abstracts P38

Get the bigger
picture P44

Create a sense
of speed P36

Go macro for
minibeasts P40

Start your
portfolio P46S

te
fa

n
o

 U
n
te

rt
h
in

e
r



PRACTICALPHOTOGRAPHY.COM 31

YOUR  

COMPLETE  

GUIDE TO MORE 

STRIKING & 
UNIQUE WILDLIFE 

IMAGES

GET STARTED NOW!



P
e r h a p s  t h e  b i g g e s t 
technical challenge you’ll face 
when photographing animals 
is how to deal with movement. 
Small birds and mammals in 
particular, such as blue tits, 

squirrels and mice, are constantly on the go, 
so you’ll need to choose your camera 
settings carefully. 

In most situations, the best way to capture 
wildlife is to use a very fast shutter speed. 
This means that even when the subject is 
moving, it will appear perfectly frozen in 
your shot. To achieve these ultra-short 
exposure times, you’ll need to use a 
combination of a wide aperture and a 
medium-to-high ISO, which even on a dull 
day should allow you to achieve lightning-
fast shutter speeds of up to 1/8000sec. This 
is the maximum setting on most DSLRs, but 
you shouldn’t ever need anything faster.

Select the best settings 
It’s up to you whether you work in aperture-
priority mode, shutter-priority mode or 

manual – they’re all perfectly good options 
for this type of photography. In shutter-
priority, you can choose a specific shutter 
speed that you know is fast enough to freeze 
your subject. So if you’re shooting birds in 
flight, for example, you might need at least 
1/2000sec for pin-sharp wing tips. Once this 
shutter speed is selected it will remain the 
same for every shot, while the camera 
chooses an appropriate aperture to balance 
the exposure. 

You might instead opt for aperture-
priority mode, which will allow you to set a 
specific aperture and let the camera choose 
a shutter speed for you. This is my preference, 
as it gives you full control over depth-of-
field, though you’ll need to keep a constant 
eye on the shutter speed to ensure it’s fast 
enough, raising the ISO if necessary. 

A third option is to work in manual, 
where you control both aperture and shutter 
speed yourself. If your camera has an auto 
ISO function, you can allow it to automatically 
select an ISO setting to balance the exposure. 
Check your manual for more details. This 

third method 
gives you full
c o n t r o l  o v e r 
exposure time and 
depth-of-field, though 
it is more advanced so won’t suit everyone. 
On page 34, I recommend using aperture-
priority for your fast-action wildlife shots 
and recap the best settings to use.

Choose focal length
Animals can be extremely skittish, especially 
in the wild, so chances are you’ll need a long 
telephoto lens. This needs to be at least 
300mm, and ideally 500-600mm. Even then, 
it can be really difficult to get close enough 
for your subject to fill the frame. As a general 
rule, the longer the focal length, the more 
expensive the lens, with most 600mm 
primes costing near £10,000. This puts them 
well out of the reach of most enthusiasts. 
However, there have been several very 
affordable long telephoto zooms released in 
the past couple of years, including Sigma and 
Tamron’s 150-600mm lenses (see page 35), 
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Use a fast  
shutter speed  
to freeze action

–––

BASIC 

SKILLS

–––

Many small animals, including 

birds and squirrels, move in 

short, sharp bursts, so be 

ready to track this type 

of movement.

TipTip
 Anticipate 
 movement 



Mark Hamblin is a nature 

photographer based in the 

Cairngorms. He’s had 

several books and over 

100 articles published. 

markhamblin.com

 Work in aperture-priority 

When fast shutter speeds are important 

it’s best to shoot in aperture-priority 

mode using your lens’ maximum 

aperture. A very fast lens that goes to 

f/2.8 or f/4 will allow for the fastest 

shutter speeds, but if you are using an 

f/5.6 or f/6.3 lens you can generate the 

required shutter speed by increasing ISO. 

The wide aperture will also produce a 

shallow depth-of-field which can help 

isolate the subject from the background.

 Use a fast shooting speed 

A fast enough shutter speed will freeze 

the action, but you can increase your 

chances of a great shot by shooting in 

rapid bursts. An animal’s pose will vary 

enormously between frames so it’s best 

to use your camera’s fastest speed.  

I tend to lock off focus, then fire off a 

burst of 5-10 frames. Don’t forget to use 

a memory card with a fast write speed,  

or else you’ll be waiting a long time for 

your camera’s image buffer to empty.

 Be ready for movement 

Anticipate when an animal is about to do 

something and be prepared with the 

camera’s focus point(s) covering the eye 

– a monopod or tripod will help to keep 

the camera steady while you wait. Keep 

your finger poised on the shutter release, 

and as the animal bursts into action, pan 

the camera smoothly to keep it in focus 

and correctly framed. Press the shutter 

button as you do this, preferably using 

your camera’s fastest burst speed. 
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Expert advice
 for pin-sharp shots 
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Use continuous AF for 
sharper wildlife shots
As most animals are always 

on the move, the distance 

between them and the 

camera is constantly 

changing. This makes 

maintaining sharp focus a real 

challenge. If you’re using 

single-shot AF, take your shot 

immediately after you focus. 

In other words, press the 

shutter button fully down in 

one smooth press, rather than 

pausing halfway, as you might 

for other types of photography. 

If you don’t, the animal might 

move and drift out of the 

plane of focus. This is 

especially important if using  

a wide aperture.

Better still, use continuous 

AF, where the camera focuses 

constantly when your finger is 

half-pressed on the shutter 

button. Wherever the animal 

moves, the lens will adjust to 

keep it sharp. 

For very fast-moving 

subjects, autofocus might 

struggle to keep up, 

regardless of the AF mode 

used. Pre-focus on a particular 

point in the scene where you 

anticipate the animal will be, 

then flick to manual (MF) using 

the switch on the lens barrel. 

Then fire off a fast burst of 

shots as the animal moves 

through this point.

Train your 
attention on a 
position that 
your subject 

visits regularly.
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2
Adjust your ISO
Point your camera at the animal and 

check the shutter speed. For very 

fast-moving subjects like birds, you’ll need 

between 1/2000sec and 1/8000sec to 

freeze the movement of their wings. For 

slower subjects like elephants, 1/500sec 

should suffice. Simply adjust the ISO until 

you have the shutter speed you need.

3
Set a fast burst
To give yourself the best chance of 

getting the perfect shot, choose your 

camera’s fastest continuous shooting 

speed, which is around 5fps on most 

DSLRs. This is particularly important with 

faster-moving animals. You should also set 

the focusing to the mode of your choice 

(more on this on page 39). 

1
Use a wide aperture
Select aperture-priority mode (A or Av 

on the mode dial), and choose the 

widest aperture your lens will allow. This will 

let in the maximum amount of light for fast 

shutter speeds, helping to keep your 

subject sharp. It will also produce a shallow 

depth-of-field for a blurry background, 

which helps the subject to stand out.

Set up your camera for pin-sharp results

and Nikon’s 200-500mm f/5.6, which is 
priced at £1179. For those on a tighter 
budget, a 70-300mm is a good bet, and can 
cost as little as £98. When used on an APS-C 
DSLR such as a Canon 80D or Nikon D500, 
the effective maximum focal length is 
around 450mm. 

Don’t forget that if your lens doesn’t quite 
have enough reach, you can always crop your 
shots in post-processing – turn to page 104 
to find out how to enlarge and sharpen.

Find a location
You don’t have to travel far to find amazing 
wildlife subjects. In fact, your back garden is 
packed full of incredible photographic 
potential. Garden birds and 
squirrels are perhaps the most 
accessible animals to shoot, as 
they’re active, common, 
diurnal and easy to bait. 
A few days or weeks before 
you want to shoot, hang a 
bird feeder from a tree, and 
keep it topped up with nuts
and seed. Local wildlife will 
soon get into the habit of returning 
to this spot. Once you head outside, 
they’ll be aware of your presence, so stay as 
far away as you can and sit as quietly as 
possible. Stay near a hedge or fence rather 
than in the middle of your lawn, as they’ll
less easily recognise your shape. 

Get your shot
If you’re handholding your camera, find a 
comfortable shooting position, as you may 
be there for some time. A blanket to sit on or 

a portable camping chair 
could be a good option. 

You might also consider a 
pop-up hide to make you less 

visible. If you’re using a large, 
heavy lens, a tripod will make 

shooting easier, but only if you know your 
subject will appear in a certain place, such as 
birds on a feeder. If your tripod has a ball 
head, slacken this off so your camera pivots 
freely. Keep your camera turned on and the 
correct settings dialled in so you can react 
quickly if a shooting opportunity arises. It’s 
also worth using a fast memory card, so if you 
fire off a burst of images they’ll be written to 
the card as quickly as possible. 

Even though you’re using a very fast shutter 
speed, keep your camera as still as possible as 
you shoot, and turn on image stabilisation if 
you’re working handheld. For very fast-moving 
subjects, use a slightly looser composition as 
it’s harder to keep all of your subject in the 
frame. You can always crop it later. 

Below we check out the best camera 
settings for getting pin-sharp results, and to 
the right we look at how to keep your 
fast-moving subject perfectly in focus.

Above Capturing the animal mid-air can help 
inject a sense of energy and movement.

Right Shooting at the start or end of the day 
produces softer, more attractive lighting.

Getting to the animal’s eyelevel 

tends to produce more 

attractive results, so for 

some subjects it’s best 

to lie on the floor.

TipTip
 Get down to 

 eyelevel 
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Get the gear Three great wildlife superzooms

 Tamron 70-300mm  

£239 

Boasting a maximum aperture  

of f/4-5.6 and with image 

stabilisation built in, this budget 

zoom from Tamron  

is a great 

entry-level 

telephoto lens 

for those 

starting out. 

On APS-C 

cameras,  

the effective 

focal length  

is around 

105-450mm, 

but the lens is 

also full-frame 

compatible.

tamron.eu/uk

“Activate image 
stabilisation 

when working 
handheld”

All images by Mark Hamblin

Three great wildlife superzooms

 Sigma 150-600mm  

from £739

Sigma’s answer to Tamron’s 

successful budget long-

telephoto lens comes in 

two subtly different 

options – the 

Contemporary model 

and the Sport model. 

Both have the same 

focal length range, 

aperture range, HSM 

focus motor, and image 

stabilisation system, but 

the more expensive 

version (Sport) has a more rugged 

construction, a larger manual focus 

ring, an aluminium lens hood, better 

weather-sealing and a slightly more 

advanced optical design.

sigma-imaging-uk.com

 Tamron 150-600mm £739 

This 150-600mm is the first of a new 

generation of affordable ultra-long 

telephoto lenses, and it comes with a 

maximum aperture of f/5-6.3 and has 

both image stabilisation for blur-free 

handheld shots and an Ultrasonic Silent 

Drive for quiet focusing. The lens has a 

minimum focus distance of 2.7m and 

weighs around 2kg. Although designed 

for full-frame bodies, it’s also fully APS-C 

compatible, on which the focal length is 

225-900mm.

tamron.eu/uk
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F
reezing your subject with 
a very fast shutter speed might 
be the most common approach 
to photographing wildlife, 
but it’s not always the best way 
to convey a sense of movement. 

Sometimes, allowing a small amount of 
motion blur can inject dynamic energy 
into your images and give your work a 
different look.  

Choose the right technique
There are two broad methods for doing this. 
The first is to keep the camera completely 
still, allowing the subject to move within the 
frame. The result is a pin-sharp background 
with a blurred subject. My advice is to use 
this approach with caution, as the result can 
easily look like you accidentally selected a 
shutter speed that was too slow for the 
subject. However, in the right situation the 
results can be stunning. You might choose 
this approach when there are tens or 
hundreds of animals in the same frame, 
such as the image of the birds to the right. 

It also works particularly well when there’s 
a plain background. 

If you’re shooting a single moving animal, 
as in the image of the fox, try using the
panning technique, where you track the 
subject with your camera. This will cause the 
animal to stay more-or-less sharp, but with a 

blurred background, which is a great way of 
injecting a feeling of speed. Panning is best 
done either handheld, or using a gimbal 
tripod head that will hold the weight of the 
camera and lens but still allow free movement 
(see below). You can use a regular ball head 
tripod but it’s much more difficult to achieve 
smooth, uniform movement. If you do choose 
to handhold, keep your feet shoulder-width 
and tuck your elbows into your body. For the  
smoothest movement, pivot with your waist 
rather than your arms.

Keep your subject sharp
Put your camera into shutter-priority mode, 
as you’ll want total control over the length of 
the exposure. Choose a shutter speed of 
around 1/30sec to start with, and adjust the 
ISO so that aperture is relatively wide. You 
can adjust the exposure length depending on 
how fast the animal is moving and how much 
blur you want. The idea is to move your 
camera so that the subject’s head stays at
exactly the same position within the frame 
for the duration of the exposure. So you’ll 
need to track the animal as accurately as 
possible as it moves. Panning is very much a 

Two great gimbal tripod heads

Blur the 
motion for 
a sense 
of speed

 Beike BK-45 
 Gimbal Head £57 

This budget gimbal head with 70mm 

Arca-Swiss plate is ideal for 

sports and wildlife shooters 

who want to move their 

camera freely without 

holding a heavy telephoto 

lens. The head can support 

8kg and will 

fit onto any 

tripod with a 

3/8in thread. 

amazon.co.uk

 Benro GH2 
 Gimbal Head £284 

Offering ultra-smooth panning for lenses 

up to 600mm, the GH2 can 

hold a load of 23kg, and 

weighs 1.4kg. Complete with 

a Benro plate, it’s also 

Arca-Swiss compatible.  

A more expensive carbon 

fibre version of 

this head  

is also 

available.

benroeu.com

–––

INTERMEDIATE 

SKILLS

–––



Ben Hall is one of the  

UK’s leading wildlife 

photographers, with a 

focus on conservation. His 

work is widely published. 

benhallphoto.com

 Choose your shutter speed   

Choosing a suitable shutter speed is 

paramount for capturing motion blur. 

Shutter-priority mode will allow you to 

experiment with shutter speeds to find 

which gives the optimum results. A setting 

between 1/15sec and 1/60sec is a good 

place to start, though this will depend on 

the speed and distance of your subject, 

and the degree of blur you’d like.

 Use a fast burst 

Setting your camera to its fastest frame 

rate will allow you to fire a continuous 

burst of images. The more frames you 

fire, the more chance you have of 

capturing your subject in an engaging 

position. If you are shooting a bird in 

flight, for instance, the position of the 

wings can make or break a shot. 

 Expand your focus area 

Most DSLRs feature several different 

focusing modes. By increasing the 

number of active focus points you’ll find 

it easier to keep your subject in focus as 

you pan. Leaving plenty of space in front 

of your subject produces a more pleasing 

composition, so move the focusing area 

to one side of the frame.

 Practice panning 

When handholding (my preferred method 

when using lenses less than 500mm), 

stand with your feet shoulder-width apart 

and swivel your upper body, keeping 

your elbows tucked into your sides for 

stability. For lenses of 500mm upwards, 

Gimbal tripod heads are a great choice as 

they take all the weight out of the lens, but 

allow complete freedom of movement.
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 Expert advice
 for panning images 

Stabilisation can cause issues 

when panning, so it’s best to 

leave it off unless your lens 

has a dedicated IS 

function.

TipTip
 Turn off image 
 stabilisation 

trial-and-error technique, so don’t expect 
perfect results every time. 

If your subject is blurred, chances are 
you’ve gone too fast or too slow. However, 
this could also mean that your subject isn’t 
in focus, so be sure you choose an 
appropriate focusing method. The easiest 
way is to pre-focus on the area where your 
subject will be using AF, then switch to 

manual focus. Provided the animal isn’t 
moving towards or away from the camera, 
it should stay sharp. Alternatively, use 
continuous focusing and activate a cluster 
of focus points. Check your screen regularly 
to ensure the results are sharp. 

It’s also best to activate your camera’s 
fastest shooting speed so you can fire off a 
burst of consecutive images. 

Pan with the 
subject to  

keep them 
sharp while the 

background 
blurs.

Using a slow shutter 
speed to capture a 
hive of activity can 

create a striking, 
abstract look.
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F
inding creative and unusual 
ways to capture the beauty of 
the animal kingdom will help 
you build a more unique and 
stylish wildlife portfolio. 
One particularly eye-catching 

technique is to shoot your image with an
extremely tight composition so that only a 
small section of the subject is in the frame. 
Abstract close-ups can be a particularly 
useful approach if a wider shot simply won’t 
work – perhaps because the background is 
too messy, or the animal is standing in an 
awkward position. 

Detail shots are usually easiest to shoot in 
zoos, wildlife parks and nature reserves, as 
the animals are considerably tamer than they 
are in the wild. For larger animals such as 
hippos and elephants, you can also get close 
up without being in danger. Find out if your 
local zoo runs photography days, as you’ll be 
able to get closer to some of the animals than 
the general public.

In most cases, you’ll need a long telephoto 
lens to get the right composition, although
for smaller animals like lizards or birds, 
a macro lens might be needed if you want 

to fill the frame with the animal and eliminate 
any background. 

Choose your subject
Look out for animals with interesting skin, 
fur or feathers. This could be the rough, 
cracked texture of a rhino, the stripy hair of 
a zebra, or the bright blue plumage of a parrot. 
For a minimal-looking image, 
you might want to frame up so 
your chosen texture or pattern 
fills the entire frame, or 
alternatively you could
include an eye or beak for 
more context, as in the shot 
of the gannet to the right. 
If possible, choose an animal 
that is standing relatively still 
to give you the best chance 
of accurate focus and a blur-free 
result. This will also help you achieve
a precise composition.

Get your shot
Where possible, position yourself so that your
camera is square-on to the section of the 
animal you’re interested in. This will keep 

everything in your frame on the same focal
plane, and therefore perfectly sharp. 

It’s best to work handheld so you can react 
quickly if the animal changes position. For the 
best chance of sharp shots, tuck your elbows 
into your body and turn on image stabilisation. 
To help improve your chances of a perfect 
shot, shoot at your camera’s fastest shooting 

speed, and always work in RAW 
for extra processing control. 

To the right we check out the 
best camera settings for 
abstract close-ups.

Crop in for striking abstracts

When processing your files in 

Lightroom or Photoshop, turn 

up Clarity and Sharpness 

to reveal maximum 

detail.

TipTip
 Bring out 

 extra detail 

Where possible, position yourself so that yourWhere possible, position yourself so that your
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Laurie Campbell has won 

23 awards for his wildlife 

work, boasts a 120,000- 

strong image library and 

has authored several books.

lauriecampbell.com

 Explore your angles 

It’s easy to think that just about 

everything in nature has been 

photographed. But it’s always possible 

to produce something different. Start 

with common subjects that you have 

repeated access to and stay with them, 

experimenting with different techniques 

and abstract angles – don’t walk away 

until you’re out of ideas.

 Choose a tight composition  

When your subject allows, go in close 

and isolate the parts of it that you find 

interesting. Make your composition 

concise and exclude everything that is 

unrelated – good photography is as 

much about what you include as you 

leave out. By excluding surrounding 

features, viewers may not immediately 

recognise what they are looking at and 

curiosity may provoke them to stay 

longer to look at your images. 

 Find a unique style 

Never try to emulate or be influenced by 

techniques that you see other 

photographers using. Being a composer 

rather than a ‘cover artist’ is, after all, 

how we develop our own recognisable 

and distinctive style of working.

 Expert advice
 for better abstracts 
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1
Select your lens
If the area of skin you 

want to shoot is smaller 

than a few centimetres wide, 

you’ll need a macro lens for a 

1:1 magnification. Otherwise,  

a telephoto lens will do the job. 

Prime lenses are ideal for this 

type of image as they provide 

exceptionally sharp results 

right across the frame.

2
Choose your aperture
Set your camera to aperture-

priority mode and choose an 

aperture of around f/8. This will give 

you optimum lens quality and render 

most or all of your shot in focus. 

Select an ISO that gives you a shutter 

speed of around 1/500sec, especially 

if using a long focal length. Turn on 

stabilisation if you have it.

3
Focus your shot
Accurate focusing is vital for a 

pin-sharp result. You can use 

any focusing method, but the fastest 

and most accurate is single-point AF. 

It may struggle with low contrast 

surfaces such as dolphin skin, in 

which case, focus on a higher 

contrast area, lock focus, then 

recompose the shot.

Choose the best settings
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T
he insect kingdom provides 
a wealth of photographic 
potential, so long as you know 
how to capture it. There is a 
huge variety of minibeasts to 
be discovered in your own 

back garden, and when viewed close up they 
can display amazing colours and detail that 
can’t be appreciated with the naked eye.

Use the right gear
For truly striking close-ups where the 
subject fills the majority of the frame, you’ll 
need a dedicated macro lens. This will allow 
you to focus much closer than a regular lens, 
typically with as little as 30cm between the 
camera’s imaging sensor and the 
subject. All true macro lenses 
have a magnification ratio of at 
least 1:1, which means the 
insect is recorded life-size 
on the sensor. Some more 
advanced macro lenses, 
such as Canon’s MP-E f/2.8, 
offer a magnification of 5:1, 
which enables you to fill 
most of the frame with, say, 
a housefly’s head, with enough 
detail to see the structure of the eye. 

Your average kit lens has a magnification 
ratio of at least 1:3, so on its own is not 
suitable for insect photography. However, 
you can buy an inexpensive reversing ring 
adapter that allows you to attach it to the 
body back-to-front for much closer focusing. 
However, you lose all electronic connection

so there’s no autofocus or aperture control. 
Close-up filters are another option.

As well as a macro lens, you’ll need a 
decent tripod. This will help you achieve 
very precise focusing and use slower shutter 
speeds without the risk of  shake.  
Handholding is a better option for subjects 
which don’t hold still for long. The best macro 
tripods are those that get your camera low to 
the ground, so if you’re buying a new one, 
check the minimum working height. Some 
models let you reverse the central column so 
you can mount your camera at ground-level, 
and Manfrotto’s swinging horizontal columns 
(see below) are also great options.

Control aperture
The closer you focus on your 

subject, the narrower the 
depth-of-field becomes, so in 
macro photography the 
d e p t h  o f  p e r c e i v e d 
sharpness is sometimes less 
than 1mm. This means a 

ladybird’s head might be 
perfectly sharp, but its back 

legs completely blurred. You can 
control this problem to an extent by 

using a very narrow aperture, although this 
brings with it some issues. Most importantly, 
the higher the f/number, the less light is 
collected, so the shutter speed becomes 
slower. On dull days, this can lead to camera 
shake if shooting handheld, which is why a 
tripod is crucial. Images taken with the smallest 
apertures (usually around f/22) also suffer from 

The best kit for stunning macro

Go macro to 
capture minibeasts

Any kit lens can shoot 

close-ups, but for true 

macro you’ll need a 

dedicated macro lens with 

a 1:1 magnification ratio. 

This allows you to focus 

much closer to the subject 

so it appears life-size on the 

camera’s sensor, which is 

important for shooting 

insects. For best results, 

you’ll also need a decent 

tripod, and ideally one that 

will get your camera very 

low to the ground. We 

check out three great value 

kit options here...

 Manfrotto 190 Go!  

 with ball head £139

With a weight of 1.67kg and a 

folded length of 45cm, this 

aluminium tripod is very light 

and compact, and boasts a 

maximum height of 146cm. It’s 

particularly good for macro as 

it has a horizontal central 

column, allowing you to 

position your camera at 

very low angles. The kit 

comes with a Manfrotto’s 

popular 496RC2 ball 

head. manfrotto.co.uk
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Throwing some extra light 

onto your subject can help fill 

in shadows and increase 

colour saturation. If you 

don’t own a flash, use a 

5-in-1 reflector.

TipTip
 Use a reflector 
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Matt Cole is an award-

winning photographer with 

a specialism in macro. His 

work has appeared in a long 

list of publications.

mattcolephotography.co.uk

 Set your alarm clock 

Insects are far more approachable when 

they’re cold, so if you want to get close to 

skittish subjects such as dragonflies or 

butterflies an early start will be necessary. 

Check out long grass and reeds at the 

edges of ponds and lakes, and with a bit 

of luck you might find dew-covered 

insects that have roosted overnight.

 Use a tripod 

Photographing in early morning light 

often results in slow shutter speeds, 

particularly when using a small aperture 

to maximise depth-of-field. A tripod (or 

monopod or beanbag) will be necessary 

to avoid camera shake. Manoeuvre the 

tripod so the front of the lens is parallel 

to the subject, thereby ensuring most of 

the insect falls within the depth-of-field.

 Try adding flash 

If light levels aren’t sufficient, or if you 

would simply like to add a bit of sparkle to 

an image, then flash can be the answer. 

An external flashgun or a twin macro flash 

such as the Canon MT-24 EX or the Nikon 

R1C1 will produce the best results. To 

reduce harsh highlights, use a diffuser.

 Shoot wide-angle 

Macro photographers will often isolate 

subjects against clean backgrounds,  

but sometimes doing the opposite pays 

dividends. Fisheye or wide-angle lenses 

will often show the subject within its 

natural environment, for interesting and 

informative results. Pay close attention 

to the background, compose carefully 

and shoot against a blue sky.
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 Expert advice for  
 striking close-ups 

A dedicated macro 
lens allows you to 

focus very close up 
so the subject fills 

the frame.

 Tamron 90mm  

 f/2.8 £579 

This recently released macro lens with 

image stabilisation is suitable for both 

full-frame and APS-C bodies. It boasts 

improved image stabilisation and 

near-silent USD focusing, as well as 

full-time manual focus override. 

tamron.eu/uk

 Sigma 105mm  

 f/2.8 £329 

This popular macro lens is designed for 

both APS-C and full-frame cameras, 

and offers a magnification ratio of 1:1. 

The lens boasts image stabilisation for 

sharper handheld shots, and an HSM 

focus motor for quiet AF.

sigma-imaging-uk.com
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diffraction, which impacts on overall sharpness. 
Sacrifice a small amount of depth-of-field for a 
sharper shot by choosing f/18 instead. 

Set up your shot
Give yourself the best chance of success by 
selecting the right location and best 
conditions for your subject. If you want to 
shoot bees, work in the summer months and 
set up near brightly-coloured flowers. For 
snails, wait until after it rains. Butterflies are 
only around in the spring and summer, and 
tend to be attracted to plants such as buddleia, 
and dragonflies and damselflies are found 
near water. For smaller minibeasts such as 
woodlice and spiders, check under rocks and 
flowerpots, and work early in the morning as 
this is when insects are least active. Check out 
our recommended camera settings below... 

Set up your camera for the best macro results

Above Using 
bright, 
contrasting 
colours helps 
the subject 
stand out 
against the 
background.

Left Including 
some of the 
surrounding 
environment 
can give the 
image more 
context.

Try to avoid shooting in direct 

sunlight, which causes a high 

contrast result, often with 

overexposed 

highlights.

TipTip
 Shoot in  

 the shade 

2
Select a fast burst
In the same way as when shooting 

larger animals, the window of 

opportunity to get the perfect shot can be 

extremely short, so it’s best to fire a fast 

burst of images. To do this, activate your 

camera’s fast shooting speed, which is 

usually around 5fps. Hold in the shutter 

button for a continuous burst.

3
Focus your shot
There are several focusing options  

for macro. If you’re shooting static 

subjects from a tripod, switch to manual 

focus and activate Live View. Press the 

zoom button, then adjust the focus ring until 

the subject is sharp. For moving subjects, 

handhold your camera and use either 

single-point AF or manual focus. 

1
Choose your aperture
Set your camera to aperture-priority 

mode and select an aperture of around 

f/8. This will give a relatively fast shutter 

speed to eliminate blur, as well as a suitably 

large depth-of-field. You may also need to 

raise the ISO if the shutter speed drops 

below 1/200sec. If you want more of your 

subject in focus, use an aperture of f/16.
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Set up your camera for the best macro results
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M
ostwildlife
images are
composed so
t h a t t h e
subject fills
most or all of

the frame, as this allows the
viewer to see the subject in as
much detail as possible. But with
hardly any background in shot,
this approach means excluding
the local environment, so it’s
often hard to see the animal in
any context with its habitat. Inany context with its habitat. In
some cases, such as if you’resome cases, such as if you’re
shooting at a zoo, this might be ashooting at a zoo, this might be a
good thing, as you probablygood thing, as you probably
won’t want to give away that yourwon’t want to give away that your
image wasn’t taken in the wild.image wasn’t taken in the wild.
Similarly, your subject may beSimilarly, your subject may be
standing against a messy or
unremarkable backdrop that
doesn’t really add anything to the

shot. But if the animal is in an
attractive setting, you can use it
to help reinforce the viewer’s
understanding of the species.
This is done by opting for a much
wider composition where the
subject might only take up a tiny
proportion of the frame.

Select the focal length
As a general rule, you’ll want to
use a wide-angle lens, which
provides a large field-of-view
without you having to stand too
far away. We check out three
ultra-sharp wide-angle primes to
the right. You might decide to
position your subject very close
to the lens so that they take up a
large proportion of the frame, aslarge proportion of the frame, as
in the shot of these langurs, orin the shot of these langurs, or
alternatively they could be somealternatively they could be some
distance away.

Given that the majority of the
image is taken up by the
background, it helps to keep your
landscape photographer hat on,
paying attention to the usual
compositional rules. Try to frame
up your shot so that the animal
fallsononeofthefourpowerpoints
within the image (the areas where
horizontal and vertical thirds
intersect), and ideally have your
animal moving into the frame
rather than leaving it.

Usealargedepth-of-field
Just as when shooting a regular
landscape image, you’ll usually
want everything in the frame to
be sharp, so it’s best to choose a
narrow aperture such as f/16. Ifnarrow aperture such as f/16. If
your subject is very close to theyour subject is very close to the
lens, you might instead opt tolens, you might instead opt to
blur the background slightly to

help them stand out. However, if
it’s too blurred you’ll lose some
detail, so stick to around f/5.6.
Select an appropriate ISO to
produce a shutter speed of at
least 1/200sec, or faster if your
subject is moving. Don’t feel you
need to use a tripod for this
technique – handheld is fine
provided the shutter speed is fast
enough. You should also activate
image stabilisation if available.

It’s best to focus with single-It’s best to focus with single-
point AF, using the D-pad topoint AF, using the D-pad to
move the active point so that itmove the active point so that it
corresponds with your subject.corresponds with your subject.
This is superior to having severalThis is superior to having several
points active as it allows you topoints active as it allows you to
be more accurate.be more accurate.

Below Getting in and among
these hanuman langurs helped
produce a natural portrait with
plenty of background in shot.

Get the bigger picture
withwith environmental portraits
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Italian photographer 

Stefano Unterthiner has 

authored seven books and 

shoots regularly for 

National Geographic.

stefanounterthiner.com

 Stay local 

You don’t need to travel to exotic 

locations to get great shots – explore 

your local woods, mountains and coasts, 

or even your own garden. Take photos of 

species that you are familiar with, 

especially when shooting environmental 

wildlife portraits.

 Take your time 

Don’t expect to get amazing results  

right away. Wildlife photography is a 

waiting game, so invest lots of time  

into your work. For the best results, 

return to a certain place again and 

again. Learn how the light falls on 

the landscape at different times  

of day, and observe the wildlife 

around you. The more intimately 

you know the environment you’re 

shooting in, the better the shot 

you’ll get.

 Experiment with   

 different lenses 

Forget the lenses you usually use for 

wildlife and try something new. 

Experiment with a wide-angle so your 

subject is smaller in the frame – this will 

allow you to include the surrounding 

landscape. Don’t worry about it being 

too small! Use your body as a zoom – 

move towards and away from the subject 

to find new perspectives.

 Develop your own style 

Read, learn, then forget! You need to 

know the principles of photography but 

once you’ve mastered the basic 

techniques, you must find your own 

visual style. Don’t copy other 

photographers, but develop your own 

path. So, after having reading my tips, 

forget them and find your own way!

 Sigma 10-20mm f/3.5 £329

This compact ultra wide-angle lens is 

designed specifically for APS-C cameras, 

offering an equivalent focal length of 

15-30mm. It boasts an aperture of f/3.5 

through the entire zoom range and a Hyper 

Sonic Motor (HSM) for quiet focusing.

sigma-imaging-uk.com

Three best wide-angle lenses

 Tamron 35mm f/1.8 £499 

One of the first lenses in Tamron’s new-look 

lens range, this sleek, well-built prime is ideal 

for environmental portraits. Compatible with 

both APS-C and full-frame, it offers a wide 

maximum aperture of f/1.8. tamron.eu/uk
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If your subject becomes 

inquisitive of you or the 

camera, go with it – this 

can produce really 

striking results.

TipTip
 Encourage 
 interaction 

 Sigma 20mm f/1.4 £629 

Sigma’s latest ultra wide-angle prime 

boasts an unusually wide aperture of 

f/1.4, meaning you can include plenty of 

background in shot but still isolate the 

subject with a shallow depth-of-field. It 

can also be used on an APS-C camera. 

sigma-imaging-uk.comsigma-imaging-uk.com

 Expert advice
 for wildlife portraits 
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Getting your 
portfolio started
There are so many opportunities to capture your 
wildlife shots – start your portfolio today! 

Everyone loves those incredible shots of 

animals from all over the world. You don’t 

have to go on safari or trek through the 

desert to find your own though. Zoos can 

provide the perfect opportunity to get 

some time up-close with these animals. 

Many zoos have viewing platforms, which 

can help you to get the best view of the 

animals. However, you often have to deal 

with the difficulties of shooting through 

fences or glass. Still, you can get some 

fantastic shots at the zoo with a variety of 

subjects that you don’t see every day.

n Spending a day at the zoo will also

support their conservation and charity 

work. Check out britishzoos.co.uk  

In the UK we’re lucky to have a plethora 

of indigenous wildlife that are relatively 

easy to find. One of the best places to 

spot wildlife is at your local reserve. The 

UK is home to an assortment of reserves 

that vary from meadows to beaches and 

more. Using these reserves not only 

supports local conservation but you can 

often research what wildlife you will see 

beforehand. There are usually hides and 

viewing spots that will help you to find 

the best view of the wildlife and offer a 

place to camp out and wait for that 

perfect shot.

n Find your nearest wildlife reserve 

at wildlifetrusts.org

There are so many wildlife photography 

workshops available that it can be hard 

to choose. However, this variety means 

there will always be a workshop that’s 

perfect for you. Whether you want to 

photograph on safari, birds, or local 

wildlife, each workshop will have a 

different format. Time with an expert is 

an invaluable opportunity to learn from 

their experience. And while this can be 

the pricier option, with the range 

available there’s also a range of prices, 

so you can tailor for your budget. 

n Find a variety of workshops at 

naturalwondersphotography.co.uk

Visit a zoo 
To find exotic wildlife

Go to a reserve
For UK species

Take a workshop
To learn from a pro

A lens hood can help to 

reduce reflections in the 

enclosure glass when 

shooting at the zoo. It will 

also reduce flare, if you 

have to shoot into 

the sun.

TipTip
 Take a lens hood  
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SLR Zoom .................................... £39

Focus GP-8 .................................. £79

Ball Heads:

494RC2 ..................................£45

498RC2 ..................................£74

324RC2 ..................................£99

327RC2 ..................................£135

Anvil:

Anvil Slim................................. £189.99

Anvil Super .............................. £189.99

Anvil Pro .................................. £209.99

 Hadley: Canvas/Leather: Khaki/Tan, 

Black/Tan, Black/Black. 

FibreNyte/Leather: Khaki/Tan, Sage/

Tan, Black/Black.

Digital .................................. £109

Small ................................... £139

Large ................................... £154

  Pro Original ......................... £169

Tripod Strap Black or Tan     .... £19

 RuggedWear:

F-5XB ................................. £72

F-5XZ ................................. £99.95

F-6 ...................................... £99

F-803 .................................. £139

F-2 ...................................... £149

 Canon Lenses 

 Photo Bags & Rucksacks

 Tripods & Tripod Heads

 Nikon Lenses 

 24.3 
  megapixels

 24.2 
  megapixels

 24.3 
  megapixels

 20.8 
  megapixels

 20.9 
  megapixels

 36.3 
  megapixels

 Full Frame
Sensor

 Full Frame
Sensor

 Full Frame
Sensor

 Full Frame
Sensor

     1080p 
  movie mode

     1080p 
  movie mode

5DS Body  £2699

5DS R Body  £2899

EOS 5DS

5DS       From £2699

5D Mk III Body £2178

5D Mark III

5D Mk III £2178

  22.3 
  megapixels

 Full Frame
Sensor

 6.0 fps

50.6 
  megapixels

 Full Frame
Sensor

 5.0 fps

 6.0 fps 6.0 fps 6.5 fps

12.0 fps 10.0 fps7.0 fps

Photo Sport BP 

200 AW Black

Perfect for

carrying a DSLR 

with lens attached, 

an additional lens, 

fl ash, accessories, 

a 2-litre hydration 

reservoir (not 

included), plus 

extra gear such 

as a bike helmet, 

jacket, snacks and 

a compact tripod.

 GT3542L
• 178cm Max Height 
• 16cm Min Height 

SLR Zoom
• Flexi-Tripod legs
• 25cm Closed Length 
• 3Kg Max Load

327RC2 
Joystick 
Head

 Hadley Pro 

Original

Canvas Khaki/Tan 

 F-803

RuggedWear

Perfect for

carrying a pro 

DSLR with 

lens attached, 

4-6 ad-

ditional lenses, 

a fl ashgun and 

accessories. 

 We sell tripod accessories including plates and spiked feet on our website!

3N1-25..................................£139

3N1-35..................................£129

Manfrott o 
Pro Light 3N1 
Backpacks
Designed to hold 

a digital SLR with 

battery grip and 

mid-range zoom 

lens attached, 3-4 

additional lenses, a 

fl ashgun and iPad/

tablet.

G7 X Mk II

 G7 X Mk II        £549

D3300 Body £248

D3300 + 18-55mm AF-P £319

 D3300 

Black, Red
or Grey

 D3300      From £248

 24.2 
  megapixels

  5.0 fps

 Lighti ng & Accessories

 430EX III £219
£199 inc. 

£20 Cashback*

 SB5000
£499

3m Heavy Duty 
Background 

Stand
£89

Lumimuse LED 
Lights

From £44.95
 Ezybox Speed-Lite 2  

£49.95
 L308s
£149

Plus III Set
£199

Gemini Pulsar

Tx 500R Kit £949

Tx 500 Pro Kit £1199
D-Lite RX 4/4 

Softbox Set £699
Urban Collapsible 
Background £165

   18.0 
  megapixels

5.0 fps

700D Body £389

£349 inc. £40 Cashback*

700D + 18-55mm IS STM £449
£409 inc. £40 Cashback*

 EOS 700D

700D         From £389

   24.7 
  megapixels

5.0 fps

760D Body £549
£499 inc. £50 Cashback*
750D Body £469

£419 inc. £50 Cashback*

 EOS 760D

760D From £549 D7100 Body  £569

D7100 +18-105mm VR £799

 D7100

 D7100       From £569

24.1 
  megapixels

6.0 fps

7D Mark II Body  £1179

 EOS 7D Mk II

7D Mk II           £1179 

20.2 
  megapixels

     1080p 
  movie mode

10.0 fps

6D Body £1119

 EOS 6D

 6D £1119

D5500 Body            £499

D5500 + 18-55mm AF-P £569

D5500 + 18-140mm VR £749

D5500

D5500      From £499

24.2 
  megapixels

5.0 fps

 Black
or Red

MT190XPRO3
• 160cm
Max Height 
• 9cm
Min Height 

NEW 1D X Mk II Body £5199

 EOS 1D X Mk II

1D X MK II      £5199

20.2 
  megapixels

20.1 
  megapixels

4.2x 
optical zoom

 16.0 fps

 Full Frame
Sensor

   20.2 
  megapixels

4.5 fps

 Full Frame
Sensor

 NEW

MT055XPRO3 ...................£139
MK055XPRO3
+ X-Pro 3-Way Head .........£209
MK055XPRO3
+ 498RC2 Ball Head ..........£169
MT055CXPRO3
Carbon Fibre......................£269
MT055CXPRO4
Carbon Fibre......................£279
MT190 Series:
MT190XPRO3 ...................£129

THE WEX PROMISE: Over 17,000 Products | Free Delivery on £50 or over** | 30-Day Returns Policy† | Part-Exchange Available | Used items come with a 12-month warranty††

NEW 80D Body £999

NEW 80D + 18-55mm  £1089

NEW 80D + 18-135mm £1349

 EOS 80D

 NEW 80D          £999

 24.2 
  megapixels

7.0 fps

NEW G7 X Mk II £549 

G5 X Body £579

24mm f1.8 G ED AF-S .......................................£629

85mm f1.8 G AF-S .............................................£399 

105mm f2.8 G AF-S VR IF ED Micro .................£659

10-24mm f3.5-4.5 G AF-S DX ............................£669

16-80mm f2.8-4 G AF-S VR ED DX ..................£769

18-200mm f3.5-5.6 G ED AF-S DX VR II ..........£549

18-300mm f3.5-5.6 AF-S ED VR .......................£749 

18-300mm f3.5-6.3 G ED VR AF-S DX .............£549

24-70mm f2.8 E AF-S ED VR ............................£1849
£1699 inc. £150 Cashback*

24-70mm f2.8 G AF-S ED ..................................£1399
£1249 inc. £150 Cashback*

55-300mm f4.5-5.6 G AF-S DX VR ...................£269

70-200mm f2.8 G AF-S ED VR II .......................£1799
£1649 inc. £150 Cashback*

70-300mm f4.5-5.6 G AF-S IF ED VR ...............£449

80-400mm AF-S Nikkor f4.5-5.6 G ED VR ........£1859
£1709 inc. £150 Cashback*

200-500mm f5.6 E ED VR AF-S ........................£1179

EP 35mm f1.4 L II USM  ............................... £1799

EF 16-35mm f2.8L Mk II USM ........................ £1060

£985 inc. £75 Cashback*

EF 70-300mm f4-5.6L IS USM........................ £1029 

£919 inc. £110 Cashback*

EF 24mm f1.4L II USM .................................... £1099

EF 50mm f1.4 USM ......................................... £232

EF 100mm f2.8 L IS USM Macro .................... £619

EF-S 10-22mm  f3.5-4.5 USM ......................... £377

£332 inc. £45 Cashback*      

EF 16-35mm f4 L IS USM . ............................. £682

EF 11-24mm  f4L USM .................................... £2799 

EF 24-70mm  f4.0 L IS USM   ............................ £675

EF 70-200mm  f4.0 L IS USM  ........................... £795

£720 inc. £75 Cashback*

EF 100-400mm f4.5-5.6 L IS II USM ................ £1799

EF 70-200mm f2.8 L IS II USM ......................... £1499

EF 24-105mm f4.0 L IS USM ............................ £727

EF 24-70mm f2.8L II USM ................................ £1400

EF 50mm f1.2L USM ......... ............................... £995

EF-S 10-18mm f4.5-5.6 IS STM ....................... £179

£159 inc. £20 Cashback*

EF 180mm f3.5 L USM Macro  ......................... £1049

EF 85mm f1.8 USM  .......... ............................... £237

MT190XPRO4 ...................£139
MT190CXPRO3
Carbon Fibre......................£229
MT190CXPRO4
Carbon Fibre......................£239
MT190XPRO3
+ 496RC2 Ball Head ..........£139
MT190XPRO4
+ 496RC2 Ball Head ..........£189

Quality used 

cameras, 

lenses and 

accessories

with 12 months 

warranty*

www.wex.co.uk/
pre-loved

Pre-Loved
cameras

*Excludes items marked as incomplete 
or for spares

Anvil Slim 

Professional 

Backpack

 NEW  NEW
 NEW

 NEW

From £549

£50
Cashback*

From £389

£40
Cashback*

Nikon Camera and Lens Cashback* off ers ends 31.08.16

Canon Lens Cashback* off er ends 31.08.16

430EX III £219

£20
Cashback*



Dina Belenko is a 

conceptual still life 

photographer based  

in East Russia. She 

mainly collaborates 

with local businesses 

producing food-related product 

photos, and also sells stock online  

on 500px and Getty Images.

500px.com/arken

Crafting enchanting 
stories from inanimate 
objects, Dina Belenko 
guides us through her 
creative process.
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MEMORIES
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Pro Showcase Dina Belenko



H
ey, coffee cups, 
you’re my actors, so 
listen up and do as 
I say!” These were 
the words of a young 
Dina Belenko, as she 
directed the subjects 
in her very first still 
l i f e  p r o d u c t i o n . 

Inspiration strikes in many ways and for Dina 
it’s not the recording of events or retelling of 
stories that sparks ideas, but the invention of 
what she calls impossible memories.  

Throughout her school years Dina 
photographed everything from flowers and 
clouds to kittens and people, but as she grew 
up her creative flair blossomed and she began 
to take her work more seriously, with shoots 
planned in greater detail and more attention 
paid to every minor detail. Post-education, a 
job in a publishing house lasted for just a few 
years before Dina decided to leave and focus 
her energy on her real passion instead. Shoots 
for small cafés and local crafters swiftly 
followed, and gradually both her business 
and talents developed into what we see today.  

How to define her work? In Dina’s own 
words, she “tells animate stories about 
inanimate objects”. She constructs elaborate 
stories using simple objects, and each image 
has a clear narrative that we can all relate to. 
Take coffee, for instance – yes it’s a liquid 
energy and fuel for creativity, but in Dina’s 
hands it  also becomes an ethereal 
constellation of stars. 

For all her creative prowess, however, 
developing a ‘style’ has never been Dina’s 
priority. “I don’t really believe in consciously 
developing your style,” she admits. “For me, 
it’s more like handwriting. If you’ve learned 
how to write, you have your own unique 
handwriting. You can improve it, make it 
more beautiful or make it look like someone 
else’s, but this already belongs to you. I think 
it’s more productive to concentrate on 
becoming better at what you love than being 
original. If a photographer is obsessed with a 
particular subject, their style should 
constantly be evolving and their work should 
be unique by default. You don’t have to find 
your style – you have to find your passion.”

For Dina, every creative journey starts with 
a list – “that’s the secret behind my inspiration”. 
She’ll jot down her favourite foods, flowers 
growing near her house, or objects that catch 
her eye in the kitchen. She never knows what 
will spark an idea, but projects of every size 
invariably begin in this same way.

Perhaps Dina’s most elaborate project to 
date is her ‘Endless Book’ series, which 
comprises 52 individual images that merge 

The use of a 
defined colour 
palette and 
props depicts a 
far-off galaxy.
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together to create one colossal panoramic 
collage. With the goal of taking an image a 
week for a year, preparation started in the 
usual fashion with lists of sweets (cookies, 
marshmallows, doughnuts…) and of celestial 
objects (planets, shooting stars, comets…). 
She then paired them up, and as a result 
cookies became asteroid belts, doughnuts 
became constellations and cupcakes came 
face-to-face with aliens. 

Back on terra firma, with cup of tea, 
sketchbook and felt tips in hand, lists turn 

into sketches. “I choose an abstract topic (sea, 
astronomy, travel, sweets...) and find objects 
to tell stories, or I select an object first (cups, 
magnifying glasses) and come up with 
adventures for it. To use coffee as an example 
again, steam from a coffee cup can rise up, 
and blimps or kites can fly around in the 
clouds”. After the story’s been sketched out, 
props are selected and carefully arranged, 
ensuring each one is essential to the narrative. 

At this point, Dina’s house becomes her 

“Steam from a 
coffee cup can rise 
up, and blimps or 

kites can fly around 
in the clouds”

Pro Showcase Dina Belenko

Inspired by a  
science lesson, 
colourful smoke 

is used to 
create drama 

and excitement.
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studio – “all my backgrounds and props are 
taking over my apartment, but I can roll with 
it”. Her equipment includes a Nikon D800 
with a 50mm or 105mm lens, two flashguns, 
two softboxes, a large diffuser panel, 
reflectors, and a tripod that allows her to shoot 
directly from above. The key light is positioned 
behind the scene and a fill light off to one side. 
Dina then refines this setup and props until 
the image is as close to perfection in-camera, 
which means less time in front of a monitor. 

The home-grown ethos continues with 
the equipment Dina chooses to use too, and 
a quick glance over her workstation reveals 
that her essential kit isn’t the usual 
photographer fare. The most indispensable 
item in her arsenal is a hot glue gun, which 
comes into play when double-sided tape just 
can’t hack it. “Granted, a glue gun has its 
flaws, but it can handle a couple of cups, a 
tower of sugar cubes, or a collection of 
silverware. It’s vital for finely balanced props 

and shooting falling objects”. A balloon 
pump with a flour-filled paper cone attached 
to the end works a treat when she wants to 
create clouds, and two flashguns provide the 
perfect amount of power to freeze the motion 
and highlight the spectral detail in the 
‘clouds’. Sparks are simply captured with a 
range of exposures from 1/100sec to 1.5sec 
– the longer the shutter speed, the more fiery 
the tails of sparks. Dina admits it would be 
impossible for her ideas to come to life 

An exposure of 
1.5sec captures 
the burning tails 
of sparklers that 
have been 
dropped into 
glassware.
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Pro Showcase Dina Belenko

1 Never blame equipment 

Don’t allow material items to control your 

imagination. We often think, ‘If only I had 

this camera or that prop...’ but this should 

work as a prompt to be more creative. 

Want a dragon in your image? You don’t 

actually need to find a giant fire-breathing 

lizard, just cut a silhouette out of paper. 

2 Ask questions 

Questions lead you to better understand 

how to translate your story into visual 

language. What are these objects? How 

did they come here? Who is the main 

protagonist? What’s going on here? What’s 

the main emotion? Is there dramatic light? 

Think in small steps and take your time 

deciding what the answers will be.

3 Find your creative prompts 

Figure out which situations help you to be 

the most creative. Does it need to be a 

place where you can talk to other people? 

Does it need to be quiet and cosy? Inside 

or outside? I find most of my good ideas 

come during sunny days, when I take a 

long bus ride with my headphones on.

4 Start with the little details 

If you don’t have a big idea, don’t be 

disheartened. Start to prepare your 

workplace, buy some paper or new props. 

Little preparations will help to clear your 

mind and spark inspiration.

5 Postpone criticism 

Don’t critique your ideas during 

brainstorming. Let your ideas flow and 

decide which are good or bad later. Our 

inner critic is very quick to judge but don’t 

let him speak right now – he’ll have his 

moment later, when it’s time to choose 

one idea from many.

Dina’s top five photography tips

without her toolbox containing an assortment 
of tweezers, double-sided tape, cotton swabs, 
stationery clips, masking tape and incense 
sticks (the fundamental instrument for 
creating mystical, creepy images), to name 
but a few.

Learning which utensils are needed to 
craft Dina’s elaborate designs has come from 
extensive trial and error. Her first attempt at 
suspending a stack of cups from strings 
ended badly – “it collapsed under its own 
weight, but luckily I’d already finish the 
shoot!”. Now, she uses transparent plastic 
and hidden supports instead. 

Recognising when to persevere and when 
to quit is a skill that Dina thinks is vital for 
any photographer. “We’re often told we have 
to find one thing and then never give up, 
never quit, but I think it’s fine to say ‘I failed, 
I’ll learn and next time I’ll fail faster’”. Dina 
herself has dozens of unfinished projects that 
simply haven’t worked. Acknowledging the 
point when an idea needs to be abandoned 
means that you can free up your schedule to 
try different, exciting ideas. However, Dina 

emphasises the importance of creativity 
when encountering difficulties. She lives in a 
small town and can struggle to find props – “I 
have to check at least four flower shops to get 
simple white flowers” – but she uses this to 
her advantage. So you can’t find UFO models? 
Solution – make them from toffee wrappers 
and metallic paper. 

At one point or another, we all hit the same 
wall, aka creative block. Dina’s magic solution 
to this is “lists, lists, lists!”. She adds, “it’s 
helpful to have a collection of things you want 
to try, such as interesting objects, metaphors, 
compositions, lighting schemes, tricks or 
effects. It’s not a ‘to-do’ list, it’s more like an 
‘I want to give it a try’ list. It’s simply a 
defence against the daunting prospect of a 
blank page.” 

Clearly, with this mindset there’s going to 
be a lot more to see from Dina Belenko. Her 
intriguing stories and impossible memories 
are reaching increasingly wide audiences, as 
she’s been working on collaborative projects 
with companies in the UK, Germany and 
Austral ia ,  and is  act ively  seeking 
opportunities to do more. Who knows what’s 
coming next – only time will tell. But first, is 
that a new galaxy in my coffee? 

“We’re told to never
quit, but I think it’s
fine to say ‘I failed,
I’ll learn & next time

I’ll fail faster’”
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“I WISH I’D 
TAKEN THAT!”

Every now and then we all come  

across a photograph that makes us sit 

back in our chair, take a deep breath and 

think, “Wow, I wish I’d taken that.”

Images like this connect with us on a  

level way beyond the technical, so it can 

sometimes be difficult to define what it is 

exactly that has made the photograph  

so jaw-droppingly good. To find out,  

we’ve interviewed three different pro 

photographers and asked them how they 

create images so amazing that they 

continuously draw you in, no matter how 

many times you’ve seen them. 

Read on, and find out how you can create 

inspirational images that will leave your 

friends, family and fans in awe...

Prepare for your 
success P58

Learn from the experts...

Get familiar with your 
surroundings P62

Plus! Take your 
photos further P65

Take a chance with 
your photos P60

B
e
lla

 K
o

ta
k
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F
inding an image 
that jumps out of the 
page (or off the 
screen) at you is 
hard, but creating 
one yourself is even 

harder. In a world of constant 
access to incredible images, 
meticulously preparing your 
shoots can give you the best 
chance of making sure your 
photos stand out from the crowd. 

Bella Kotak has perfected the 
art of creating highly detailed 
images that invoke a more 

magical world. Her photography 
has a mystical quality that gives 
her viewers a glimpse into the 
machinations of Bella’s mind. “I 
think a successful image is one 
that strikes a chord with people,” 
she says. “In this age of beautiful 
imagery via social media, it’s easy 
to become desensitised to a 
beautiful picture, just because 
you see so many of them. Little 
things like clever composition, 
surreal elements and subject 
choices can help to create an 
image that stands out to us in 
some way. 

“When I plan a shoot I don’t 
always have a concrete vision. 
More often than not I just have a 
vague idea of elements that I’d 
like a picture to include, but 
sometimes the end visual eludes 
me, only appearing when I’m on 
location creating a scene fairly 
organically. Most of the time that 
‘vagueness’ solidifies right there 
in front of my eyes as I set the 
model in place and notice little 
details that I never saw before, 

and then suddenly I’m in my 
picture and the realness often 
takes my breath away. I love 
magic and moments and stories, 
and this is what I strive to weave 
into my photographs.”

Plan & prepare
When it comes to fine art and 
fashion photography, the efort is 
not in taking the photo but in the 
planning and preparation that 
has gone into the shoot in the 
weeks or months beforehand. 

“The longest I’ve spent 
preparing for a shoot is a month,” 
admits  Bella ,  “and that ’s 
physically preparing. By this I 
mean creating props, connecting 
with designers, models, hair and 
make-up, scouting a location and 
sourcing various elements to pull 
together a vision. However, I can 
mentally prepare for months or 
even years. 

“When I’m preparing for a 
shoot the first thing I do is get a 
sense of what I’d like to create. 
I get inspired by lots of things – 

music, a particular model, 
clothes, locations, twilight, 
golden hour light and so on. 
When something strikes a chord 
with me, I hold onto it and build 
an image from it. 

PREPARE YOUR 

SHOOTS FOR 

AMAZING RESULTS
Create ephemeral images with careful planning, like Bella Kotak

I Wish I’d Taken That!

n THINK OUTSIDE  
OF THE BOX  

Letting yourself grow 

used to a certain way of 

doing things can be a 

death knell for your 

creativity. If you feel like 

your photographs are all 

starting to merge into the 

same image, try shaking 

up what you’re doing. 

This can be as simple as 

changing your angle to 

find a new perspective or 

as complex as finding a 

completely new genre to 

photograph. No matter 

what you do to give your 

images a new lease of 

life, the important thing is 

that you are actively 

experimenting and 

improving your work.

n KNOW THE RULES SO 
YOU CAN BREAK THEM

There are some core 

rules of photography – 

obey the rule-of-thirds, 

expose your images 

correctly, avoid noise, 

etc. Everyone knows you 

must never break them in 

order for your images to 

be successful... Except 

there will always be 

some images that have 

broken all of the rules 

and they’re incredible 

both despite and 

because of that. Don’t 

despair, this doesn’t 

mean those countless 

hours spent painstakingly 

conforming to what’s 

expected are wasted. 

Knowingly breaking the 

rules is different to just 

not having any idea what 

you’re doing. Take the 

time to learn your craft 

and then you can 

experiment.

n CONSIDER LIGHT 
FROM THE OUTSET

There is little point in 

planning magnificent 

shoots if you haven’t 

given a thought to what 

kind of light you will be 

dealing with. Light is 

intrinsic to any image, 

but you can take it 

beyond getting the 

correct exposure. If you 

are shooting inside then 

consider using flash. On 

the other hand, if you 

are shooting an image 

outside with lots of 

natural elements, then 

you may want to use the 

sun as your sole light 

source. If this is the 

case, don’t forget to plan 

your shoot around the 

weather. A cloudy sky 

may give great 

moody diffused 

lighting, but will it 

be bright enough 

to light your 

subject when 

you’re shooting? 

Bella Kotak is an 

accomplished 

fine art and 

fashion 

photographer 

who is based in 

Oxford and London. She has 

had her work shown in galleries 

across the world. Fairy tales, 

nature and strong female 

characters inspire her work and 

her aim is to find ‘magic in the 

most ordinary of spaces’.

bellakotak.com

  Top Tips What do you need to know?  
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Main signpost

“To give you an idea, I passed 
a beautiful overflowing rose bush 
the other day. I knew immediately 
I was going to create a picture 
with it, so everything I do from 
this point on is to build up that 
vision and story. 

“My process of preparing for 
a shoot roughly begins with 

connecting with a model that I 
may have in mind to use, then I’ll 
start visualising the styling, 
setup, what I’d like the picture to 
say. I’ll reach out to designers 
and pull together a team, if that’s 
what I’d need to bring my vision 
to life. Now and then I love to 
create my own props, so that will 
have to be taken into account too. 

“Preparing a shoot is always 
fun. I love sourcing all the 
elements and when I see the final 
piece it feels really satisfying. 
When it comes to the actual 
shoot, they can range anywhere 
from 20 minutes to three hours. 

“I love to have music on and 
create as I go. If a picture isn’t 

going quite the way I thought it 
would I’m flexible enough to 
change it up and discover a new 
angle. I want my shoots to be 
enjoyable for myself, my clients 
and my models. When there’s 
that positivity and the feeling 
that you’re creating a beautiful 
moment in time, I feel that it 
translates into the final piece.”

“When something strikes a 
chord with me, I hold onto it 
and build an image from it”

Bella matched the 

colour of her model’s 

hair with the colour 

of the flowers.
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L
e a v i n g  y o u r 
images to chance 
can be a frightening 
prospect, especially 
if you are used to 
long and steady 

hours where you know exactly 
what you want to come away 
with. But if you want to try 
wi ldl i fe,  sport  or  street 
photography you’ll need to put 
down the tripod and trigger 
release and instead get to grips 
with shooting those blink-and-
you’ll-miss-it moments that can 
make extraordinary images. 
There are no do-overs with 

photography like this – you need 
to be ready to capture the 
moment or you will miss it 
forever. While this can be 
challenging, it is also incredibly 
rewarding when you get a shot 
that is unlike any other. Joao 
Peletairo is an experienced rugby 
photographer who is used to 
taking captivating shots. 

“We live in a world where 
there is an incredible amount of 
noise, with millions of images 
being published and circulated 
every day. If you only use the 
t y p i c a l  l a n g u a g e ,  t h e 
photographic clichés, you are 

only adding to the noise – even if 
your images are technically 
perfect. The unusual shots are 
the ones that are able to rise 
above the noise, opening a new 
angle and giving a fresh 
perspective on a subject.  Rugby 
is a magnificent photographic 
subject, but doing some basic 
research on the teams that are 
playing is always a good idea. 
This way you can identify the key 
players or the ones recovering 
from injury. You can also 
understand the importance of 
that specific game and the 
rivalries between the teams. 

Joao Peletairo  

is an amateur 

sports 

photographer 

based in Lisbon, 

Portugal. He 

began to take photography 

more seriously after finishing 

college and gradually 

developed a taste for portrait 

and architecture photography. 

He has shot several rugby 

games, from his own children’s 

team to big international 

tournaments. 

jp-rugby.com

DON’T LET CHANCE
MOMENTS PASS YOU BY
React fast to fleeting moments, with sports photographer Joao Peletairo 



Social media is a great source for 
this type of information.”

With limited time comes 
added pressure, but there are 
steps you can take to give yourself 
the best chances possible of 
getting the image you want. 

Shoot fleeting moments
“ T h i s  i s n ’ t  l a n d s c a p e 
photography, so when the action 
comes you must be prepared to 
act fast,” says Joao. “It’s important 
to have a camera and lens 
combination with fast focus, a 
high shooting rate and a deep 
buffer. But, it’s also key to stay 
focused on the action, anticipate 
when those fleeting moments are 
coming and know beforehand 
what type of framing you want for 
each shot. I always shoot in 
aperture-priority so I can be in 
control of the depth-of-field. 
I also use auto ISO to define the 
minimum speed, which is usually
not below 1/1000sec, unless I 
want motion to be apparent. 

During the game I’m always 
moving along the sidelines, trying 
to be closer to the action. A good 
background separation is key and 

if you’re closer to the players it’s 
easier to throw the background 
out of focus. 

“While luck inevitably plays a 

part, the more you know about the 
game and your kit, the more you 
practise and the more you 
experiment, the luckier you’ll be.”
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I Wish I’d Taken That! 

n KNOW YOUR SUBJECT

Whether it’s sports, wildlife 

or street photography, you 

need to know your subject in 

order to predict what they’re 

going to do. Joao started off 

shooting his children’s rugby 

games and then worked his 

way up to international 

tournaments. Starting in a 

more low-risk environment, 

where the shots you get 

aren’t vital to your career, 

will help you to be able to 

predict what’s going to 

happen when the stakes are 

higher. When you are 

comfortable with the habits 

of your subject then you’ll 

be able to anticipate 

opportunities for great 

photographs that you may 

have missed before.

n KNOW YOUR 

EQUIPMENT 

When things are moving fast 

you have no time to mess 

around with your camera 

settings. You need to know 

what aperture, shutter 

speed, focus mode etc will 

give you the shot you want, 

and then you need to be 

able to change these 

settings swiftly and 

confidently. Just like 

knowing your subject, this is 

a case of practise makes 

perfect. Invest your time in 

learning every nook and 

cranny of your camera, so 

that when you’re in a high 

pressure situation you can 

adapt to new technical 

challenges without the 

uncertainty of second 

guessing yourself. 

n MASTER YOUR 

WORKFLOW

It’s not just when you’re 

behind the camera that you 

have to be prepared. No 

matter what genre of 

photography you’re 

interested in, you need to 

have an effective way to 

manage the high amount  

of images that you will be 

working with. While you can 

afford to be more relaxed 

with personal projects, when 

you’re working 

professionally having lots of 

projects piling up can get 

stressful. Make sure that you 

have a filing system on your 

computer that helps you 

easily find images. It’s also a 

good idea to build set 

periods of time for editing 

into your day, so that it’s not 

an afterthought. 

 Top tips What do you need to know?  

Joao’s fast 
shutter speed of 

1/1000sec helped 
him capture the 
falling droplets.
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Know your 
subject like the 
back of your 
hand, with pro 
landscape 
photographer  
Colin Prior

C
r e a t i n g  a 
c a p t i v a t i n g 
image is often a 
labour of love 
t h a t  t a k e s 
exponentially 

more time than the fraction of a 
second for which the shutter is 
pressed. When it comes to genres 
like landscape and architectural 
photography, the better you 
know your subject, the better the 
images you will produce. 

Scottish photographer Colin 
P r i o r  h a s  b e e n  s h o o t i n g 
landscapes for over two decades 
and has remained enthralled 
throughout that time by the wild 
Scottish mountains he often 
hikes over. For him, it’s not a 
matter of photography being the 
passion – it’s the subject that the 
photographer needs to love first 
and foremost.

“Great photography in any 
genre  is  the  result  of  a 
photographer’s passion for his or 

her chosen subject. That passion 
needs to outweigh the obsession 
with photography and its multi-
faceted technical disciplines, 
such as sensor sizes, lenses, Big 
Stoppers and the desire to ramp 
up the sliders in Lightroom. Most 

photographers can’t get past this 
stage  and that ’s  because 
photography is the passion, and 
not any particular subject. It’s 
what I refer to as landscape 
photography on steroids! 

“ I t ’ s  c r u c i a l  t h a t 
photographers begin to create 
connections with their subject, 
and explore it from the inside 
out,” believes Colin. “It took me 
many years to realise that I spend 

much of my life chasing moments 
that ordinarily don’t exist. They 
are, in essence, the convergence 
of rare moments of light and land. 
It takes years to get to know a 
particular area, but there is far 
more value in creating an 

authoritative body of work in one 
area than returning to the usual 
honeypots  frequented by 
countless other photographers.”

Return again & again
“For some of my mountain 
photographs of the Scottish 
Highlands, I made four attempts 
over a four-year period to finally 
achieve the result I sought. 
Reconnaissance is truly the key to 

Colin Prior is a 

landscape 

photographer 

whose interest in 

photography 

began with a 

fascination of the natural world. 

He has produced images for a 

variety of clients, including 

British Airways, Calmac, Talent 

Scotland and more. Over the 

past 10 years he has worked 

on a variety of documentaries 

featuring mountains and travel.

colinprior.co.uk

EXPLORE YOUR SUBJECT 

TO GET FAMILIAR WITH IT

“Great photos don’t  
happen by accident, they  

need to be planned”



n BE TENACIOUS

Don’t be afraid to go after 

what you want. The image 

you’re after might not be 

easy to attain, but with 

persistence and 

perseverance you can 

capture it. This can apply to 

any genre of photography, 

as having the guts to go out 

there and get your photo,  

no matter how hard it is, 

already puts you ahead of 

everyone else who thought 

about it but ultimately 

decided not to bother. 

However, when the elements 

are battling against you for 

your shot, this is when you 

need to be at your most 

tenacious. 

n VISUALISE YOUR SHOT 

Knowing what you want out 

of a landscape before you 

even step foot outside your 

front door is a great way to 

make sure that you come 

back with a shot you’re 

happy with. Consider what 

emotion or mood you want 

from the image. Undergoing 

the intense research of 

walking the area you want to 

shoot means that you’ll gain 

a wealth of knowledge. This 

will help you to make those 

key decisions, such as what 

time of day you want to 

shoot, where exactly you 

want to position yourself 

and whether or not you’re 

going to use filters. 

n HAVE PASSION

This may seem obvious,  

but if you’re going to spend 

hours traipsing around a 

landscape, you’d better 

make sure that you’re really 

passionate about it first. As 

Colin mentions, while being 

interested in photography is 

obviously key to creating a 

good image, being able to 

create jaw-dropping 

photographs really does 

depend on your keen 

interest in what you’re 

actually shooting. You will 

probably end up spending 

hours on your subject, so 

make sure that it’s 

something that you truly 

enjoy before beginning.
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creating successful landscapes – 
you’ve got to walk the ground and 
decide where and when you plan 
to shoot. Great photographs don’t 
happen by accident, they need to 
be planned. I have shot some 
locations on many occasions, 
often camping on a mountain 
summit in an effort to capture the 
conditions held in my mind’s eye. 

“The vast majority of images 
taken on digital cameras are little 
more than a record of a moment. 
What makes an image truly 
captivating and truly powerful is 
when it transports the viewer to 
a place beyond the image and 
causes an involuntary reaction.”

I Wish I’d Taken That! 

Preparation pays off 
for Colin with this 
sunrise-drenched 

image of Milton Ness.

  Top Tips What do you need to know? 
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I Wish I’d Taken That! 

WAYS TO TAKE YOUR
SHOTS FURTHER

Experiment even more with these three key pieces of advice 

3

1

2

3

There aren’t many places where there is absolutely no opportunity 

for a photo. How many times have you been caught out without a 

camera when something amazing was happening? Admittedly, 

with the advent of smartphones these missed chances have 

decreased, but your image quality will suffer with this inferior 

equipment when compared to DSLRs or CSCs. Getting into the 

habit of taking your camera everywhere may seem cumbersome 

at first, but your eye for seeing potential photos will improve 

dramatically when you’re constantly looking out for them. If you 

want a more formal project to really keep yourself in check, why 

don’t you try doing a 30-day challenge on a particular theme, 

such as a colour or emotion. If you’re feeling really ambitious you 

could even stretch yourself with a 365-day challenge. The 

urgency of having to take a photograph every single day will push 

your creativity further and make you go out of your way to find the 

image you’ve cooked up in your mind’s eye.  

When you are out walking the landscapes or cities that you want 

to shoot, why not take some test shots along the way? Doing this 

will help you determine which locations work well for you and 

what angles make them look their best. You may also want to try 

taking test shots in different lighting conditions, so you know 

exactly when to go for your final shot. By taking a camera with 

you on your exploratory walks, you will always be looking for new 

and unusual angles that will help your images stand out from the 

crowd. You can also experiment with these photos – why not try 

using a panoramic format like Colin Prior? Or you could try using 

different filters for different effects. Taking test shots gives you the 

freedom to experiment, so that when it comes to taking your final 

shot you don’t have to worry that an untested element may end 

up adversely affecting your photograph. 

lt doesn’t just have to be your vision. There are a plethora of 

designers, stylists, make-up artists and models that are all 

itching to take on a creative project, so why not try reaching 

out to a few people and seeing if they would work with you? 

Contacting your local university is a great way to connect 

with creative minds who are always looking for new 

opportunities. While some people may work with you for 

free, it is considered good form to at least pay for any travel 

expenses they may incur. If you’re already used to working 

with models, designers and stylists, why don’t you stretch 

your collaborative muscles and try working with another 

photographer? You might find it interesting to see how 

another person works and you could both draw on each 

other’s experiences to create images that neither of you 

would be able to achieve on your own. 

Chance Carry your camera  
to maximise possibilities

Familiarity Take test 
shots to help you plan

Preparation Work with 
others for creative results

Write down all the ideas that 

you think of in a notebook. 

This will help you keep on 

top of your shooting 

plans and ideas.

Tip
 Keep track of 

 your ideas 
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Pro Insight Tejas Soni

Tejas Soni is an acclaimed 
wildlife photographer based in 
Gujarat, India. He’s a Canon 
ambassador and regularly 
leads photo tours to some of 

the world’s most magical natural world 
havens. 500px.com/tejassoni

Crawling on his belly  

in simmering 43ºC heat 

allowed Tejas Soni to immerse 

himself in this sun-kissed world.
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W
ildlife demands a 
s p e c i a l  k i n d  o f 
dedication. Wading 
through clammy mud 
at 5am, sitting for 12 
hours at a time in a tiny 

hide, subjects that like to keep you guessing 
until the end; it’s perhaps no surprise that 
those who make it to the top are true 
obsessives. Tejas Soni certainly is. His belief 
that you can only shoot nature once you’ve 
assimilated with it is only half the story...

 How long have you been a  

 wildlife photographer? 

By definition for 8 years, but the process that 
led to me being a wildlife photographer began 
long before. Photography, like any other art 
form, is an expression and that expression starts 
with an urge to tell stories. This urge first took 
hold when I started sketching; from sketching I 
moved onto sculpture and eventually arrived at 
photography. I’d like to think that my style is 
fluid and can’t be boxed or categorised – it’s ever 
evolving, much like the wildlife I train my lenses 
on. I’m now a Canon ambassador for India and 
also run a group called Karastaan, which 
arranges workshops for painting, sketching, 
sculpting and photography. 

 What’s the story behind  

 this incredible image? 

This is one of many images I took during a 
5-day tour of Porbandar, a city in the state of 
Gujarat, India. Temperatures can touch 50ºC 
in this region during the summer months! I try 
to become one with nature when I shoot 
wildlife and on this occasion I started by 
observing the location and the light. While 
observing I very slowly crawled on my 
stomach towards the flamingoes. When I felt 
I’d crawled close enough I stopped and lay still 
for two hours, by which point I was surrounded 
by these amazing birds. 

Tripods and monopods are a big no-no 
with this approach, so instead I try to use my 
surroundings as much as possible, both for 
comfort and camera support. I’d been lying 
still for so long with my camera poised that the 
flamingoes were acting as though I was part 
of the landscape. That is, until a wild dog 
appeared and caused a major panic among the 
birds. I hadn’t anticipated this happening, but 
I was perfectly positioned to capture the entire 
sequence and this is just one frame. 

 Talk us through the photographic  

 techniques used to take this shot… 

I used a 100-400mm zoom, which allowed me 
to experiment with a variety of focal lengths 
and types of shots, from tight portraits to 
landscapes. This particular image was shot at 
400mm. The settings were 1/2000sec, f/5.6, 
ISO 400 and shutter-priority mode, as it was 
an action shot. The light was so luminous that 
ISO could be relatively low and shutter speed 
could be just fast enough. I shot in short bursts, 
squeezing off four frames for this sequence, 
and focused on the flamingoes nearest the 
camera. No tripods, no beanbags, just the 
ground to support the camera and lens. 

 The quality of light is incredible,  

 especially the way it highlights the  

 birds in the foreground… 

I’ve always been drawn to the soft and slanting 
rays of sun at the start or end of the day – they 
can be very expressive and I enjoy the 
challenge of trying to capture that expression. 
This gorgeous light lasted for roughly half an 
hour, in which time I was able to shoot dozens 
of frames and leave without disturbing the 
wildlife. It was a hot afternoon, but the light 
was nothing special when I arrived. The 
quality of light only warmed up towards the 
end of the session. Despite having crawled in 
mud for an hour and a half and lying perfectly 
still for two hours, it was more than worth it.

 What can you prepare for when it  

 comes to wildlife shots of this kind? 

To plan is anti-life! Life doesn’t have a plan – 
it’s like a stream that springs and then finds its 
way. We can only plan for the process and work 
hard to tune into our environment. This image 
was the result of a naturally occurring event and 
that’s not something a photographer can 
choreograph, but being there and having a clear 
vision will always present you with 
opportunities. To answer your question, prepare 
for the process and hope great shots follow. 

 How many shots did you take in  

 total and how did you know this  

 particular frame was the one? 

I took thousands of shots during the trip – 
action, documentary, animals feeding… a huge 
variety. This particular shot was taken on the 
final day. I don’t make notes on shoots and 
don’t really think the day or number of shots 
matters too much – this could just as easily 
have happened a few clicks into the first day. 
As for choosing just one frame, it’s a very 
spontaneous and instinctive decision. You’re 
not aware at the time that the shot you’ve just 
taken has the magic. It’s when you look at your 
work in the silence and solitude of your office 

Three key techniques Tejas uses in his shot
1 Fill the frame       

Switching between primes isn’t an option in some situations, so a 

zoom will not only allow you to recompose for portraits and environmental 

scenes, it’ll also mean you don’t have to move and potentially disturb your 

subject. Canon’s EF 100-400mm f/4.5-5.6L IS II USM did the legwork for Tejas.  

2 Freeze the action      
Flamingoes are large birds and ungainly flyers, and neither quick nor 

elegant when taking off. A shutter speed of 1/2000sec was plenty fast enough 

to freeze the subjects in the foreground and the flapping wings in the distance. 

3 Shoot in bursts          
Your camera’s continuous shooting mode is a great way to improve 

your hit rate when photographing action. Canon’s 7D can shoot 8 frames-per-

second, meaning Tejas only needed half a second to rattle off four frames.

1

32

Above A shutter speed of 1/2000sec was 
fast enough to freeze this flamingo’s wings.



Tejas talks gear 
“The best and latest is always good, but basic 

gear shouldn’t be seen as a limitation. Far more 

important is knowing your gear – know its 

features, benefits and limitations. Ultra-modern 

gear is worthless if it dominates you…”

Cameras, lenses and accessories 
Canon 7D, Canon 550D, Canon EF-S 10-18mm f/4.5-5.6 IS 

STM, Canon EF-S 18-55mm f/3.5-5.6 IS, Canon EF 75-300mm 

f/4-5.6 III USM, Canon EF 100-400mm f/4.5-5.6L IS II USM, Canon 

EF 100mm f/2.8 Macro USM, GorillaPod, monopod, 

flashgun, extension tubes, remote 

release, elbow pads, Wi-Fi router, rain/

dust cover for DSLR, sunscreen. My 

preparation of my kit bag depends on 

the weather conditions. 
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that each frame speaks to you. Knowing which 
to edit comes from experience and intuition and 
it’s tough to describe that in words. I know in a 
split-second if it’s the one, but there is no cut and 
dried formula to arrive at that conclusion.

 What challenges does wildlife  

 photography like this present? 

Wildlife photography is completely draining, 
physically and mentally. I crawl for many 
hours on my stomach or hands and knees, and 
always have a pain relief ointment in my kit 
bag. And you’re never sure when you’re going 
to get the shot – it may take minutes (though 
this is very rare) or several hours or days to 
capture the perfect frame. This demands 
endless patience and discipline. So an image 
that was exposed for 1/1000sec actually took 
many hours of hard work. The question 
reminds me of Hemingway: “It is good to have 
an end to journey toward; but it is the journey 
that matters, in the end.”

 How much time was spent in  

 post-production and what kind  

 of processing was applied? 

I don’t rely too much on post-production. I use 
Canon’s Digital Photo Professional (DPP) 
software for basic editing, and then only to 
reduce noise if needed. I might resize a file if 
it’s for web use. I tell my students that post-
production is necessary, but only for wedding 
photographers and graphic designers, as they 
specialise in selling perceptions. 

 How does this image rate in terms  

 of complexity compared to the rest  

 of your portfolio? 

It’s certainly one of the more challenging images 
I’ve captured, partly because of the reflections 
and unpredictable subjects, but mostly because 
of the fieldcraft involved. Saying that, it’s not the 
most involved – I once invested seven days to 
bag a single shot. The flamingo picture is good, 
but I’m convinced Mother Nature has more 
beautiful frames to show me.

 How can Practical Photography

 readers get a shot like this? 

Observe, follow the light, choose your angle 
and compose the frame. It’s all about following 
this process again and again and never giving 
up. Plus, crawling on your belly in simmering 
43ºC heat in boggy marshland isn’t for 
everyone, but it’s the only way to convey the 
perfect sense of depth. Your readers should try 
this when they want to blur foreground and 
background while capturing dramatic 
reflections. Finally, fieldcraft is indispensable 
– unless you know the subject like the back of 
your hand, you’ll never get the desired results.

What Tejas is shooting now

Pro Insight Tejas Soni

I have some interesting photo tours 

lined up in the Ranthambore National 

Park, and in July the Karastaan group 

goes on a macro photography tour in 

the dense forests of Dang, Gujarat, in 

association with the local forestry 

commission. Later in the year I lead a 

group to Laddakh to shoot the barren 

Western Himalayan landscape, and I 

plan to tour the holy city of Varanasi, 

situated on the banks of Ganges. After 

that I go to Pushkar, Rajasthan to 

capture candids at the Pushkar Fair. 

When not touring, I make time to 

indulge in personal work, like the 

flamingo shot here. I love to explore 

and create my own way, and I love to 

share what I know and what I’ve 

experienced in the field. The best way 

to learn is to teach, so I enjoy teaching 

immensely.



O
f all the genres we’ve 
explored so far in this 
series, weddings have to 
be one of the most 
d e m a n d i n g .  W h y ? 
Because you only get 
one chance to capture 

that special moment – miss it and there’s no 
repeat performance. It’s also a genre that has 
evolved massively over the last few decades, 
moving way beyond its static pose beginnings 
into a magical world of fly-on-the-wall 
reportage, colourful candids and fantastic 
fine art. Ross Harvey is one of the most 
in-demand wedding photographers in the 
world right now and also one of the most 
creative. Over to him...

 How planned are your wedding shoots?   

Greg Whitehouse, email

Believe it or not, I don’t plan anything! I’m a 
firm believer in acting on the spur of the 
moment. Over the years I’ve constructed a 
collection of creative techniques than can be 
employed in various circumstances and light 
conditions, and I’ll draw on the most 
appropriate technique(s) depending on the 
environment. I’ve found instinctive 
photography to be far more rewarding, in 
both the process itself and the finished 
photograph.

 I’ve noticed that you use framing  

 devices quite a lot – why is this? 

Mary Whittingdon, email

Frames, both foreground and background, 
add depth and dimension, especially when 
combined. They’re very useful for both 
drawing the attention of the viewer’s eye and 
showcasing the structure of the environment. 
I use specific items for effects too, such as 
reflections or specular highlights.

 What’s the secret to great candids? 

Daniel Jenkins, email 

The two Rs – relaxation and rapport, of both 
yourself and the couple. All of my best candid 
portraits are taken when we’re all relaxed and 
having fun. Friendly banter goes a long way 
– don’t be afraid to crack a joke or join in with 
other people’s.  The friendlier your 
relationship with the couple, the better your 

portraits will be. How you act defines how 
people will react to you. It’s a simple premise 
that yields profound results. Would you feel 
more comfortable with a friendly, relaxed 
person, or a nervous one? We each – often 
subconsciously – project an act or attitude.

 How do you get such vibrant colours? 

Saira Shabnam, email 

If I had a pound each time I was asked this 
(and about skin tones), I’d be able to buy a 
couple of D5s! The secret is simple – don’t 
wash them out, use higher contrast editing. 
There’s an overwhelming amount of people 
pushing tone curves at the moment, which 
lessens contrast. Blacker (or black) blacks and 
white whites keep the dynamic range of the 
image much higher. A great tip is to saturate 
the image (and hence the environment), then 
tweak skin tones with the Hue, Saturation and 
Luminance sliders.
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Introducing Nikon  
photographer Ross Harvey

Biography: Ross Harvey is a  

multi award-winning wedding 

photographer recently voted ‘Best in 

England’. His unique fine art-meets-

photojournalism style helps him create 

stories with ‘no set poses, no set 

routines’. rossharvey.com

On being a Nikon photographer:

“I’m a fast shooter – I see, 

compose and shoot in the moment. It’s 

all very instinctive. I can’t bear to use 

gear that slows my process down and 

the only cameras that don’t are Nikon. 

They allow me to be me; they become a 

part of my creative process.” 

Nikon says: Ross is a passionate 

Nikon user with a stellar reputation. 

He has a slew of accolades and awards 

to back up his very deserved success.

Ask the expert!
Next issue we’ll be putting your gear  

& technique questions to movie stills 

photographer Helen Sloan. Email 

practical.photography@bauermedia.

co.uk & the best ones will be answered 

in the September issue, on sale 4 Aug.

In this series we’ll  
be focusing on the 
talents of pro Nikon 
photographers. The 
UK’s most influential 
photographers are 
here to answer your 
questions. nikon.co.uk



1
Nikon D750 

This little gem of a camera continues to 

surprise me. It’s an incredible performer in  

a tiny, light and ergonomic shell. Its AF, ISO and 

dynamic range are incredibly powerful. To have all 

that in a lightweight body is a dream.

2
Nikon AF-S Nikkor 35mm f/1.4G

This is my workhorse wedding lens. 

It balances well on the D750 and has 

never ever let me down. I use it wide open in 

challenging light conditions. 

3
Nikon AF-S Nikkor 35mm f/1.8G

This is my choice for travel and street 

photography. It’s small, light and capable, 

and has gone all over the world with me and never missed a beat.

Ross’ three  
Nikon essentials...

 Colour or mono – how do you decide?  

Roger Plail, email

Being an ex-graphic designer, I’m a huge fan 
of colour. I do employ black & white, but it 
depends entirely on the photo. Some images, 
in my mind, are ‘born’ for either, and it can be 
instinctive. To reduce that statement further 
– how clean is the image? Will faces and detail 
be lost if converted to black & white? In a busy 
scene, faces are often identified much faster 
in colour.

 The way you use light is amazing –  

 how do you do it?  

Emma Collings, email

Keep it directional. I always opt for ambient 
light, as I feel there’s much skill in being able 
to use that efficiently, no matter how tough it 
may seem, but sometimes it’s just not good 
enough. I’ll then use my own flashguns.

Advertising feature
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Make an incredible  
day-to-night panorama
Want to shoot a 
panorama with a 
difference? Kingsley 
Singleton combines  
night and day in the 
same scene – the perfect 
holiday project!

S
o m e  p e o p l e  p r e f e r 
shooting in daylight, and 
some prefer shooting at 
night, but there are only two 
ways to shoot both at the 
same time. You can either 

hitch a ride on the International Space 
Station, or follow this month’s Capture & 
Create technique. Scared of heights? No 

problem, let’s do it from ground-level. 
A day-to-night image in its most simple 

form requires shooting two pictures from 
the same position – one in the light of the 
sun and the other after it has set. The shots 
are then combined in Photoshop using 
Layers and you’ll quickly have one side of 
the scene in the light and the other in 
darkness. Because the camera hasn’t 

CAPTURE
CREATE
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1
HOW TO SHOOT AND 

STITCH A PANORAMIC 

LANDSCAPE IMAGE  

Good panoramas rely on careful 

shooting because the separate images 

must be at just the right angle for them 

to be stitched in software, while they 

also need consistent exposure, 

depth-of-field and focus.

2
HOW TO COMPOSE A 

DAY-TO-NIGHT SCENE  

Not every location will work 

well as a day-to-night panorama, so 

you need to know what to look for. The 

location needs plenty of activity or the 

resulting panorama will look bland.

3
HOW TO STACK AND 

BLEND LAYERS IN 

PHOTOSHOP 

This technique is reliant on taking the 

pictures that you’ve shot throughout 

the day and first combining them as 

panoramas in 

Photoshop, before 

finally using Layers to 

show the exact parts of 

each that you want and 

revealing both the 

night and 

day parts 

of the 

scene in all 

their glory.

Three things you will learn...
moved, any static parts of the scene will be 
in identical positions in each shot, so 
they’ll synchronise perfectly. Once you’ve 
got the hang of that, it’s fun to push things 
further and that’s why we’ve taken the 
basic technique and combined it with a 
panorama, giving it an extra wide sweep 
for twilight to creep into the scene. 

Planning your shoot
The first thing you need is to find a good 
place to shoot, and you’ll need some time 
to kill between the exposures too – there’s 
no rushing this one. That makes it the 
perfect technique to try on your holidays, 
where you’ll be able to find interesting 
subjects and have the time to do them 
justice. Find a spot where there’s plenty 
going on, and where man-made lights will 
light up, as this really adds to the effect.

How to shoot & stitch photos 

together as a panorama 

How to stack and align Layers 

How to use Layer Masks

Software Photoshop 

Do it in 30 mins

 What  
 you’ll learn 

each that you want and

revealing both the
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The easiest way to create a day-to-night 
image is to do it as a single frame and to wait 
your way through the passing of the sun. Two 
or more pictures from the same position can 
then be blended in software.

But when you consider the practicalities of 
staying in the same spot, it’s actually not that 
easy, or perhaps even possible. Yes, you can 
shoot 30mins before sunset and stick around 
for an hour, until after sunset when the lights 
come on, but what if you want full midday-
style sun mixed with a low-light element – 

that could mean four, five or more hours’ 
waiting. Add in that you may be shooting in a 
busy spot, as I was at the harbour side in 
Rethymno, Crete, and it’s clear that you can’t 
leave the camera unattended. 

All this makes the thought of shooting the 
pics at separate times quite appealing. But 
with the shots needing to line up as precisely 
as possible, how do you do it? The answer is 
right at your feet, and it comes from putting 
the tripod back in the exact same position and 
height each time you return to the location. 

That might sound tricky, but if you set up 
and place the legs by objects or marks on the 
ground that you can remember, like cracks in 
the stone, or particular rocks, it’s easy to do. 
The tripod will also need to be at the same 
height each time, but that just means sticking 
to using the legs at one of their sections. 

The process is further complicated if you’re 
shooting day to night as a panorama, as I did, 
but with your shooting position and angles 
consistent, this won’t be a problem, it just 
takes a little more care and concentration.

Capture the shots that you need

What are the advantages and disadvantages of shooting 

your day-to-night photo as a single frame image or as a 

panoramic composition? The single frame route means 

that, in theory, you don’t need to move the camera at all, 

so the elements will lock together much more easily. 

And that also means there’s less editing to do when it 

comes to combining the panoramas, and blending the 

day-to-night effect. On the downside, with less width to 

work across, the effect can feel a bit ‘sudden’ in places 

if you try to combine too many lighting conditions, with 

day turning to night too quickly (you can address this by 

shooting fewer frames – just a day and night image can 

suffice). However, the wider format certainly gives you 

more space, allowing you to combine the lighting 

conditions more gradually. It’s up to you!

 Find a good location 

Pick a location that will have a decent 
amount of difference between day and 
night. For this reason, city scenes work 
really well, as they change in appearance 
when the lights come on and don’t fall into 
deep darkness. Try to judge how the scene 
will change, and pick a quiet shooting 
position that’s unlikely to be disturbed or 
where your view might be obscured from 
one hour to the next – once you’ve picked 
a spot you need to stick to it.

 Take control with manual settings 

A consistent set of pics is required to make a good panorama,  
so you should shoot in manual exposure mode, using the same 
settings throughout each group of pics, and use manual focus.  
This means the shots will blend more easily in your software.

 Note your tripod position 

If you’re planning on shooting each set of 
pictures, moving off, then returning to the 
same spot later (as I did), make sure you 
take note of the exact position of the 
tripod feet and its height, then replicate 
them, as 
even minor  
shifts can 
ruin the 
panorama. 
Try taking a 
pic on your 
phone to 
mark the 
position.

You can shoot your 
overlapping images either 
horizontally or vertically, 

to add extra depth to 
the scene.

 Tip 
 Vertical or  
 horizontal? 

Above & left  
If you’re 
sticking to a 
single frame, 
try not to cram 
in too many 
lighting 
conditions.

 Regular frame 4 shots  Regular frame 2 shots

 Panoramic frame 4 shots

What to shoot
 Single frame or panorama 
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1
Compose your 
panorama the 
right way

Panoramic framing is trickier 

than a single shot, as you 

need to work out the 

composition across the 

frames. Practise framing the 

wide scene by scanning 

across it using the viewfinder. 

Is the composition going to 

lead to a focal point on one 

side or the other? Or will it be more central so the edges frame the middle? Now 

sweep across the scene, placing the far edge of the first frame in the middle of 

the next. Work your way to the far end of the scene, and take a note of how many 

frames it involved. Try not to go beyond three/four horizontal or five/six vertical 

pics, or the panorama can look too stretched. Finally, lock the camera off on a 

tripod and make sure that your shooting position is level using either a spirit level 

or your camera’s digital level function. Most DSLRs and CSCs now have the 

latter, which can be switched on in Live View or through the viewfinder. Check 

your manual to find it on your camera.

4
Check and repeat 
With the sequence completed, bring up the histogram to 

check the exposure is good. Now you can either leave the 

tripod in the same position and wait a few hours before shooting 

again, or up-sticks, have a drink and return later. If you decide on the 

latter, remember to keep the tripod feet in the same position, and 

replicate the height. You should also focus in the same spot.

  How to fix shooting problems  

WHY DON’T THE PICTURES 

LINE UP?  

Check that the tripod is at the 

same height and its feet are 

placed in the same position 

for each set of shots. It’s also 

vital that the tripod is levelled. 

Begin your sequence with the 

same framing in each set that 

you shoot, and move through 

the set of shots in the same 

way – that way, everything 

should line up.

WHY ARE SOME PARTS OF 

THE PANORAMA TOO 

LIGHT OR TOO DARK?  

The light levels can vary a lot 

as you move across the 

scene because your shooting 

angle changes in relation to 

the sun. For this reason it’s 

best to shoot in manual mode 

and meter for the brightest 

part, then use RAW 

processing to even the 

exposure later, if required. 

HOW LONG SHOULD I WAIT 

AFTER SUNSET FOR THE 

NIGHT SHOTS?   

Night scenes tend to look 

best if there’s still some 

natural light turning the sky  

a deep blue. If you wait too 

long, the sky will be black, 

which doesn’t contrast as 

well with man-made lights.

Above Make 
sure there’s 
plenty of 
overlap 
between shots.

Left Use your 
camera’s 
digital level if  
it has one.

2
Calculate the exposure
In aperture-priority, set a small aperture like f/14 or f/16, a low 

ISO (100-200), and frame up on the first part of the scene. 

Check the shutter speed, then turn through the other shots, checking 

the shutter speed again in each. Switch to manual mode (M) and dial 

in the same aperture and ISO, then add the fastest shutter speed that 

was noted. This should mean that your exposures are consistent and 

you don’t lose highlight detail in any part. Also switch to RAW mode. 

3
Lock the focus and shoot the sequence 
Set the white balance to daylight so, like the exposure, it 

won’t change from shot to shot. Then focus on a part of the 

scene and switch to manual to lock it too. Now shoot the first frame, 

allowing a little room outside the starting point (this helps with 

editing later). Turn the tripod head to the next point you picked in 

Step 1 and shoot again. For even greater consistency, note the 

degree markings on your tripod collar as you shoot.

Shot 1 Shot 2 Shot 3 Shot 4Shot 3Shot 3 Shot 4Shot 4Shot 4Shot 2Shot 2

Overlap 
area

Overlap 
area

Overlap 
area
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Create the image 
in Photoshop 
Now the pics have been shot, it’s time to start blending them. First, 
the pictures must be turned into panoramas, then stacked as Layers 
in a single document. In Step 3 below I use a File>Scripts command 
to do it, but you can also cut and paste them into the same document 
then use Edit>Auto Align Layers... to sync them up. Then comes the 
blending. The simplest way is to use Gradient Masks (Layer Masks 
made with the Gradient Tool), but as you’ll see in the steps, you can 
refine them and get more interesting effects using the Brush Tool as 
well. This lets you blend Layers more accurately, for example making 
one side of a building night and the other day. And remember, once 
the image is made, treat it as a normal landscape and edit it 
accordingly, making the most of contrast and colour as you usually 
would before finally sharpening the finished composition. 

5
Add a Gradient Mask
In the Layers palette, click the top Layer, then click the Add Layer 

Mask icon. Pick the Gradient Tool (G) and in the Options bar, set 

it to Linear Gradient. Click on the Gradient Editor and choose Black, 

White and set Opacity to 100%. Now click around 1/4 or 1/3 of the way 

into the image and drag from left to right to add a gradient. You’ll now 

see parts of the Layer below showing through.

2
Stitch the panorama 
I also used the Straighten Tool (A) to level the horizons in each pic. 

Just drag it along the horizon to do it. Select All again, hit Open 

and with the images in Photoshop, go to File>Save As and save them as 

JPEGs. Now go to File>Automate>Photomerge... Click Add Open Files, 

choose Auto as the Mode, and tick Geometric Distortion Correction, but 

leave the other boxes unticked. Click OK to make the panorama.

4
Check the order of the Layers 
In the Layers palette (Window>Layers) you should now find all the 

panoramas nicely stacked up. The edges of the composition will 

look a mess, but we’ll sort those later. Now make sure the Layers are in 

the right chronology, from full sun to low light. If they’re not, click on the 

Layers in the palette and drag them into position, so the lightest part of 

the day is at the top. You can close down the ‘flat’ panoramas now.

1
Convert your RAWs 
If you’ve shot in RAW, as is advisable when working on panoramic 

compositions, you’ll first need to process the files. Load up each 

set from the different times to launch Adobe Camera Raw, then press 

Ctrl+A to Select All the files. Make whatever changes you need. Here, 

among others, I used Shadows set to a positive and lowered the Whites, 

so there was detail in those areas. 

3
Stack up the panoramas as Layers
When the panorama has stitched, go to File>Save As and save it 

as a JPEG. Repeat the process with the other sets of images you 

took, and you should finally have three or four panoramas to work with. 

Now load them all back into Photoshop and go to File>Scripts>Load 

Files into Stack... Click Add Open Files, and tick the box marked Attempt 

to Automatically Alight Source Images. Click OK to stack up the pics.
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6
Improve the mask using the Brush tool 
Pick the Brush Tool and set black as the colour (D, then X). Set the 

Opacity to 100% and paint onto any parts of the image where you 

want the scene below to show. Work along features in the scene to make 

a nice mix, and vary the Hardness of the Brush (Shift + [ or ]). Work with a 

hard edge on detailed areas and a soft one for smoother parts, where 

you should also lower the Opacity for a good blend, like in the sea or sky. 

8
Heal any ‘ghosts’   
If you have moving elements, like boats, try to keep them entirely 

in one mask so you don’t get a ‘ghost’ effect. Sometimes that 

won’t be possible, so when you’re done masking go to Layer>Flatten 

Image, then pick the Spot Healing Brush (J). With the tool set to Content 

Aware, and using a Size slightly larger than the area to fix, run the Spot 

Healing Brush over any ghosts you need to remove.

9
Crop and clone  
Finally, pick the Crop Tool (C), set it to No Restriction and drag it 

over the image, losing the rough edges, then click the tick. You will 

probably have some white areas of canvas left over, so to fix them pick 

the Clone Stamp Tool. Hold the Alt key and click to sample similar parts 

of the scene, then paint them over the offending areas. For more control 

of Cloning and Healing, take a look at Editing Suite from page 99.

7
Mask through the other Layers  
Work through the other Layers in the same way. You can get some 

good effects by masking so that the different scenes overlap in 

places, and here I kept the sunset behind the lighthouse but carefully 

brushed back in the light. As you work, you might find some 

misalignment in the Layers – to help, try holding the Ctrl key and use the 

arrow keys to nudge them so each Layer better matches another.

How to tell you’ve got the shot right

1 Precise alignment    
There should be no ‘ghosting’ 

visible, particularly in the static parts of 

the scene, like buildings or landscape 

features. If the scene has moving 

elements or water it may be impossible 

to remove all ghosts, but won’t be a 

problem if they’re low in opacity. 

2 Smooth blending    
Is there a smooth blend from one 

set of lighting conditions to the next, 

especially in flat areas like the sky? To 

help, run the Gradient Tool over a wider 

area, and use a low Opacity setting 

when masking with the Brush Tool.  

1 3

2

3 Good colour and contrast    
Don’t forget that your day-to-night image still needs to be well processed aside from the 

blending, so concentrate on the colour and contrast too. 
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Digital Edition

Don’t miss it! Available now for just £3.99

 Find the best DSLR  
 or CSC for you 

 Learn new image  
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1
Distance and 
perspective
The distance between 

the camera and a subject has a 

tremendous effect on the 

perspective in your image, and  

in turn this will determine how 

flattering your portrait will be. 

When using a wide-angle lens, 

you’ll need to be very close to the 

subject in order to get a 

traditional head-and-shoulders 

composition. Conversely when 

shooting with a telephoto lens, 

you’ll have to be much further 

away to get the same 

composition. It’s this process of 

physically moving that changes 

the perspective, rather than the 

focal length itself. A change in 

perspective affects how your 

subject will look. Shoot wide-

angle from very close up and 

you’ll get a back-of-a-spoon 

effect where the nose looks big 

and the face convex. You may not 

be able to see the ears at all. 

Shoot from a distance with a 

telephoto lens and the face will 

appear flat. Neither of these will 

flatter your subject. It happens to 

be that 50mm is the most 

attractive focal length because  

for a head-and-shoulders 

composition you’ll be standing at 

a distance that gives a natural-

looking perspective, not dissimilar 

to that of the human eye. This is 

only true on APS-C cameras, 

which have a crop factor. On 

professional full-frame models, 

85mm is the focal length to use.

2
Aperture and 
sharpness
Prime lenses tend to 

have a much wider aperture than 

other types of lenses. Typically, 

an 18-55mm kit lens has a 

maximum aperture of between  

f/4 and f/5.6, whereas prime 

lenses have a much wider 

maximum aperture of between 

around f/1.2 and f/2. Using a wide 

aperture, such as f/1.8 will allow 

for a much shallower depth-of-

field and blurred bokeh 

background. This will leave the 

subject as the only element of the 

image in focus and help them to 

stand out. With what is in focus, 

prime lenses offer an astounding 

level of sharpness in comparison 

to other types of lenses, such as 

zooms. The reason being, for a 

lens to have zoom capability it 

requires moving parts in the 

design. The more moving 

elements in a lens, the more 

sharpness tends to suffer as a 

result. Prime lenses don’t have 

these extra elements, and are 

therefore sharper.

3
Size and weight
Prime lenses have a far 

simpler optical design in 

comparison to other types of 

lenses. They don’t need to 

incorporate extra elements, such 

as moving parts to allow for 
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I’ve been told that a 50mm lens is the best for portrait 

photography. Why are prime lenses, and in particular  

the 50mm lens, the best for taking portraits? 

Jack Hinds, Halifax Jack Hinds, Halifax 

Why is a 50mm 
prime the best 
for portraits? 
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Georgie says: We’re always hearing about which lens is best for 
different types of photography and it can get quite confusing. There are 
so many lenses available at such a range of prices that it’s hard to know 
what to commit to. For the most eye-catching portraits, prime lenses 
tend to be the glass of choice, and in particular the 50mm f/1.8, often 
referred to as the ‘nifty-fifty’. But why is that magical 50mm considered 
to be the best focal length?



zoom, therefore the simpler 

design of primes means that 

they can be much lighter than 

their telephoto counterparts,  

and much smaller too. A lighter 

and smaller lens can be a huge 

advantage when carrying your 

camera or camera bag all day. 

Their compact size means you 

can easily pack them in your 

camera bag and still have plenty 

of room for other gear too, 

allowing for both more flexibility 

and comfort when shooting, as 

there’s simply less weight to 

worry about. For shooting 

portraits, a smaller lens can 

sometimes be less intimidating 

and imposing for your model too 

– a real bonus as you want your 

portrait subject to be as relaxed 

as possible in front of the camera. 

4
Price
The simpler design not 

only allows for less size 

and weight, but it also means 

that primes are cheaper to 

manufacture and therefore 

purchase. The Canon 50mm 

f/1.8 can be picked up for 

around £100, which is a 

mind-blowing bargain. This 

fantastic lens offers the perfect 

focal length for portraits, an 

aperture of f/1.8, creamy bokeh 

backgrounds and pin-sharp 

images, and all in a lightweight 

and compact package that 

doesn’t break the bank. 
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The widest aperture of a lens 

isn’t always the sharpest. 

Select an aperture one-third 

of a stop up from this 

point for sharper 

results.

Tip 
Stop up from the Stop up fr
widest aperture
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The back-of-

a-spoon 

distortion isn’t 

always a bad 

thing. Being 

mindful of the 

effects that your 

lenses can create 

can gives you the 

opportunity to 

experiment with 

quirky and 

alternative 

portraits. Using 

this distortion 

when shooting 

portraits can lead 

to some unusual 

and striking 

portraits. This 

distortion can be 

particularly 

effective when your subject is a child, as it can create 

some fun, charismatic and quirky images. 

Use distortion creativelyRight & 
below PrimePrimebelow
lenses, like 
this Canon 
40mm, are 
often much 
smaller than 
most zooms.most zooms.



Louise says: If you’re shooting 
near puddles, ponds or lakes and 
the conditions are right , 
reflections can be a great way to 
add drama, balance and symmetry 
to your shots. But mirroring a 
scene in water can be trickier than 
it looks, so we’ve put together our 
four top tips for getting images 
with even more impact. 

Wait for calm
For a true mirror image 
you need perfectly still 

conditions so the surface of the 
water is completely flat. This is 
most likely to happen around 
sunrise and sunset, which is 
fortunate as it coincides with the 
soft, warm light of golden hour. If 

you plan to shoot in the water, be 
sure to stand perfectly still for a 
minute or so to let any ripples 
you’ve created die  away. 
Alternatively, leave the water 
completely and use a wireless 
release to trigger the shutter. You 
might also try zooming in on the 
ripples for an abstract, eye-
catching look.

Choose your light
You’ll  get the best 
reflections when the 

water is in shadow, but whatever 
is to be reflected is actually in sun. 
This is common at the start and 
end of the day when the low angle 
of the sun will only illuminate 
higher ground.

Use an ND filter
If the surface of the 
water is slightly rippled, 

it will produce a less-than-perfect 
reflection. However, it’s still 
possible to get a decent result by 
using a longer exposure, which 
will effectively smooth out the 
water ’s surface. In bright 
conditions, this isn’t possible 
without the use of a neutral 
density (ND) filter, which will 
limit the intensity of the light 
reaching the sensor. NDs come in 
a range of different strengths, 
with some reducing your 
exposure by 15 stops. In other 
words, they let through only 
1/32,000 of the light. As you can 
imagine, this produces extremely 
long exposure times. However,
you only really need a 10-15sec 
shutter speed, so a 6-stop ND is 
probably the best one to go for. 
Simply compose your shot, focus 
as normal, attach your filter, and 
flick the focus switch to MF.  
Shoot in manual at f/16, ISO 100, 

and set a shutter speed 6 stops 
slower than if the filter wasn’t 
attached. Should this be beyond 
30sec, you’ll need to shoot in Bulb
mode instead and use a shutter 
release cable.

Get down low
W h e n  s h o o t i n g 
reflections, the lower 

your angle, the stronger the 
reflection will be, as the light will 
glare off the surface. Water is 
transparent, meaning the higher 
the viewing angle, the more likely 
you are to simply see through the 
water rather than the reflection in 
it. It’s best to be reasonably close 
to the water’s surface, so make 
sure you’re on a level with the 
water, rather than elevated on 
higher terrain such as a hill.

I’ve been trying to shoot some landscape reflection 

shots, but without any luck so far. Do you have any 

 suggestions for improving my images? 

Tom Lynch, Haversham 

How do I shoot reflections?
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Strong reflections produce 

striking symmetrical images. 

To exaggerate this, keep 

the horizon in the  

centre of the 

frame.

Tip
 Ignore the  Ignor

 rule-of-thirds 
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Above Get creative, abstract effects from reflections in the water. 

Above Calm, clear conditions 
will allow for impressively crisp 
reflections in large bodies of water.
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Know Your Stuff

Georgie says: Both methods have their 
pros and cons. Using your camera’s 
monochrome setting means that you can 
review images and immediately see what 
they look like in various shades of grey. You 
can then make adjustments according to 
what your image looks like stripped of 
colour, such as changing your settings, 
adding filters or altering the composition. 
The danger is that if you shoot in JPEG 
mode, there’s no going back – your images 
will remain in black & white forever. 

Perhaps the safest option is to shoot in 
RAW and use the monochrome setting to 

review images on the LCD screen only. As 
RAW files consist of unprocessed ones and 
zeros, they’ll still be in their original colour 
form when saved to a hard drive and you’ll 
then have a number of powerful post-
processing options at your fingertips if you 
still want to convert them to black & white. 
The additional benefit of shooting in RAW is 
that the file type retains a much higher level 
of detail and gives you more flexibility when 
it comes to adjusting tonal detail. 

Whichever file type you opt for, there’s no 
denying that a camera’s monochrome mode 
is a great way to hone your eye and visualise 
the world in black & white. This isn’t always 
the most intuitive way of seeing, especially if 
you’re just starting out, and yet it’s an 
undeniably powerful way of capturing 
emotion and atmosphere without the 
distraction of colour.

My new camera has a setting to 

shoot in monochrome. Is it better  

 to use this in-camera setting or convert  

 to monochrome while post-processing?

 Mark Everett, Salford 

Convert RAW files to mono in post-processing

Photoshop
Open Photoshop and go to File>Open. 

Once the image has opened, look at the 

adjustments on the right-hand side of the 

screen and click Channel Mixer. This 

creates an Adjustment Layer and opens  

a properties box. Tick the Monochrome 

option in the properties box. 

Elements
Open Elements and select File>Open,

then click on the Quick or Expert tab. For 

monochrome, click on Enhance>Convert 

to Black and White. Now select a style 

from the options that appear, adjust Red, 

Green, Blue and Contrast to suit your 

image, and click OK. 

Lightroom
Open Lightroom and import your image 

by clicking File>Import Photos and Video.  

Select the Develop tab found at the top 

right-hand side. Then select Basic from 

the list of options on the right and select 

Black & White from the treatment options. 

Your image will convert to black & white.
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My flash portraits are all 

blown out, causing the 

subject’s skin detail to be lost. 

What am I doing wrong? 

Kate McPherson, Bucks 

Tim says: A flash is a fantastic tool 

to have, especially when you’re 

working in low light conditions. 

However, you may find that it’s more 

of a hindrance than a help if you’re 

struggling with unwanted 

overexposure. The first thing you 

can try is simply moving further 

away from your subject – this will 

give the light further to travel, so it 

won’t be as strong. To get the same 

composition as before, zoom in a 

little on your lens. 

Alternatively, try using a 

flash diffuser. You can 

pick these up for a 

few pounds to 

soften light 

and reduce 

flash 

brightness. 

Diffusers are 

available for pop-up 

flashes or external ones. If 

you’re not looking to spend 

money and you already have 

an external flashgun, simply  

tilt it upwards to bounce the 

flash off the ceiling. This 

gives a softer, more 

natural-looking result.

How do I stop my 
flash burning out 
my subject?

How do I shoot in black & white?
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Louise says: If you’ve ever seen a pro studio 
photographer at work, you may have noticed a 
little wire hanging from the side of their camera 
and wondered what it’s for. The answer is that 
this wire tethers the camera to a computer or 

tablet, allowing images to be viewed in a larger 
format during a shoot. This is a great way to 
check focus, lighting and image quality, and it
can show up issues that you simply wouldn’t 
spot on a 3in LCD. 

Some photographers like to use tethering 
when photographing people, as it’s a much 
easier way to show the subject the results as you 
get them. Others use tethering simply as a way 
of backing up shots as they go, eliminating the 
chance of data loss should the memory card fail. 

All you need to work tethered is a copy of 

Lightroom and the 
correct USB cable. 
Tethering works on 
most DSLRs, and some 
Wi-Fi models will even tether wirelessly. 
Third-party wireless tethering products are 
also available, such as CamRanger Wireless 
Camera Control. 

Check out how to set up a standard wired 
Lightroom connection using a USB cable below. 
Once you know it works, you’ll probably want 
to invest in a much longer one. 

What is tethering?
I’ve heard about photographers 

syncing their camera and their  

 computer. Is this really possible and if 

 so, how do I do it? 

Ella Jackson, Manchester

Tether your camera and computer in Lightroom

1
Connect to a computer
Open the connections port on the 

side of your DSLR. There may be 

several slots available but the one you 

want is the USB port. Check your manual if 

you’re not sure which one this is. Insert the 

USB cable that came with your camera, or 

if you have a similar longer cable you may 

wish to use this instead. Plug the other end 

into the USB port on your computer. Turn 

your camera on.

2
Set tethering options
Open Lightroom, and go to 

File>Tethered Capture>Start 

Tethered Capture. This will bring up a 

settings box. Here you can name the 

session and give your shots sequenced 

file names. You can also choose where on 

your computer you want the files saved 

to, and add keywords or metadata to the 

images. Once done, click OK and you 

should see a long control box appear.

3
Take a test shot
In the top-left of the control box, 

you should see your camera make 

and model. This indicates that the 

tethering has worked. If not, check your 

camera is compatible with tethering and 

that the cable is working. You should also 

be able to see your shutter speed, ISO, 

aperture and WB. You can now shoot as 

normal with your camera, or use the shutter 

button at the end of the control box.

If taking your laptop to a shoot 

proves too impractical, try 

connecting your 

camera to a tablet or 

smartphone 

instead. 

Tip
 T Tether to 

 your tablet your tablet 



Know Your Stuff

My shots are coming out 

really dark and I’m not sure  

 why. Any bright ideas? 

 Shona Harrison, London 

Tim says: If your images are always 

too dark, your first port of call should be 

your camera settings. To lighten an 

image, select a wider aperture or 

slower shutter speed to allow more 

light to reach the camera’s sensor. 

Alternatively, increase your ISO, 

although this can increase the amount 

of digital noise on your image. 

If you’re using an automatic mode, 

such as aperture-priority or shutter-

priority, you may want to adjust the 

exposure compensation instead. This 

overrides the camera’s calculated 

exposure and makes the image lighter 

or darker. It’s a sliding scale that’s 

marked with a plus (+) and minus (-) 

sign that can normally be found on the 

LCD. If the slider is to the left of 0, then 

your photos will be darker than they 

should be. Bringing it up to 0 corrects 

the exposure, while sliding it to the right 

of 0 brightens images even further. And 

vice versa for darkening down shots. 

Alternatively, you can change the 

metering mode. Evaluative metering 

considers multiple areas of the frame to 

calculate the correct exposure, centre- 

weighted puts extra emphasis on the 

centre of the frame to work out 

exposure, and spot metering considers 

only a small area in the centre of the 

frame. Switch between metering modes 

to see which is best for your image.

You can also check your LCD’s 

brightness if images look correctly 

exposed when viewed on a computer. 

The LCD’s brightness setting can be 

adjusted in your camera’s menu.  

Georgie says: Touchscreens are 

increasingly popular on cameras, as 

they offer a variety of features that 

aren’t possible on a traditional digital 

camera, such as focus and shoot, or 

touchscreen menus. These features 

can make life easier when shooting, for 

example tapping on your subject to 

focus rather than relying on focus 

points. But this new functionality does 

take some getting used, especially if 

you’ve only ever used traditional 

manual controls. If you’re going for a 

touchscreen for the first time, allow for 

a period of adjustment. 

Touchscreen menus can also be 

slightly slower than traditional manual 

controls. And using the screen to 

control the camera’s features and 

settings can put real strain on the 

battery life, meaning that you will burn 

through batteries far faster than with a 

camera without a touchscreen. 

However, less buttons means that the 

cameras can be smaller, lighter and 

more compact. There’s also more room 

freed up for a larger screen, which can 

be really helpful for those people who 

struggle to review images on standard-

sized LCDs. 

Despite the cost of touchscreen 

cameras reducing dramatically since 

they were released, they’re still, usually, 

the pricier option. The features offered 

by a touchscreen camera aren’t 

essential to get great shots, but they 

can be helpful when shooting. Let’s 

take a look at those features in more 

detail below...

I’m shopping for a new camera 

and keep seeing touchscreen  

 cameras. Is a touchscreen an essential  

 feature that I should be looking for? 

Sam West, Birmingham 

Do I really need to own a 
touchscreen camera?

Why are all my 
photos so dark?
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Above The exposure compensation Above
scale can be found on the LCD screen.

FOCUS 
AND SHOOT

Touchscreen boasts 

the ability to select the 

focus point by tapping the 

subject on the screen, 

saving time adjusting the 

focus points or struggling 

to select the subject 

that you want.

NAVIGATE 
MENU

You can use the 

touchscreen to navigate 

the menu, rather than 

physical buttons and 

controls. Simply tap the 

screen to adjust your 

settings in the 

menu.  

REVIEW 
IMAGES

While reviewing 

images, you can flick 

through by dragging your 

finger across the screen. 

You can also zoom in on 

areas of the image to 

check the accuracy 

of focus. 

CHANGE 
SETTINGS

Instead of using 

buttons to change 

settings, you have access 

to controls via the screen 

and can adjust settings 

and select items on the 

menu by touch 

alone. 



Editor Ben Hawkins 
analyses and critiques 
your best images. Send 
them to ppsubmissions
@bauermedia.co.uk

Ben Hawkins

With over 15 years 

as a photographic 

journalist under his 

belt, Ben is a very 

experienced picture 

editor, writer and 

competition judge.

Feedback

The big yawn 
by Ivan Vukelic

When I visit my town’s  

zoo, I always head for the 

jaguar first because its 

habitat is perfect for taking 

photos. On this day there 

wasn’t much of a crowd 

and I was able to take 15 

images from different positions. I adjusted 

the colours, contrast and sharpness in 

post-processing. I always try to focus on 

the animal’s eyes and Nikon’s 70-200mm 

f/4 lens makes this very easy. It helped 

that the animal was in a good mood too. 

500px.com/ivovuk 

Ben says: The difference between a simple 
record shot and an insightful portrait that 
tells us more about the subject often comes 
down to one thing – behaviour. Ask any 
wildlife photographer worth their salt – and 
this issue features some of the world’s best 
(see page 30) – and they’ll tell you that 
images of hunting, feeding and running are 
always going to be more captivating than 
head-and-shoulder profiles. In Ivan’s case 
we’ve got a giant yawn, and because we can 
all empathise with being tired and having a 
good old yawn, we can immediately identify 
with this feline beauty. The fact that it was 

taken in captivity adds an extra layer of 
intrigue – this is a very clean image, with 
nothing to distract the viewer from the star 
of the show. The jaguar’s teeth and tongue 
are pin-sharp and those whiskers contrast 
perfectly with the dark backdrop. And Ivan’s 
timing was spot-on, capturing the yawn at 
its widest and most impressive. It’s easy to 
be snobbish when it comes to wildlife 
photography, but this shot goes to show that 
if you’re learning a craft, there’s more than 
one way to hone your skills.  And if I worked 
in this zoo’s publicity department I’d be 
banging Ivan’s door down asking for more. 

This is a 
very clean 
image with 
nothing to 
distract the 
viewer from 
the jaguar
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1
Aperture 
A zoom that goes up to 

300mm combined with a 

wide aperture of f/2.8-5.6 will 

provide you with a shallow 

depth-of-field and the ability to 

focus the viewer’s attention on 

your subject while leaving out as 

much of the zoo’s surroundings 

as possible. 

3
Viewpoint
Glass and bars are there 

for good reason, but they 

are a hindrance when looking for 

uninterrupted views. Glass is 

easy to deal with – simply rest 

your lens hood against it to 

eliminate any reflections. Avoid 

flash – it’ll scare the animals and 

flare off the glass. 

2
Background
Concrete walls, man-made 

features, other visitors... 

zoos can certainly be a challenge 

when it comes to finding a clean 

backdrop. Patience and 

perseverance will pay dividends, 

as will visiting at quieter times, 

as you’ll be able to walk around 

and find the best angle. 

Get the most from your trip to the zoo   

Nikon D600 | 200mm | 1/400sec | f/4 | ISO 200
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Pro image critique 
We asked award-winning travel pro 

Philip Lee Harvey (philipleeharvey.com) 

to cast his critical eye over Manish’s 

image. “This has all the right 

ingredients to work,” he says, “but 

more thought should have gone into 

the in-camera composition. I’d suggest 

thinking about how you compose 

before you take the image. Be aware 

that there’s another photographer to 

the left of the frame and either zoom in 

or get closer to avoid including them. 

Think in rule-of-thirds, as the right and 

bottom of the frame don’t add anything to the final image. See my suggested crop. A little 

editing work would also help to lift or brighten the shadows.”
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Manish 
closely 
followed and 
observed the 
horses for 
four days

Rural Olympics
by Manish Jaisi 

The Kila Raipur Sports 

Festival is held in a small 

town in Punjab, India. The 

event lasts for four days 

and consists of bullock 

cart racing, wrestling, 

kabbadi and various track 

events. This shot depicts a horse rider 

trying to position his horse on the starting 

line. I tried to convey a sense of place and 

emotion so chose a wide-angle lens – with 

the dust in the air, the setting sun and the 

town in the background, this frame really 

stood out. I made minor adjustments to 

contrast and clarity in Lightroom to 

enhance the dust. 

500px.com/manishjaisi 

Ben says: Of all the pro photographers 
we’ve featured, the one whose work has 
stood out, largely due to his masterful use of 
light and shade, is travel guru Philip Lee 
Harvey. It’s rare that you can look at an image 
and instinctively know who squeezed the 
shutter, but Philip’s style is so distinctive that 
it’s relatively easy to pick his work out of an 
ID parade. It wasn’t by accident that he was 
this magazine’s columnist until very recently. 
So when I say that Manish’s shot has a certain 
Philip Lee Harvey charm about it, I mean it 
as a huge compliment. Raking light, 
sun-kissed dust, evocative sense of place... it’s 
a beautifully realised picture. 

The event itself sounds fascinating. 
Known locally as the Rural Olympics, I’d pay 
good money to see bullock cart racing and 

people pulling cars with their teeth (yes, 
that’s an actual event – IOC eat your heart 
out). Manish fell in love with the horses and 
followed them closely during the four-day 
event, allowing him to observe them and 
learn to anticipate the moment. Of course, his 
choice of focal length conveys more than just 
the action, as we can see hundreds of 
spectators and the small town of Kila Raipur 
beyond. The rest of the settings make sense 
too – the fast shutter speed to freeze the 
action and the wide aperture to focus our 
attention on the horse and its rider. There’s 
very little to criticise here, though I’d be 
tempted to tighten the crop slightly, maybe 
even to a 16x9 ratio panoramic, and lighten 
the midtones a touch. Let’s see what Philip 
Lee Harvey has to say...   

Canon 600D | 11mm | 1/1000sec | f/2.8 | ISO 100



Ben says: Multiple-exposure photography 
is almost as old as the medium itself. 
Sometimes created in-camera, other times by 
overlaying two or more negatives or digital 
files, it’s become hugely popular in the digital 
age and an increasing number of cameras 
feature a multiple exposure mode. Often seen 
as a way of bending or enhancing reality in 
some way, examples range from simple ‘two 
images into one’ overlays to more complex 
‘one person in numerous places at the same 
time’ montages. Legends such as Man Ray 
and Robert Mapplethorpe were both fans, 
and these days a Google Image search yields 
a smorgasbord of weird and wonderful 
multiple-exposure creations. Ruslan’s is one 
of many examples, and the reason we chose 
this particular shot is that we were drawn to 
its almost graphic art feel and rather wistful 
atmosphere.  

As Ruslan says, capturing the perfect 
mood can be challenging, especially when 
you’re trying to match a second layer of 
creative content at the same time, but the 
model’s piercing gaze certainly grabbed our 
attention and suggests that he achieved his 
aim. The foliage and flocks of birds perfectly 
match the model’s thoughtful expression and 
the overall effect is at once beguiling and 
captivating. While debating the merits of 
Ruslan’s image, a few members of the team 

commented on the prominent positioning of 
the hand and questioned whether it needed 
to be included, as it prevents us from seeing 
the model’s full profile. It’s a question of 
personal taste and personally I can take or 
leave it – I can see why Ruslan included it, but 

cover it up and the image becomes much 
cleaner. Also, there’s a lot white space around 
the head and shoulders (we cropped a lot out 
to fit the page), which is a plus or a minus, 
depending on its intended use. Consider me 
a fan, however – it’s right up my street. 
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We were 
drawn to its 
wistfulness 
and graphic 
art feel

Creative exposure 
by Ruslan Isinev

I used a Nikon D700 

with 85mm f/1.4 lens 

and the portrait itself 

only took 10 minutes  

or so to get right. The 

biggest challenge was capturing the right 

emotion in the model’s face. The birds 

were added in Photoshop to complement 

the wistful mood. I found that capturing 

double exposures wasn’t as difficult as I 

initially thought and I was really pleased 

with the final image. I learned that for this 

technique to work well you have to find a 

contrasting background – in this case it 

was an overcast sky.   

facebook.com/Isinev.Ruslan 

Nikon D700 | 85mm | 1/4000sec | f/2.5 | ISO 200

Get double exposures in-camera
Find your camera’s multiple exposure mode – it’ll 

probably be tucked away in the menu somewhere 

– and select RAW. Set ISO to between 100 and 

400, and turn to the mode dial to aperture-priority. 

A medium aperture of f/5.6 will provide enough 

depth-of-field. Shoot the portrait with empty sky 

behind the model, and think about where any 

foliage needs to be positioned before shooting the 

second image. A blended version will appear on 

screen. It can be a hit-or-miss technique, so keep 

shooting until you’re happy with the results. Check 

out the May 2016 issue for more ideas. 
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This shot 
is so much 
more than 
just a family 
portrait

Causeway sunset
by Mamraz Nagi 

My aim was to capture a 

meaningful family portrait. 

I knew the Giant’s 

Causeway’s stones and

folklore would capture my 

sons’ imagination so we 

set off with the hope that 

the weather would be good. I quickly set 

up my camera on a tripod, set the remote 

and ushered my wife and kids into place. 

We all just about managed to stand still! 

Afterwards I adjusted the highlights and 

shadows and tweaked contrast and colour 

balance. I love this shot as it’s not your 

normal ‘run of the mill’ family portrait.  

nagitography.com

Ben says: County Antrim’s coast is gloriously 
wild and windswept, and the Giant’s 
Causeway is just one of many jewels in its 
crown. As magical as this geological marvel 
is, however, it’s surprisingly modest in size 
– possibly as a result of landscapers using 
wide-angle lenses to exaggerate the 
appearance of its unique basalt columns, it 
always seems to looks bigger in photos! 
Mamraz has adopted a tried and tested 
approach, opting for a 16-35mm L-series 
zoom set to 17mm, and letting the causeway 
itself provide the composition, with the rocks 
leading us to the main focal point. 

Mamraz’s aim was to create a family 
portrait with a twist, and it’s fair to say that 
he’s aced this, but this shot is so much more 
than that. The level of crisp detail, the 
sumptuous colours in the sky and the 
silhouetted figures combine to make this an 
evocative landscape that utilises scale, depth 
and emotion to draw the viewer in. On a more 
technical note, although Mamraz doesn’t say 
whether a filter was used, I’m guessing not as 
the setting sun behind the figures is blown 
out and trickles over the edge of the histogram 
mountain. A 2- or 3-stop ND grad would have 
solved this problem. Saying that, this image 
isn’t about technicalities – no doubt Mamraz’s 
kids will proudly hang this shot on their walls 
in years to come and look back fondly. 

Canon 6D | 17mm | 2sec | f/16 | ISO 160

Check your camera’s histogram 
The histogram is a graphic 

representation of a photo’s tonal range, 

with solid black at one end and solid 

white at the other. It’s an overlooked 

tool that can be incredibly useful when 

assessing exposures, as it can tell you 

what adjustments you need to make. 

You don’t need to check it after every

shot you take, but if you’re working with 

extreme contrasts, as in Mamraz’s case,   

we’d always recommend you check for 

under- or overexposure, which will be 

represented by heavy concentrations on 

one or both sides of the histogram. 
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Gives us 
some idea 
of the bird’s 
immense 
size and 
power

Prepare for takeoff
by Jim Houlbrook 

I popped into the Hawk 

Conservancy Trust in the 

New Forest as I had a free 

day. I’d stopped to take 

the weight off my feet 

when one of the staff 

brought this magnificent 

bird out for its daily exercise. I caught this 

shot just as it was about to take off. I’d 

set the shutter speed and aperture so as 

to give me the best chance to capture a 

decent in-flight shot. 

bigjimphoto.co.uk 

Ben says: What a handsome beast! Bald 
eagles (known as Haliaeetus leucocephalus to 
their mums) can grow to over a metre in 
length and weigh up to 6.3kg, and this tightly 
cropped portrait gives us some idea of its 
immense size and power – pity the prey that 
gets caught in that yellow beak. This is a very 
different kind of wildlife shot than Ivan 
Vukelic’s on page 86, but is no less compelling 
– the beady eye, the ragged plummage and 
the stoic pose all add up to a classic profile 
image. Compositionally, I’d like to see more 
of the bird and less of the background, as it all 

feels a bit squashed, and positioning the 
eye on the top-left intersecting third would 
give the shot more room to breathe while 
adding balance. Zoomed in, there’s also 
evidence of JPEG compression and/or 
oversharpening, particularly in the blurred 
green background, which lacks a smooth 
tonal gradation as a result. It’s not a deal-
breaker by any means, but it’ll certainly limit 
the size Jim is able to produce attractive 
prints at. Minor technical grumbles aside, 
however, this is still a striking portrait and 
one Jim should be proud of. 

Nikon D7200 | 200mm | 1/1000sec | f/5 | ISO 400

1
Shoot fast
Birds can move 

faster than we can 

react, so give yourself the 

best possible chance of 

getting the shot by 

switching to continuous 

shooting mode and 

working in short bursts. 

Even the slowest DSLRs 

can manage up to three 

frames-per-second, which 

is still faster than you 

could manually squeeze 

the shutter button. 

2
Use your car
Hides offer great 

camouflage, but if 

you’re on the move and 

spot a promising photo 

opp, your car will mask 

your movement. Wind the 

window down and avoid 

sudden movements.

3
Select AF
Your camera’s 

central autofocus 

point is the fastest and 

most accurate.

3 tips for photographing birds 
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Factfile
Photographer: Olivia Acland

Full-time occupation: Freelance 

journalist & photographer

Aim of project: Capturing 

people’s stories to illustrate 

newspaper articles about Street 

Child’s Sierra Leone project 

Duration: I’ve been 

working in Sierra Leone 

for five months now –  

I arrived at the end of January

Time spent: I usually 

work on a project per 

week. Each day Street 

Child takes me to meet about five 

different people they’ve helped 

and I try to capture them in their 

home environments 

Images taken: Oh god, 

thousands! I generally 

take a lot and choose the 

best few to send to the journalist 

I’m working with 

Website: oliviaacland.co.uk 

Olivia’s 

photography 

project was in 

support of 

Street Child’s 

‘Girls Speak 

Out’ appeal, which aims to ensure 

that girls’ voices are heard and 

their issues are confronted across 

Sierra Leone and Liberia. Street 

Child hopes to raise a minimum of 

£1million to help 20,000 children 

stay in school and gain a quality 

education. The UK government will 

double all donations from now until 

17 July 2016. To support the 

appeal, visit street-child.co.uk

Almost 50,000 
children call the 
streets of Sierra 
Leone home. Olivia 
Acland is working to 
improve their lives...  
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MY PHOTO

PROJECT
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B
egging, collecting 
r u b b i s h ,  e v e n 
prostitution; these are 
just some of the ways 
that homeless children 
survive in Sierra Leone. 
It’s a desperate way of 
life, more so because 

some of these children are as young as six. 
Olivia Acland works alongside Street Child 
to raise awareness, reunite these children 
with their families, and provide education. 
For her this is a very personal project...

 How did you become involved with  

 Street Child? 

I heard about Street Child through a friend 
in Freetown, Sierra Leone’s capital. He’d 
done some photography work with them 
before and put me in touch with someone 
on their team, Martin. To be honest I didn’t 
know much about the charity when Martin 
first contacted me, so I did a bit of Googling 
and reading up on its projects. I liked the 
look of what it did and said yes to the photo 
job straight away.

 What was your first Street Child shoot  

 and was it successful? 

The first time I worked with Street Child was 
on a ‘Girls Speak Out’ appeal. We went 
around with a journalist who was writing 
about the appeal, interviewing girls the 
charity was planning to support. Each girl 
had a horrific story – some were prostituting 
themselves at night so they could afford to go 
to school in the day, others were sleeping 
with much older men who would help to 
support them in return, and when these girls 
fell pregnant they were abandoned by the 
men. The Street Child appeal was aiming to 
raise money to put them back in school. 

After perhaps four or five interviews with 
young girls – each either pregnant or holding 
a small child – I started to feel emotionally 
worn down. I’d come across many dreadful 
stories of suffering in Sierra Leone, but I 
hadn’t heard so many in such a condensed 
period of time. I realised how huge the scale 
of the problem was and felt a little hopeless. 
At the same time I was happy that this 
charity was taking notice and doing 
something to help.

 What are the challenges of working on  

 a personal project of this kind, both  

 physically and mentally? 

There have been plenty of moments while 
working as a journalist in Sierra Leone when 
I wonder if writing about the problems or 
photographing them is really enough, and if 
it will make any difference. However, on this 
occasion I was very aware that the results of 
my work would be tangible – I was taking 
photos for an article about Street Child’s 
work that was going to be published in a 
national newspaper with a link below it on 
how to donate. 

I felt tired during the four-day photo 
shoots, but I think it was mostly the emotional 
exhaustion of hearing how dark so many 
people’s situations were.

There was a helpless feeling that so much 
in the country needs to change and it will take 
years. The days were generally quite long, as 
we’d start early and drive from town to town 
meeting different interviewees. In the humid 
heat you sometimes lost energy, but a few 
well-timed Coca-Cola pit stops usually 
helped with that.

My Photo Project Olivia Acland

Adama, 16, and her 
friends outside their 
house in Port Loko, 

western Sierra Leone. 



 How do the girls in Sierra Leone react  

 to you and your camera? 

If people know what you’re doing they 
generally respond very well. If you just start 
shooting without interacting first, girls can 
get nervous. I usually have a chat and show 
them the first few pictures I’ve taken of them 
and they relax. Being a woman definitely 
helps when taking photos of girls. A male 
photographer friend of mine tells me he 
sometimes gets treated like an intruder and 
women can be suspicious of him. The 
language barrier is rarely a big problem – I can 
speak a few words of Krio and when you’re 
asking someone if you can take their photo 
you can make it pretty obvious in gestures.

 Street Child helps vulnerable girls stay  

 in school – how do you go about  

 interpreting this visually? 

I’ve been to some schools to meet girls who 
are there because Street Child has supported 
them, and I’ve shot them in their classrooms 
and school playgrounds. I’ve also been to 
meet girls who are not yet on the scheme but 
that Street Child is hoping to support. Often 
these shoots were more challenging, as some 
of these girls were depressed and desperate 
for help. I sometimes felt awkward shooting 
them looking upset, but I also wanted to 
capture an expression that was relevant to 
what they were saying. I remember one 
15-year-old girl looking as though she was 
about to cry during the interview, saying that 
she barely had money to feed herself or her 
daughter. The journalist and I quickly 
decided to cut the interview short and not 
shoot her, as it felt too intrusive.  

On the first Street Child photo shoot I was 
nearly always sitting in on the interview and 
wondering which kinds of pictures would be 
relevant to the article. For example, one girl 
was talking about having to walk into town 
every day to sell cooking utensils to earn a 
living. I took some pictures of her standing 
beside various utensils that just happened to 
be on the wall by her house. But on the second 
shoot I stopped listening in to all the 
interviews – I thought perhaps the girls 
would feel less comfortable speaking to a 
larger group of people. I tended to ask the 
journalist about the story afterwards, and 
find out what he wanted to come across 
in the shots.

Above Ebola survivor Aja was bullied because of the stigma attached to surviving. 
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Above Bintu is one of 18 Ebola orphans being cared for by her elderly grandmother. 

Above The rubbish dump in Eastern Freetown where homeless search for plastic to sell. “Being a woman 
definitely helps  

when taking photos 
of girls”



 How has this project evolved? 

Working with Street Child has made me 
experiment with different environments, 
from trying to catch a wider scene – such as 
people working on the smoking rubbish 
dump – to wanting to capture a certain look 
in a girl’s expression. My hit rate improved as 
the project went on, although it would 
depend on the conditions – for instance, if the 
light was good or if the subject wasn’t 
awkward being photographed. When I was 
shooting one girl I’d usually come away with 

20-30 pictures from different angles and with 
different expressions. I’d switch to burst 
mode so that I could catch the right look. 
Then I’d choose the best one or two to hand 
over to the journalist.

 How do you adapt your approach and  

 technique to suit the subject? 

If I’m shooting a wider scene, I obviously use 
a wide-angle lens. I also try to ask the 
journalist doing the interview to sit in a 
certain place so that the best light falls on the 

subject while they talk. This way I can catch 
the subject in a candid moment as they’re 
telling their story. For portraits I nearly 
always use my 35mm lens at f/1.8 and I try to 
get something out of focus in the foreground, 
for example their bare feet. This gives a sense 
of distance and space.

 What have you learned personally  

 and professionally? 

I’ve learned to try to get that great shot that 
will accompany the article and to think about 
what the essence of this photo should be – 
what else should be shown in the composition 
to set the scene, and how to get the subject’s 
character across. As I said before, I do this by 
shooting quite a lot of photos to get the right 
one, but I also often position the subject in a 
certain place to get the right light falling on 
them. Then I think whether or not I should 
include something else in the shot – cooking 
utensils, their young child, school books etc. 

 Personal projects should tell a story  

 – what’s the collective story here? 

The photo shoots focused on girls’ education 
and the subjects were either girls who had 
been helped to go to school or those who 
should be helped in the near future. Their 
own life stories were difficult and depressing. 
They were all suffering extreme poverty and 
desperate to get an education. Street Child 
has helped some already and the current 
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Above Ericson, 25, looks after 11 Ebola orphans who’re all the children of his dead relatives.

Kadiatu and her 
daughter in her 
sparse kitchen 

near Makeni. 
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Olivia’s 5-step guide to better personal projects 

1
Practise is crucial –  

I love taking the 

camera to crowded 

places and trying to catch 

people in certain moments.  

I often shoot unsuspecting 

passers-by just to hone my eye 

and improve my reflexes. 

2
Being fast enough to 

get a particular 

moment on camera is 

important, so it’s good to have 

the camera to hand as much 

as possible. If you hesitate or 

fumble with your settings, 

you’ve often lost the moment. 

And that feeling of losing the 

moment is much worse than 

having an overexposed photo 

or an angry stranger shouting 

at you because you took a 

picture of them smelling their 

armpits (this happened to me).

3
I’m inspired by other 

people’s work and 

find it helps to look at 

photo books that display the 

settings in which the pictures 

were shot. This way it’s easy to 

learn which kind of aperture or 

shutter speed can create 

which effect and in which kind 

of light etc. I also try to go to 

as many exhibitions as I can.

4
It helps to experiment 

with camera settings 

and not get stuck on 

one particular type of shot that 

works for you. Photographing 

a wide variety of subjects from 

stormy seascapes to bits of 

old rope, piles of rotten food 

and moving insects keeps 

things fresh.

5
Certainly being in a 

colourful place that 

inspires you helps.  

I often feel that Sierra Leone 

(though plagued with many 

problems) is such a beautiful 

country that it’s hard not to get 

good photos. The light can be 

incredible and the colours of 

the buildings, buses and 

clothes come as gifts. Feeling 

excited by a new environment 

usually inspires me to take a 

lot of pictures. 

appeal should help more. I hope to shoot 
those people a couple of years down the line 
when their lives have improved and we can 
see the direct result of the charity’s work. So 
many of their situations were so bleak that it 
would be very encouraging to meet them 
again and see that their lives have taken a 
better turn with a bit of help.

I also took photographs of the marathon 
that Street Child organises. This was a very 
fun and light-hearted event – I set off at 6am 
on the back of a motorbike and spent hours 
chasing the runners and catching them 
mid-race. I then had to speed to the finish 
line in time to photograph the winner 
exhaustedly crossing it. Joggers from around 
the world gallop 27km through Makeni in 
30°C heat!

 What’s next for you and Street Child? 

I’ve just finished two photo shoots  
for Street Child and I hope to take more 
photos again, next time there is another 
journalistic project in Sierra Leone. Working 
as a photographer on this appeal I saw 
first-hand the suffering of so many girls that 
the charity was trying to help. I saw the 
sheer enormity of the problem and witnessed 
how many people have unbelievable stories 
of hardship. 

It sounds like a cliché, but giving just a 
pound a month really can make an enormous 
difference. The amount of money that some 
of these people were surviving on was 
remarkably small. The girls had found 
themselves exploited by older men because 
they needed someone to pay £50 a year to 
send them to school. It seems like such a 
small sum of money to us in the West. In this 
sense it’s empowering because you know that 
a £50 donation can really send a girl to school 
for an entire year. Above A young boy from Kpondu, the village where Ebola first struck, greets Olivia.

Above Adama standing proudly next to kitchen utensils similar to those she used to sell. 

Olivia Acland My Photo Project

If you have a unique body of 

work you’d like to share with 

the world, drop us a line at 

practical.photography@

bauermedia.co.uk

 We want  
 to see your  

 photo projects!
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Canon EOS 750DCanon EOS 750D

24.2
MEGA

P I X E L S 5 FPS

Body only

£409.00*

+ 18-55 IS STM

£479.00*

*Prices include £50 cashback from 
Canon. Ends 31.08.16.

£50
cashback

Canon EOS 760D

24.2
MEGA

P I X E L S 5 FPS

Body only

£499.00*
See website for low 

prices on lenses

*Price includes £50 cashback from 
Canon. Ends 31.08.16.

£50
cashback

Canon EOS 70D

20.2
MEGA

P I X E L S 7 FPS

Body only

£697.00

+ 18-55 IS STM

£722.00

Add a Canon BG-E14 battery grip
for only £149.00!

Canon EOS 7D Mark II

20.2
MEGA

P I X E L S 10 FPS

Body only

£1,299.00

+ 100-400 L IS II

£2,778.00

Visit us in store or online to see how 
you can claim Canon lens rewards!

Canon EOS 6DCanon EOS 6D

20.2
MEGA

P I X E L S

Body only

£1,119.00

+ 24-105 IS STM

£1,489.00

Add a Canon BG-E13 battery grip
for only £174.00!

Canon EOS 5Ds

50.6
MEGA

P I X E L S

Body only

£2,699.00
See website for low 

prices on lenses

Add a Canon BG-E11 battery grip
for only £225.00!

Canon EOS 5Ds r

50.6
MEGA

P I X E L S

Body only

£2,899.00
See website for low 

prices on lenses

Add a Canon WFT-E7 wireless fi le 
transmitter for only £599.00!

22.3
MEGA

P I X E L S 6 FPS
3.2” 1080p

The EOS 5D Mark III is a full-frame 22.3 MP DSLR with 61-point 
autofocus and 6fps continuous shooting. Capture high-quality
Full HD movies, with manual control over everything from frame 
rate to audio.

64GB Extreme Pro SDXC 95MB/s Class 10 card (95MB/s) worth £56!

Quote PRACTICAL PHOTOGRAPHY & receive a FREE SanDisk

Canon EOS-1D X Mark II

20.2
MEGA

P I X E L S 14 FPS

See website for latest 
information on availability!

Claim a FREE SanDisk 64GB Extreme 
PRO CFast 2.0 Card and Reader!

Body SRP
£5,199.00

NEW!

AF-G 10.5mm f/2.8G ED DX  £549.00
AF-D 14mm f/2.8D £1,199.00
AF-D 16mm f/2.8D Fisheye  £625.00 
AF-S 20mm f/1.8G ED £579.00 
AF-D 20mm f/2.8  £463.00 
AF-D 24mm f/2.8D  £369.00
AF-S Nikkor 24mm f/1.4G  £1,379.00
AF-D 28mm f/2.8  £245.00
AF-S 28mm f/1.8G  £495.00 
35mm f/2 AF Nikkor D  £255.00 
AF-S 35mm f/1.8G ED  £399.00 
AF-S 35mm f1.8G DX  £151.00 
AF-S 40mm f/2.8G ED  £199.00 
AF 50mm f/1.4D  £244.00 
AF-S 50mm f/1.4G £349.00 
AF-D 50mm f/1.8  £109.00
AF-S 50mm f/1.8G  £179.00 

AF-D 60mm f/2.8 Micro  £368.00 
AF-S 60mm f/2.8G Micro ED  £439.00 
AF-S 85mm f/3.5G DX  £389.00 
AF-S 85mm f/1.8G  £399.00 
AF-S 105mm f/2.8G VR  £659.00 
AF-DC 105mm f/2 Nikkor £805.00 
AF-D 135mm f/2.0D £1,029.00 
AF-D 180mm f/2.8 IF ED  £695.00 
AF-D 200mm f/4D IF ED  £1,179.00 
AF-S 200mm f/2G ED VR II  £4,099.00 
AF-S 300mm f/2.8G ED VR II  £3,999.00 
AF-S 300mm f/4 D IF-ED £999.00
AF-S 300mm f/4E PF ED VR  £1,499.00
AF-S 400mm f/2.8 FL ED VR £8,999.00 
AF-S 500mm f/4G ED VR £5,849.00 
AF-S 500mm f/4E FL ED VR  £8,149.99 
AF-S 600mm f/4E FL ED VR £9,649.99 

AF-S 800mm f/5.6E FL ED VR £12,990.00 
AF-S 10-24mm f/3.5-4.5G  £639.00 
AF-S 16-80mm f/2.8-4E ED VR £769.00 
AF-S 16-85mm f/3.5-5.6G  £499.00 
AF-S 17-35mm f/2.8 IF ED  £1,347.00 
AF-S 17-55mm f/2.8G DX  £979.00 
AF-S 18-35mm f/3.5-4.5G  £519.00 
AF-S 18-105mm VR  £204.00 
AF-S 18-140mm ED VR DX  £429.00
AF-S 18-200mm ED DX VR II  £534.00
AF-S 18-300mm f/3.5-6.3 VR  £549.00 
AF-S 24-85mm VR £359.00 
AF-S 28-300mm ED VR  £699.00 
AF-S 55-200mm f/4-5.6G VR II  £229.00
AF-S 70-200mm f/2.8 VR II £1,679.00 
AF-S 70-300mm IF ED VR  £429.00 
AF-S 200-400mm VR II £5,199.00

NIKON LENSES
Prices updated DAILY! Visit us in store, online at 

parkcameras.com/prp or call our expert team on 01444 23 70 54

Nikon D5

20.8
MEGA

P I X E L S

See website for latest 
information on availability!

Receive a FREE 32GB XQD Card & 
USB 3 Card Reader when pre-ordering

Body SRP
£5,199.00

NEW!

153
AF

P O I N T S

Nikon D500

20.9
MEGA

P I X E L S

See website for latest 
information on availability!

Eligible for 12 months interest free 
credit. Call 01444 23 70 54 for details

Body SRP
£1,729.00

NEW!

10 FPS

Nikon D810

36.3
MEGA

P I X E L S

Body only

£2,139.00

+ 24-70 f/2.8 ED

£3,523.00

Add a Nikon MB-D12 battery grip
for only £284.00!

Nikon D610

24.3
MEGA

P I X E L S 6 FPS

Body only

£999.00

+ 24-85 VR

£1,499.00

Visit www.parkcameras.com/used
for pre-loved D610 bodies

Nikon D7200

24.2
MEGA

P I X E L S 6 FPS

Body only

£714.00

+ 18-105 VR

£888.00

Add a Nikon MB-D15 battery grip
for only £229.00!

Nikon D5500

24.2
MEGA

P I X E L S

Body only

£499.00

+ AF-P 18-55 VR

£569.00

Add a Panasonic EN-EL14a spare 
battery for only £40.00!

24.3
MEGA

P I X E L S 6.5 FPS
3.2” 1080p

In a world where anything is possible, this full-frame 
24.3-megapixel powerhouse gives you the freedom to dare. 
The newly designed FX-format sensor delivers exceptional image 
quality with cleaner results than ever before at high ISOs.

£1,390.00
Body only

£1,716.00
+24 -85 VR

£1,979.00
+24 -120 VR

For up to £150 cashback on selected Nikon lenses, see in store or visit 
www.parkcameras.com/nikon-lens-cashback

PANASONIC LENSES
14mm f/2.5 II Pancake £299.00
20mm f/1.7 II ASPH £269.00
45mm f/2.8 Macro  £498.00
42.5mm f/1.2 O.I.S  £1,099.00
7-14mm f/4.0 ASPH  £739.00 
12-60mm f/3.5-5.6 ASPH £359.00
14-140mm f/3.5-5.6  £405.00
35-100mm f/2.8 O.I.S £799.00
45-175mm f/4.0-5.6 O.I.S  £279.00
100-300mm f/4-5.6 O.I.S  £378.00
100-400mm f/4.0-6.3 £1,349.00

See website for even more lenses!

Panasonic GX80

16
MEGA

P I X E L S

+ 12-32mm

£549.00*

Twin lens kit

£679.00*

*Prices include £50 cashback from 
Panasonic. Ends 05.09.16.

Olympus E-M10 Olympus E-M10Olympus E-M10 Mark II

16.2
MEGA

P I X E L S 8 FPS

Body only

£449.00

+ 14-42mm EZ

£549.00

Add an Olympus BLS-50 spare 
battery for only £49.99

Sony RX10 III

20.1
MEGA

P I X E L S

Add a Sony NP-FW50 spare battery 
for only £64.95

In stock at only

£1,249.00
Try this camera 

out in store!

25x

NEW!

Olympus E-M5 Olympus E-M5Olympus E-M5 Mark II

16.1
MEGA

P I X E L S

Body only

£749.00

+ 12-50mm

£879.00

Add an Olympus BLN-1 spare
battery for only £54.95

Ends 29.06.16

Panasonic FZ1000

20.1
MEGA

P I X E L S

In stock at

£599.00

Add a Panasonic BLC12E spare 
battery for only £49.00

16x

14mm f/2.8L II USM  
20mm f/2.8 USM                      
24mm f/1.4L Mk II USM 
24mm f/2.8 IS USM £455.00
EF-S 24mm f/2.8 STM £127.00
28mm f/1.8 USM                     £345.00
28mm f/2.8 IS USM £389.00
35mm f/1.4L USM 
35mm f/1.4L II USM  £1,799.00
35mm f/2.0 IS USM 
40mm f/2.8 STM 
50mm f/1.2 L USM 
50mm f/1.4 USM 
50mm f/1.8 STM  £97.00
EF-S 60mm f/2.8 Macro 
MP-E 65mm f/2.8 
85mm f/1.2L II USM £1,499.00 
85mm f/1.8 USM  £249.00
100mm f/2 USM  £349.00
100mm f/2.8 USM Macro £373.00
100mm f/2.8L Macro IS £619.00
135mm f/2.0L USM   £679.00
180mm f/3.5L USM £1,049.00

200mm f/2.0L IS USM  £4,350.00
200mm f/2.8L USM/2 £569.00
300mm f/2.8L USM IS II  £4,499.00
300mm f/4.0L USM IS £959.00 
400mm f/2.8L USM IS II  £7,698.00
400mm f/4.0 DO IS II £6,999.00
400mm f/5.6L USM £889.00
500mm f/4.0L IS MK II  £6,499.00
600mm f/4.0L IS MK II  £8,895.00 
800mm f/5.6L IS USM £9,899.00
TSE 17mm f/4.0L £1,449.00
TSE 24mm f/3.5L  II  £1,479.00
TSE 45mm f/2.8 £934.97
TSE 90mm f/2.8  £1,124.00
8-15mm f/4L Fisheye USM  £999.00
EF-S 10-18mm IS STM £179.00
EF-S 10-22mm f/3.5-4.5 £377.00
EF 11-24mm f/4L USM £2,799.00
EF-S 15-85mm f/3.5-5.6 IS   £529.00
16-35mm f/2.8L II USM £1,060.00
16-35mm f/4.0L IS USM  £682.00
17-40mm f/4.0L USM £549.00
EF-S 17-55mm f/2.8 IS USM £519.00

EF-S 18-135mm IS STM £329.00
EF-S 18-200mm f/3.5-5.6 £385.00
24-70mm f/2.8L II USM £1,400.00
24-70mm f/4.0L IS USM £675.00
24-105mm f/4.0L IS USM £727.00
24-105mm f/3.5-5.6 IS STM £375.00
28-300mm f/3.5-5.6L IS  £1,795.00
EF-S 55-250mm f/4-5.6 IS STM  £199.00
70-200mm f/2.8L IS II USM £1,499.00
70-200mm f/2.8L USM £945.00 
70-200mm f/4.0L IS USM £795.00
70-200mm f/4.0L USM  £439.00
70-300mm f/4.0-5.6 IS £356.00
70-300mm f/4.0-5.6L IS USM £894.00
70-300mm DO IS USM £999.00
75-300mm f/4.0-5.6 III  £188.00 
75-300mm f/4.0-5.6 USM III £219.00
100-400mm L IS USM II £1,799.00
200-400mm f/4.0L USM £8,598.00
1.4x III Extender  £314.00
2x III Extender £302.00
EF 12II Extension Tube £79.99
EF 25II Extension Tube  £139.99

CANON LENSES

Canon cameras! See in store or www.parkcameras.com/canon-lens-rewards.

For up to £150 cashback on selected Canon lenses this Summer, 
visit www.parkcameras.com/canon-summer-cashback.  

£1,529.00
£385.00

£1,099.00

£959.00

£379.00
£149.00
£995.00
£245.00

£329.00
£753.00

FUJIFILM
XP90 £174.00
X70 £539.00
XQ2 £249.00
X-A2 + 16-50 £329.00
X-E2s £549.00
X-T10 £449.00
X-T1  from £805.00
X-PRO2 £1,349.00

OLYMPUS
TG-4 £264.00
TG-TRACKER £279.99
E-PL7  from £319.00
E-M1  from £849.00
PEN-F  from £999.00
RICOH
WG-30w £169.00
GR II £499.00

PANASONIC
G7  from £448.97
GX8  from £649.00
GH4R  from £999.00
PENTAX
K-50  from £399.00
K-S2  from £469.00
K-70  from £559.00
K-3 II  from £709.00

SONY
FDR-X1000 £359.00
RX10 £559.00
RX10 II £1,036.00
RX100 IV £759.00
a7 Body £799.00
a7 II Body £1,179.00
a7R £1,199.00
a7S £1,499.00

EVEN MORE CAMERAS!

Exclusive offers, 
competitions & more at

Experts in photography          Unbeatable stock availability          Competitive low pricing          UK stock

4K

Try this camera 
out in store!

from £2,178.00

Canon EOS 80D

24.2
MEGA

P I X E L S 7 FPS

Body only

£999.00

+ 18-55 IS STM

£1,089.00

Add a Canon BG-E14 battery grip
for only £149.00!

£50
cashback

Tamron SP 15-30mm
f/2.8 Di Vf/2.8 Di VC USD

In stock at £724.00*

*Prices include £75 cashback from 
Tamron. Ends 31.07.16.

£75
cashback

Tamron SP 35mm
f/1.8 Di VC USD

In stock at £424.00*

*Price includes £75 cashback from 
Tamron. Ends 31.07.16.

£75
cashback

Tamron SP 45mm
f/1.8 Di VC USDf/1.8 Di VC USD

In stock at £424.00*

*Price includes £75 cashback from 
Tamron. Ends 31.07.16.

£75
cashback
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Software guide
Photoshop CS

Photoshop CS is the 

ultimate pro image 

editing software for 

photographers, and 

has more tools and  

features than you’ll 

know what to do with. 

Photoshop Elements

With streamlined 

functionality, Elements 

is Photoshop’s little 

brother but still a 

powerful editing tool 

capable of meeting 

photographers’ needs. 

Photoshop Lightroom

Lightroom provides a 

creative editing solution 

for those who need 

RAW files converting 

and enhancing. It has 

loads of brilliant, useful 

editing functions.

Plus Free Actions 
Sharpen your images the easy way, by 

using our exclusive sharpening presets. 

There are 16 to choose from! See p106

Discover three quick 

and easy ways to 

remove distracting 

elements from your 

natural world images.

Give your wildlife 

shots a professional 

studio-like finish using 

Adjustment Layers 

and Dodge and Burn.

Recompose and 

sharpen your images 

to get frame-filling 

results without a 

massive telephoto.

Fix imperfections p100

Add a dramatic effect p102

Increase impact p104

Before

Before

Before

After

After

After

Editing
Suite

WILDLIFE  

TECHNIQUE  
SPECIAL
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l how you should retouch wildlife pics really depends 
on your intentions for the image and whether any ‘imperfections’ 
are part of the story. In some cases you might want to retain the 
original look even if the animal is flecked with mud, or grass or 
blood. But in most you’ll want to clean up the look and remove 
any distracting elements. Then there’s the ubiquitous problem 
of DSLR sensor dirt or litter in the scene. Both of those have to 
go. Whatever you need to correct, there’s a way of doing it in 
software and here we’ve outlined three essential clean up tools. 

The Spot Healing Brush is a great option for quick and 
simple retouching, functioning in an automatic way, so it’s 
great for sensor dust, stray hairs or dirt. In some more complex 
areas it can struggle, so in those cases try the Clone Stamp 
Tool, which reproduces parts of the image, making it handy 
for dealing with sharp lines or complex textures. Finally, 
there’s the Spot Removal Tool in Lightroom, which works like 
a mix of the two, and like all editing in Lightroom is 
non-destructive, so highly flexible.

After
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Above The starting image has several imperfections – sensor dirt, a fly 
crawling on the bird’s neck and some of its lunch is hanging off its beak.

Three ways to clear up 
imperfections in pics

Identifying distractions and removing them from your 
wildlife pictures is a sure-fire way of improving them,  
and it’s easy to do, as Kingsley Singleton explains.

Basic Skills

How to use Spot Healing

How to use the Clone Tool 

How to use Spot Removal 

Software Elements,  

Photoshop or Lightroom 

Do it in 5 mins

 What  
 you’ll learn 
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1
Set up the tool
In Element’s Expert mode, go to Layer>New>Layer... and call it 

‘Heal’. Pick the Spot Healing Brush (J), and zoom in to find 

imperfections like bugs or sensor dust. In the Options bar, set the Size of 

the Brush to a little larger than the area to heal. If you’re working on a 

smooth area, like a defocused background, set Type to Proximity Match;  

if it’s a detailed part, use Content Aware. Finally, tick Sample All Layers.

2
Heal the imperfections
Paint over the imperfection, running the tool across and around the 

area you want to clean. After painting, the healing will take place 

(the larger the area, the longer it’ll take). Assess whether the newly created 

pixels look like a good match and if not, hit Ctrl+Z to Undo and try again. If 

the match looks okay but you’ve painted too widely, grab the Eraser Tool 

(E) and run it over that area of the Layer. Finally, go to Layer>Flatten Image.

2
Sample and clone
Now hold the Alt key to bring up the sampling target (a little 

cross-hair). Click on a similar part of the subject near to where you 

want to repair and release the Alt key. Now you’ll get an overlay showing 

the point you sampled. Move the tool over the area to repair, checking that 

it aligns and then paint in the new pixels. Delete any parts of the ‘Clone’ 

Layer you don’t want, and go to Layer>Flatten Image to finish.

2
Apply the Spot Removal Tool
You can use Spot Removal with Visualise Spots on or off, so pick 

whichever feels more comfortable (the slider increases or decreases 

the effect). Paint over the offending area with the Spot Removal Tool and it 

will automatically pick a point to sample from. If this isn’t to your liking click 

on the source point and drag it to a new area. To tackle another area paint 

again. You can edit areas you’ve fixed by clicking on the grey pins.

1
Set up the tool
Go to Layer>New>Layer... call it ‘Clone’ and click OK. Pick the  

Clone Stamp Tool (S) and set Sample to Current & Below. Now set 

the Clone Stamp Tool’s Hardness to 0%, which will create a good join 

around the areas you’re cloning. The Mode should be set to Normal, and 

the Opacity to 100%. Set the Size to a little larger than the area you want  

to clone – here that’s about 50px.

1
Set up & find spots
In Lightroom’s Library module, click on the pic you want to repair, and 

press D to enter the Develop module. Pick the Spot Removal Tool (Q) 

and set the Size to about 25 (use the [ and ] keys to decrease or increase). 

Feather to 100 (Shift+[ or ]) and Opacity to 100. To start off, set the Brush to 

Heal, especially if you’re only working on blobs of dust. Now, to see the 

blobs more clearly, click Visualise Spots at the bottom.

Editing Suite

Method 1 Spot Healing Brush

Method 2 Clone Stamp Tool

Method 3 Spot Removal Tool
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Above To make a striking wildlife portrait like this, it’s best to start off with a photo where the 
subject is fairly large in the frame and looking towards your position, or better yet, directly 

Intermediate Skills

After

Before

l in many ways, wildlife photography is 
about capturing the moment, and it takes a 
fair degree of skill and/or effort to do that. 
Getting a well-exposed, sharp shot where the 
animal is a decent size in the frame means the 
image is already a success. But that doesn’t 
mean you need to stick with the original look 
and framing, which is great for those of us 
who like to experiment. 

This is where processing effects come in, 
and as you’ll see in this particular tutorial, it’s 
easy to take a fairly run-of-the-mill wildlife shot 
and turn it into something a lot more dramatic. 
This style relies on cropping closely and lighting 
just the facial features, almost as you would in 
a studio portrait, so it’s not something that 
would be easy to achieve on location with 
erratic subjects and changing light.

The steps here use Photoshop Elements, 
but you can use the same methods to get the 
look in Lightroom, Photoshop, or any software 
that allows selective changes to the lighting 
and contrast. And it doesn’t need to be in black 
& white – it just stands out well that way! 

We start by cropping closely, so that none 
of the background is visible, and that means 
it’s also a good one to try if there’s more 
sharpness in the background than you’d like, 
or some distracting elements. And while our 
subject is staring right down the barrel of the 
lens, you can still try it on shots where they’re 
a little more off-centre.

Create wildlife portraits 
with a professional finish

If you want a collection of striking animal shots, this is 
the technique for you. Kingsley Singleton shows how  
to process wildlife images for an impressive studio look.

How to crop for impact

How to alter the lighting  

with Adjustment Layers 

How to add contrast

Software Elements 

Do it in 10 mins

 What  
 you’ll learn 
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“This style relies  
on cropping closely 
and lighting just the 

facial features”
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1
Crop closely for extra impact
Open your picture in Elements and, at the top of the screen, click  

on the Expert mode. Now grab the Crop Tool (C), and in the options 

bar, select No Restriction. Click and drag a crop box out over the 

subject’s face. Use the corner handles to resize the box and, with Grid 

Overlay set to Rule of Thirds, crop closely and try to line the eyes up with 

the lines. When you’re done, click the Tick or hit the Return key.

2
Go monochrome
Go to Enhance>Convert to Black & White. Under ‘Select a style’ 

you can try some presets, and often find a good mix. If you want 

more control, use the Adjust Intensity sliders. These work cumulatively, 

so make sure you don’t push them too far and make the picture too light 

or too dark. It’s the same for the Contrast slider – too high and you’ll lose 

detail, too low and the pic will look flat. Click OK to apply.

4
Work on the textures
In the Layers palette, click back on the Background Layer and 

press Ctrl+J to duplicate it. Now go to Enhance>Adjust Lighting> 

Shadows/Highlights... Then under Lighten Shadows, set the slider to 

about 20%, and under Darken Highlights to about 10% – any more can 

start to look too flat. Increase the Midtone contrast a little (+10% here) 

and hit OK to make the adjustment. 

6
Sharpen the eyes alone   
Pick the Lasso Tool (L) from the toolbox, and draw around the 

eyes. Click Refine Edge in the options bar, input some Feather to 

soften the join and click OK. Now go to Enhance>Adjust Sharpness... Set 

the Remove option to Lens Blur, then set a low Radius between 0.5px 

and 2px. Finally, set the Amount using the preview as a guide and making 

sure it doesn’t look to fringey. Click OK and go to Select>Deselect.

3
Add some dramatic lighting
In the Layers palette (Window>Layers), click the Create new fill or 

adjustment layer icon. Choose Levels and push the Black and 

Midtone sliders right to darken the pic. Move the White slider left to 

darken further. Pick the Brush Tool (B), set it to 30% Opacity and, with a 

soft-edged brush, paint black (press X if this isn’t your foreground colour) 

onto the middle of the face to restrict the effect there. Repeat if necessary.

5
Dodge and burn to increase contrast
Go to Layer>Flatten Image and then pick the Burn Tool (O) from 

the toolbox. Set its Range to Shadows, and its Exposure to a low 

level like 3%, then run it over any parts where you want to deepen the 

shadows (here, the neck, nose and mouth). Switch to the Dodge Tool 

(Highlights, 3%) and run it over the eyes and any other highlight areas to 

brighten them and increase the contrast.

Editing Suite
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l for striking results, wildlife shots often feature 
the subject large in the frame, and that usually means shooting 
with telephoto lenses. A 70-300mm can often be enough, but 
if the subject is small you can still struggle to reproduce it large 
enough. Does that mean that you should give up? No, you just 
need to enlarge and sharpen the pic in the right way.

The trick is to enlarge the subject just enough to make it 
dominant, but not so much that you lose quality through the 
interpolation process (rather than cropping, here we’ll keep 
the dimensions of the image the same). Some softening during 
interpolation is unavoidable, but adding sharpness using a 
selection compensates and returns the detail where it’s needed, 
ignoring out of focus parts (and avoiding making digital noise 
any more pronounced). This technique works best on shots 
with a clean, defocused background, but you can make your 
selection with the Polygonal Lasso Tool too. And if you have 
Photoshop CC 2014 or higher, try Select>Focus Area instead of 
the Magic Wand Tool, as this is an excellent new feature.

After
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Above The shot has a nicely defocused background, but the puffin is too 
small in the frame. We can enlarge him to make it more striking.

Increase impact and 
detail in wildlife shots

It’s not always possible to get a frame-filling subject, 
but by recomposing and sharpening Kingsley Singleton 
shows how you can improve results in Photoshop.

Advanced Skills

How to enlarge the subject 

and recompose pictures 

How to add sharpness 

How to apply masks 

Software Photoshop 

Do it in 15 mins

 What  
 you’ll learn 
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1
Enlarge the picture 
Go to Select>All (Ctrl+A), then Edit>Free Transform (Ctrl+T). In the 

Options bar set Interpolation to Bicubic Smoother, which is best for 

enlargements. Click the chain-link (Maintain Aspect Ratio) icon and drag the 

corner handles outwards to enlarge. Try not to go too far beyond 160%. To 

recompose, click and drag within the enlargement. Hit Return to make the 

enlargement, then go to Select>Deselect (Ctrl+D).

2
Make a selection 
For an easy selection of the subject here, pick the Magic Wand  

Tool (W), and set its Tolerance to a low number like 10, 15 or 20.  

Tick the Contiguous options and click on the blurred area behind the 

subject to start the selection. Hold Shift and repeat until everything you 

want is selected. Next go to Select>Inverse (Ctrl+Shift+I) so that the 

non-blurred parts are now selected.

4
Add the sharpening  
Click the Background Layer’s visibility icon back on and, with the 

Background Copy Layer active, press Ctrl+Shift+U to desaturate it. 

Notice that only the unmasked areas are turned to black & white. Now go to 

Filter>Other>High Pass and set the Radius so the edges are clear without 

looking ‘fringey’ – low settings like 1px or 2px are best. Click OK. Finally, in 

the Layers palette click Normal and set the blending mode to Overlay.

6
Duplicate to increase the sharpness
You can duplicate the Background Copy Layer to increase the 

effect – just press Ctrl+J, or go to Layer>Duplicate Layer and hit 

OK. The new Layer copies the mask so you can make further changes to 

that. Try further restricting the sharpening effect by lowering the Brush’s 

Opacity to 20% and painting black so the sharpening is just on the 

subject’s eyes and head. Finally, go to Layer>Flatten Image.

3
Improve the selection 
Click Refine Edge in the Options bar and under Edge Detection tick 

the Smart Radius box, increasing the Radius slider until the edge 

looks good. Use the Shift Edge control to expand the selection slightly if 

required. You can also paint over any awkward parts with the Refine Radius 

Tool, which is especially handy when the subject has a furry or broken 

outline. Finally, under Output To, set it to New Layer with Layer Mask. 

5
Refine the sharpening with a mask  
Now, making sure the Background Copy Layer’s attached mask is 

active (click it to see a frame around it), pick the Brush Tool (B) and 

set Black as the Foreground Color (press D, then X), and, using a large, 

soft-edged brush, paint over any parts of the image where you want to 

further hold back the sharpening effect. For a better view, Alt-click the 

mask and you’ll see it full size. Alt-click again to go back. 

(Ctrl+D).

Improve the selection
Click the Background Layer’s visibility icon back on and, with the

For an easy selection of the subject here, pick the Magic Wand

Video Lesson On The Disc Editing Suite



Sharpen your images 
for even greater detail

How to install and apply 

your free Actions

How to sharpen images  

Software Photoshop 

& Elements

Do it in 5 mins

 What  
 you’ll learn 

Elements Install and apply the Actions
Insert the Learn Photography Now CD-ROM into your PC or Mac,n Photography Now

double-click the disc icon and drag the ‘PP Collection – Sharpening 

Effects’ file onto your desktop. Open Elements, select the Photo Editor 

module and click the Expert tab. Go to Window>Actions, click on the 

drop-down menu top-right in the Actions palette and select Load 

Actions. Locate the ‘PP Collection – Sharpening Effects’ file and click 

Open. Your Actions will appear in the Actions palette. Open your image, 

select the Action you want to apply and click the Play icon.

Photoshop Install and apply the Actions 
Double-click the Learn Photography Now disc icon, drag then Photography Now

‘PP Collection – Sharpening Effects’ file onto your desktop and 

double-click on it. This will automatically import the Actions into

Photoshop CS. Now open Photoshop and go to Window>Actions to 

open the Actions palette. The ‘PP Collection – Sharpening Effects’ file 

should be visible. Go to File>Open, locate your image and click Open. 

Now simply select the Action you want to apply and click the Play icon 

(grey triangle) at the bottom of the Actions palette. 

Sharpening is an 
essential technique, 
but also one of the 

trickiest. Ben Hawkins 
simplifies the process with 
a new batch of Actions... 

l unless you’ve spent megabucks on 
some seriously high-end glass, chances 
are every RAW file you process will need 
a degree of sharpening for it to looks its 
best. This can be applied in Camera RAW, 
Lightroom and Photoshop, and in typical 
Adobe fashion there are numerous tools 
and techniques that can be used to get 
results. But use the wrong tool or apply 
too much sharpening and you run the risk 
of highlight fringing, halos and more. 

To streamline the process we’ve create 
a comprehensive set of 16 sharpening 
Actions that are compatible with both 
Photoshop and Elements. With a preset 
for every occasion, whether you want to 
sharpen only highlights, midtones or 
shadows, or simply sharpen for impact, 
follow the instructions below and give 
your images the finishing touch they 
deserve. These Actions are designed to be 
used together with the Opacity slider for 
a more refined effect, so group the various 
Layers together by holding down the Shift 
key and sharpen away...

Using the Sharpen for 
Impact Action on this 

image has really pulled 
focus to the subject.  

Free Actions On The Disc Editing Suite

Before Sharpened

After
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Manfrotto Tripods & Heads

MT190XPRO3 Tripodripod £129.00

MT055XPRO3 Tripodripod £139.00

190GO Tripodripod £149.00

XPRO Ball Head £114.00

XPRO3W 3 Way Geared Heady Gear £149.00

MT190XPRO4 Tripodripod £139.00

MT190CXPRO3 Carbon Fibre Tripodripod £229.00

MT190CXPRO4 Carbon Fibre Tripod ripod £235.00

MT055CXPRO3 Carbon Fibre Tripodripod £279.00

XPRO 3 Way Heady Head £99.00

Befree 
Aluminum 

Travel Tripod 

£119.00

Befree 
Carbon Fibre 
Travel Tripod 

£248.00

Profoto B2 250
AirTTL To-Go Kit

£1,495.00

Bowens Gemini
400/400Rx Umbrella Kit

£569.00

Profoto D1 Studio
Kit 250/250 Air

£1,999.00

Bowens Gemini
500/500R Twin Head Kit

£949.00

*Befree Aluminum efree Aluminum
Travel TripodTravel Tripod

Studio Lighting

EF 50mm F1.4 USM £239.00

EF 50mm F1.8 STM £97.00

EF-S 60mm F2.8 USM Macro £305.00

EF 85mm F1.2L II USM £1,499.001,499.00

EF 100mm F2.8L IS USM Macro £619.00

EF 8-15mm F4.0L USM Fisheyey £899.00

EF 16-35mm F2.8L USM II £1,060£1,060.00

EF 17-40mm F4.0L USM £498.00

EF 24-70mm F4L IS £675.00

EF 24-70mm F2.8L II USM £1,400£1,400.00

EF 24-105mm F4.0L IS USM £727.00

EF 24-105mm F3.5-5.6 IS STM £375.00

EF 70-200mm F2.8L IS USM II £1,499£1,499.00

EF 70-200mm F4.0L IS USM £795.00

EF 70-300mm F4.0-5.6 IS USM £356.00

EF 70-300mm F4.0-5.6L IS USM £1,029£1,029.00

EF 100-400mm F4.5-5.6L IS USM II £1,799£1,799.00

Canon Lenses Fujifilm LensesNikon Lenses Sony Lenses

14-24mm F2.8G AF-S ED £1,459.001,459.00

16-35mm F4G AF-S ED VR £899.00

18-35mm F3.5-4.5G AF-S ED £549.00

18-200mm F3.5-5.6G AF-S VR II £519.00

18-300mm F3.5-5.6G AF-S ED VR £699.00

24-70mm F2.8G AF-S ED £1,299.001,299.00

28-300mm F3.5-5.6G AF-S VR £729.00

70-200mm F2.8G AF-S VR II £1,799.001,799.00

70-200mm F4G AF-S ED VR £999.00

80-400mm F4.5-5.6G ED VR £1,1,895.00

Nikon 300mm 
F4E PF ED VR

£1,470.00

Fujifilm XF 
16-55mm F2.8WR

£849.00 Sony FE 
24-240mm 

F3.5-6.3 OSS

£749.00

D750 BODY £1,389.00£1,389.00

D750 BODY
+ 24-85MM £1,716.00

D5300 BODY £373.00

D5300 BODY
+ 18-55MM £459.00

ALPHA A7 II BODY £1,179.00£1,179.00

ALPHA A7 II BODY 
+ 28-70MM £1,728.00

CYBER-SHOT 
RX100 IV £759.00

ALPHA 
A7R II BODY £2,599.00

X-100T 
BLACK/SILVER £795.00 X-T10 BLACK/

SILVER BODY £449.00

D610 BODY £1,099.00£1,099.00

D610 BODY
+ 24-85MM £1,499.00

D7200 BODY £779.00

D7200 BODY
+ 18-105MM £949.00

D7200 BODY £779.00

X-T1 GRAPHITE £919.00

X-T1 BLACK £805.00

X-PRO 2 BODY £1,349.00£1,349.00 ALPHA 
A7S II BODY £2,499.00ALPHA £2,499.00ALPHA £2,599.00

ALPHAA7IIBODY £1,179.00

24-70mm F4 ZA OSS Vario-Tessar T* FE £799.00

35mm F2.8 ZA Sonnar T* FE £513.00

55mm F1.8 ZA Sonnar T* FE £618.00

70-200mm F4 G OSS FE £999.00

90mm F2.8 Macro G OSS FE £899.00

16-35mm F4 ZA OSS Vario-Tessar T* FE £1,079.001,079.00

14mm F2.8 XF ££689.00689.00

18mm F2R XF £429.00

23mm F1.4 XF £689.00

27mm F2.8 Black or Silver XFer £329.00

35mm F1.4R XF £429.00

56mm F1.2 XF £769.00

56mm F1.2R XF APD £1,079.001,079.00

60mm F2.4R Macro XF £459.00

10-24mm F4 R XF £769.00

18-135mm F3.5-5.6 WR £619.00

50-140mm F2.8 WR OIS £1,159.001,159.00

50-230mm F4.5-6.7 OIS Black or Silver XCer £289.00

55-200mm F3.5-4.8 R LM OIS XF £529.00

EOS 6D BODY £1,119.00£1,119.00

EOS 6D BODY 
+ 24-105MM £1,499.00

EOS 80D BODY £999.00

EOS 80D BODY 
+ 18-55MM £1,089.00

EOS 7D 
MARK II BODY £1,179.00

EOS 80D BODY £999.00

EOS 5D 
MARK III BODY £2,178.00

Nikon D500Nikon D500 BodyBody

£1,729.00

Nikon D810Nikon D810 BodyBody

£2,139.00

Nikon Nikon D5 D5 BodyBody

£5,199.00

D500D810D5

Canon EOS Canon EOS 5DS R 5DS R BodyBody

£2,899.00

Canon EOS Canon EOS 5DS 5DS BodyBody

£2,699.00

Canon EOS-1D X Canon EOS-1D X MarkMark II IIMarkMark IIIIMark BodyBody

£5,199.00

EOS 5DS R EOS 5DSEOS-1D X Mark II

All prices include VAT at 20%. Prices correct at time of going to press. E&OE. *T&Cs apply. 0876-0615

PRICE PROMISE
If you find an identical product available at a lower price 
at a UK based retailer simply tell us who the competitor 
is and their price and we’ll match it*. Even if you find it 
cheaper up to 7 days after purchasing!

NATIONWIDE  
STORES
Visit us in store at any of our 
locations for expert and advice 
from our specialist team.

TRADE IN.. TRADE UP...
Looking to upgrade your equipment? Why not part  
exchange your old kit towards the latest model?  
Visit www.calphoto.co.uk or for further information  
on our trade in process.

Call: 0333 003 5000 Click: www.calphoto.co.uk Follow us on:CONTACT US

MORE THAN JUST A 

PHOTOGRAPHIC SHOP…

NEW NEW NEW

NEW

NEW

NEW



HOLIDAYS AND COURSES

STUDIO HIRE
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Join Paul’s Studio on a glamour and nude shoot in an 
exclusive location. The events are perfect for beginners 
and experienced photographers; free help and 
assistance is on hand. We offer various shooting options, 
working in small groups, including opportunities for one-
to-one. Optional tuition is also available. Our models 
are experienced professionals, with a creative and 
fun outlook.

MANOR HOUSE DAY EVENT
Spend the day in a beautiful Grade 2 listed Jacobean manor 
house, complete with splendidly furnished rooms and set 
in 25 acres of classical gardens and parkland in Berkshire. 
Natural light fl oods the rooms, and we’ll also set 
up studio lighting.

Saturday 16th April 2016, Friday 3rd June 2016

Friday 12th August 2016, Friday 7th October 2016

WALES WEEKEND
An elegant 18th century mansion house estate in 
Carmarthenshire is the setting for this event. Includes 
locations diverse as beautifully furnished interiors, walled 
gardens and parkland. Studio lighting will be available, both 
indoors and out.

Friday 13th-15th May 2016
Friday 1st-3rd July 2016

Friday 2nd-4th September 2016

GLAMOUR & NUDE 
SHOOTS/WORKSHOPS

KEEP UP TO DATE WITH ALL THE 
EVENTS AT PAUL’S STUDIO 

ON THE WEBSITE

FOR MORE INFORMATION CONTACT: 
07930 462906

WWW.PAULS-STUDIO.CO.UK 
EMAIL INFO@PAULS-STUDIO.CO.UK

● Intuitive 

iPad interface 

makes viewing 

even easier 

● Extra images 

and videos 

to inspire your 

photography

● Amazing 

retina display for 

incredible detail 

& clarity

New! Experience
the enhanced 
iPad edition now...

●

iPad interface

makes viewing

even easier

●

and videos

to inspire your

photography

● Amazing

retina display for

incredible detail

& clarity

iPad edition now...

PHOTOGRAPHY COURSE IN STUNNING ROYAL DEESIDE
Thursday 20th – Sunday 23nd October, 2016

Based at the exclusive Mill of Dess Lodge near Aboyne and mentored by
the award-winning photographer and Going Digital tutor Anna Henly.

During the three days of photography Anna will run a variety of Going Digital photography workshops. The highlight 
will be a Birds of Prey photography day where the birds can be fl own and photographed in natural settings. There will 
be plenty of time in the evenings to review your work and learn specialist techniques to put into practice the following 

day. The exact programme will be weather dependent. 

You can expect plenty of encouraging hands-on advice and to be inspired by the glorious autumn colours in Royal 
Deeside. All skill levels and cameras welcome! 

Anna is the Scottish tutor for Going Digital (www.goingdigital.co.uk) and has won many awards including two in the 
BBC Wildlife Photographer of the Year competition.

We are only offering 10 places on this unique opportunity.

The price includes 3 days’ photography, all food and the chance to enjoy one of the most luxurious Lodges in Scotland.

£650 per person 
£350 per non-photographer spouse

For more information, or to reserve 
your place, please contact

Antonia McKinley:
01763 264249 or 07572 732387
or antonia@lowerdessestate.com

www.lowerdessestate.com

www.annahenly.co.uk

Wildlife Hide 
PHotograPHy

for details visit

www.davidplummerimages.co.uk

with Sussex Wildlife trust 
photographer david Plummer

Owl, Raptor, Kingfisher Hides 
plus off-road Safaris



CONTACT US

Practical Photography, Bauer Media, Media House, 

Lynch Wood, Peterborough, PE2 6EA

practical.photography@bauermedia.co.uk

EDITORIAL

Phone 01733 468000 

Editor Ben Hawkinsr

Deputy Editor Tim Berryr

Features Writer Louise Carey

Technique Writer Georgie Rastall

Editorial Assistant Sara Mattickt

Head of Publishing Shane Collins

Senior Art Editor Chris Robinsonr

Video & Art Editor Trevor Wardr

Thanks to Kingsley Singleton & Ben Davis

ADVERTISING

Phone 01733 395013 

Group Commercial Director Charlie Brookesr

Commercial Director Iain Grundy

Group Sales Manager Trevor Newman

Key Account Director Wendy Cowell

Display/Classi Sales Exec Zaher Khan

MARKETING

Phone 01733 468329  

Brand Manager Charlotte Walsher

Product Manager Lynne Fairburnr

Direct Marketing Manager Julie Spireser

Direct Marketing Executive Frederique Campbell  

Head of Newstrade Marketing Leon Benoiton

Newstrade Marketing Manager Sam Tombliner

PRODUCTION

Phone 01733 468341

Print Production Manager Colin Robinsoner

Advertising Production Manager Zoe Bellamy r

Printed by Wyndeham Southern Printy

Distributed by Frontliney

SUBSCRIPTIONS AND BACK ISSUES

To ensure that you don’t miss an issue and 

for the best subscription offers visit 

www.greatmagazines.co.uk/pp 

For subscription or back issue queries 

please contact CDS Global on

bauer@subscription.co.uk

Phone from the UK on 0844 848 8872

Phone from overseas on +44 (0)1858 438760

BAUER CONSUMER MEDIA

Managing Director – Leisure & Technology

Kim Slaney

Editorial Director June Smith-Sheppard

Head of Digital Charlie Calton-Watson

Group Direct Marketing Director Chris Gadsbyr

Finance Director Lisa Hayden

Group Finance & Strategy Director Sarah Vickeryr

Group Managing Director Rob Munro-Hall 

CEO Paul Keenan

Practical Photography magazine is published 13 times a year by Bauer 

Consumer Media Ltd, registered address Media House, Peterborough Business 

Park, Lynch Wood, Peterborough, PE2 6EA. Registered number 01176085. 

No part of the magazine may be reproduced in any form in whole or in part, 

without the prior permission of Bauer. All material published remains the 

copyright of Bauer and we reserve the right to copy or edit any material 

submitted to the magazine without further consent. The submission of material 

(manuscripts or images etc) to Bauer Media, whether unsolicited or requested, 

is taken as permission to publish that material in the magazine, on the 

associated website, any apps or social media pages affiliated to the magazine, 

and any editions of the magazine published by our licensees elsewhere in the 

world. By submitting any material to us you are confirming that the material is 

your own original work or that you have permission from the copyright owner to 

use the material and authorise Bauer to use it as described in this paragraph. 

You also promise that you have permission from anyone featured or referred to 

in the submitted material to it being used by Bauer. 

If Bauer receives a claim from a copyright owner or a person featured in any 

material you have sent us, we will inform that person that you have granted us 

permission to use the relevant material and you will be responsible for paying 

any amounts due to the copyright owner or featured person and/or for 

reimbursing Bauer for any losses it has suffered as a result.

Please note, we accept no responsibility for unsolicited material which is lost or 

damaged in the post and we do not promise that we will be able to return any 

material to you. Finally, whilst we try to ensure accuracy of your material when 

we publish it, we cannot promise to do so. We do not accept any responsibility 

for any loss or damage, however caused, resulting from use of the material as 

described in this paragraph.

COMPLAINTS: Bauer Consumer Media Limited is a member of the Independent 

Press Standards Organisation (www.ipso.co.uk) and endeavours to respond to 

and resolve your concerns quickly. Our Editorial Complaints Policy (including full 

details of how to contact us about editorial complaints and IPSO’s contact 

details) can be found at www.bauermediacomplaints.co.uk Our email address 

for editorial complaints covered by the Editorial Complaints Policy is 

complaints@bauermedia.co.uk.

Next 
month

Lighting Why one
flashgun is all you need

Editing skills New ways
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for unique results
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“If you’re hesitant about investing in fi lters, SRB 
is a good place to start. An Excellent choice.”

- Amateur Photographer Magazine,  2014

Best Value 
in Photoplus 
Big Stopper 
Group Test

46mm

49mm

52mm

55mm

58mm

£24.95

£25.95

£26.95

£27.95

£28.95

62mm

67mm

72mm

77mm

82mm

£29.95

£31.95

£32.95

£34.95

£39.95

ND1000 Circular Polarisers

UV Filters

ND Grad Filters

More Filters...

ND Fader Filters

ND Filters

Our award
winning 10 stop 
long exposure 

fi lter

- Photoplus

4 stars for 
quality & value

- AP Mag

5 stars in DC’s 
ND Group Test 

- Digital Camera

Sizes: 25 to 86mm

Sizes: 25 to 105mm

Sizes: 40 to 82mm    Grads:0.3 0.6 0.9 1.2

visit srb-photographic.co.uk for more info

49mm

52mm

55mm

58mm

62mm

£16.95

£17.50

£17.95

£18.50

£18.95

67mm

72mm

77mm

82mm

86mm

£19.50

£19.95

£22.50

£24.95

£29.95

46mm

49mm

52mm

55mm

58mm

£12.50

£12.95

£13.50

£13.95

£14.50

62mm

67mm

72mm

77mm

82mm

£14.95

£15.95

£16.95

£18.95

£20.95

46mm

49mm

52mm

55mm

58mm

£29.95

£31.95

£32.95

£33.95

£34.95

62mm

67mm

72mm

77mm

£35.95

£36.95

£37.95

£39.95

46mm

49mm

52mm

55mm

58mm

£16.50

£16.95

£17.95

£18.95

£19.95

Infrared Filters

Skylight Filters

Black & White Filters

Colour Grad Filters

Star Effect Filters

£19.95

£9.95

£7.50

£14.95

£12.95

from

from

from

from

from

62mm

67mm

72mm

77mm

82mm

£20.95

£21.95

£22.95

£23.95

£24.95

46mm

49mm

52mm

55mm

58mm

£13.95

£14.50

£15.50

£16.50

£17.50

62mm

67mm

72mm

77mm

82mm

£19.50

£20.50

£22.50

£24.50

£29.50

Sizes: 27 to 82mm         Grads:0.3 0.6 0.9 1.2

Circular Filters
Camera Lens £ Camera Lens £

Canon EOS

Canon EOS

Canon EOS

Canon EOS

Canon EOS

Canon EOS

Canon EOS

Canon EOS

Canon EOS

Canon EOS-M

Canon EOS-M

Canon EOS-M

Canon EOS-M

Canon EOS-M

Canon EOS-M

Canon EOS-M

Fuji X

Fuji X

Fuji X

Fuji X

Fuji X

Fuji X

Fuji X

Fuji X

Nikon

Nikon

Nikon

Nikon 1

Nikon 1

Nikon 1

Nikon 1

Nikon 1

Nikon 1

Nikon 1

Nikon 1

Micro 4/3

M42

Nikon

Nikon G

Pentax K

Olympus OM

Con/Yash

Leica R

Leica M

Canon FD

Canon EOS

Leica M

Nikon

Canon FD

C Mount

M39

M42

M42

Leica M

Nikon

Canon EOS

Olympus OM

4/3

Canon FD

Con/Yash

M42

Canon FD

C Mount

M42

M39

Nikon

Canon EOS

Pentax K

Leica M

Leica R

Con/Yash

Canon EOS

£16.95

£22.95

£39.95

£24.95

£24.95

£24.95

£22.95

£24.95

£44.95

£29.95

£29.95

£29.95

£29.95

£29.95

£29.95

£29.95

£24.95

£29.95

£29.95

£29.95

£29.95

£29.95

£29.95

£29.95

£24.95

£44.95

£32.95

£24.95

£22.95

£29.95

£44.95

£29.95

£39.95

£37.95

£23.95

£29.95

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

Micro 4/3

4/3

4/3

4/3

4/3

4/3

4/3

Pentax

Pentax

Pentax

Pentax

Sony Alpha

Sony Alpha

Sony Alpha

Sony Alpha

Sony Alpha

Sony NEX

Sony NEX

Sony NEX

Sony NEX

Sony NEX

Sony NEX

Sony NEX

Sony NEX

Sony NEX

Sony NEX

Nikon

Nikon G

M42

Olympus OM

Minolta MD

Leica R

Leica M

Sony Alpha

Pentax K

Canon FD

Con/Yash

M42

Con/Yash

Leica R

Nikon

Olympus OM

Pentax K

M42

Nikon

Sony Alpha

Canon FD

M42

Minolta MD

Nikon

Pentax K

Canon FD

Canon EOS

Nikon

Sony Alpha

Olympus OM

Pentax K

Leica M

Leica R

Canon FD

M39

M42

£29.95

£34.95

£29.95

£29.95

£29.95

£29.95

£29.95

£34.95

£29.95

£29.95

£29.95

£17.95

£22.95

£22.95

£22.95

£22.95

£22.95

£18.95

£44.95

£44.95

£44.95

£15.95

£44.95

£44.95

£44.95

£44.95

£29.95

£29.95

£34.95

£29.95

£29.95

£29.95

£29.95

£42.95

£23.95

£23.95

Lens/Camera Adaptors

Square Filter KitsSquare Filter Holders
A Size Holder

P Size Holder

P Size W/A Holder

Adaptor Rings

£8.95

£4.95

£4.95

£4.95

A Size Starter Kit

A Size Filter Kit

P Size Starter Kit

P Size Filter Kit

£24.95

£39.95

£24.95

£39.95

Individual Square Filters

Sizes: A Size & P Size

0.9 Hard ND Grad

1.2 Hard ND Grad

Circular Polariser

Blue Grad

Sunset Grad

Twilight Grad

Black & White Filters

4x Star Effect

6x Star Effect

P Size Diffusion Filter

£13.50

£15.95

£26.00

£13.50

£13.50

£13.50

£13.50

£13.50

£13.50

£12.50

0.3 Full ND

0.6 Full ND

0.9 Full ND

1.2 Full ND

0.3 Soft ND Grad

0.6 Soft ND Grad

0.9 Soft ND Grad

1.2 Soft ND Grad

0.3 Hard ND Grad

0.6 Hard ND Grad

£13.50

£13.50

£13.50

£15.95

£13.50

£13.50

£13.50

£15.95

£13.50

£13.50

0.3 ND Glass Pro

0.9 ND Glass Pro

£29.95

£29.95

- Digital Photo

for build, 
image quality 

& value

- April, 2014

With our on-site engineering factory we can help! Visit  srb-photographic.co.uk for more info

Square Filters

Close up Lens SetsClose up Lens Sets

Each set includes four 

close up lenses with 

upto +17 diopter and 

a protective case

- Photo Plus

52mm

55mm

58mm

62mm

£19.95

£20.95 

£21.95 

£22.95

67mm

72mm

77mm

£23.95 

£24.95 

£25.95

Auto Extension Tubes
Set of 3 tubes

Canon EOS

Canon EOS-M

Micro 4/3

Nikon 1

£29.95

£49.95 

£49.95

£49.95

from

- Digital Photo, 2015

Nikon

Pentax Q

Sony Alpha

Sony NEX

£54.95

£49.95 

£54.95

£49.95

Manual Extension Tubes
Canon EOS

Micro 4/3

Nikon

£17.50

£17.50

£17.50

Olympus 4/3

Sony Alpha

£17.50

£17.50

Close up & Macro Three Filter Wallet

£4.95 

NEW

Caps & Hoods

Lens Caps

Body Caps

Rear Lens Caps

Petal Hoods

Rubber Lens Hoods

Metal Hoods

Body & Rear Sets

£3.95

£3.50

£3.50

£10.95

£4.95

£5.95

£5.95

from

from

Self Take Kits

DSLR Self Kit

Compact Self Kit

Angled Self Kit

£34.95

£24.95

£34.95

Deluxe Lens Pouch

from £11.95 

Microfibre Cloths

Olloclip Lenses

Lens Pouch

Deluxe Lens Pouch

Circular Filter Pouch

Square Filter Wallet

Square Filter Case

Lightning Sensors

Selfie Stick Bundle

Bluetooth Remotes

OpTech Straps

Camera Spirit Levels

£1.50

£59.95

£8.50

£11.95

£5.95

£9.95

£1.95

£64.95

£9.95

£3.95

£9.99

£3.50

from

from

from

from

from

from

Lens Pen

Cleaning Kits

Dust Blowers

Cleaning Solution

£4.95

£5.95

£3.50 

£4.95

from

from

Memory Card Cases

Reflector Kits

Rainsleeves Pack of 2

White Balance Caps

Filter Stack Caps

Angled View Finder

DC Compact Mount

Circular filter Wraps

£9.95

£8.95

£5.95

£9.95

£10.95

£39.95

£17.95

£9.95

from

fromIn-It Lens Pocket £3.95 fromIn-It Camera Wrap £8.95NEW NEW
Accessories

Travel Tripod

Tripod Lens Mount

Binocular Brackets

Window Mount

Dash Mount

Universal Tripod

Mount

£9.99

£49.95

£9.99

£24.95

£9.95

£46.00

On-It Monopod £24.95NEW
28mm On-It Carbon 

FIbre Tripod
NEW

Travel Tripod

Tripod Lens Mount

Binocular Brackets

Window Mount

Dash Mount

Universal Tripod

Mount

On-It Monopod

£119.95 

colours: Red, 

Blue, Black

25mm Onit 

Carbon 

Fibre Tripod

NEWNEW

Tripods & Mounts

- Practical Photo, Jan 2016

FIbre Tripod

£149.95 
only

AWARD WINNING SERVICE & PRODUCTS   *   GOOD SERVICE AWARD 2015  & 2016  *   GEAR OF THE YEAR 2015
Gear
of the year 

2015

Lee Filters 100mm System Lee Filters Seven5 System Lee Filters SW150 System

EXCLUSIVE 

Lee Filters 

100mm Starter 

Kit

from £139.95
Seven5 Holder

£59.50 

£17.50

£109.00

£52.00

£64.95

£65.00

£68.00

£190.00

£460.00

Adaptor Rings

Starter Kit

ND Grads

ND Filters

Big Stopper

Little Stopper

Polarisers

Deluxe Kit

SW150 Mark II Holder

£150.00 

£20.00

£59.95

£115.00

£199.00

fromAdaptors Rings

Foundation Kit

Professional Kit

ND Grad Sets

Individual Filters

Big Stopper

Little Stopper

Landscape Polariser

£75.00

£104.95

£95.99

£173.99

from

£89.95

£89.95

£89.95

£89.95

£89.95

£89.95

Nikon 14-24mm 

Canon 14mm 

Sigma 12-24mm 

Samyang 14mm

Tamron 15-30mm

Tokina 16-28mm

SW150 Mark II Adaptors

SW150 Field Pouch £47.95

*NEW* Lee Filters 15-stop Super Stopper now available online!    Seven5 system - £64.95     100mm system - £99.95     SW150 system - £129.95

Pro Square Filter Holders Pro Filter Kits

NEW Pro 

Aluminium Holders!
A Size Pro Holder

P Size Pro Holder

P Size W/A Pro Holder

£19.95

£24.95

£24.95

Types: ND Soft, ND Hard, Full ND

Starter Kit: 1 filter        Filter Kit: 3 filters

A Size Pro Starter Kit

A Size Pro Filter Kit

P Size Pro Starter Kit

£29.95

£44.95

£34.95

P Size Pro Filter Kit
- P Size Pro Holder

- 3x ND Filters

- Cloth & Wallet

- NPhoto Magazine

Best 
Value

P Size Pro Filter Kit
- P Size Pro Holder

- Cloth & Wallet

Square Filter Kits

£49.95 
only

Many more great products online! Sign up for the latest news and offers at www.srb-photographic.co.uk
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Get into

BEST  
IN  
TEST

HIGHLY 
RATED

The most in-depth  
and unbiased reviews 
of the latest products 

Tim Berry

Deputy editor Tim has  

a master’s degree in 

photography and lives 

and breathes cameras 

and lenses. He also 

worked as an industry pro.

Download 
your free 
guide now!
There are 71 more camera 

reviews and ratings on your 

cover disc – that’s every 

DSLR and CSC model 

you can buy right now! 

112

120

About our tests
Our ratings explained

Every product is rigorously tested in the field 

to bring you the most thorough reviews. Look 

for these ratings to find our concise opinion...

Our product awards

These accolades are reserved 

for exceptional products with 

unrivalled performance, build 

quality and value for money. 

We’re TIPA members 

Practical Photography is a 

founding member of TIPA,  

the largest international 

photography awards body.

tipa.com

Outstanding 

Excellent 

Solid 

Poor 

Terrible

of the latest products

Super high-res 
cameras 
We review and rank the six 

most affordable high-res 

cameras currently available.  

P114  Olympus OM-D  

E-M5 MkII

P114  Pentax 645Z

P115  Nikon D810

P116  Canon 5DS & 5DS R

P117  Sony α7R II  

P118  Pentax K-1 

Mini tests 
Action cams, travel backpacks, 

phoneography video grips and 

much more.



SUPER HIGH
RESOLUTION
CAMERAS

6
OF THE

BEST

With more pixels equalling

more image information,

and therefore greater detail

and sharpness in shots,

it’s no surprise that the

‘pixel wars’ between

manufacturers have been

waging since the advent of

digital photography.

It used to be only medium-

format cameras that could

offer truly high resolutions

– typically between 50MP

and 80MP. But now

technology has allowed

DSLRs and CSCs to enter

this lofty high-res territory,

with a number of models

offering resolutions of over

50MP. These cameras not

only produce greater detail,

but let us make larger prints

and tighter crops too.

Here we take a look at six

of the most affordable high

resolution cameras currently

available, so you can find

your perfect match.

112 PRACTICAL PHOTOGRAPHY

Sony nyα7R II 
42.4MP 

Canon 5DS 
 & 5DS R 50.6MP CHECK OUT THE CAMERAS...
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Get Into Gear
FIND

YOUR IDEAL

HI-RES

CAMERA
WITH OUR

ADVICE

 Olympus OM-D y p
 E-M5 MkII 40MP 

 Nikon D810 
36.3MP 

Pentax 645Z
51.4MP 

 Pentax K-1 
 36.4MP 



114 PRACTICAL PHOTOGRAPHY

If you’re tempted by the benefits of 

a medium-format camera, then the 

Pentax 645Z is the most 

affordable option on the market. It 

boasts a 51.4MP medium-format 

sensor, and the chip measures 

44x33mm – making it 1.7x larger 

than a full-frame sensor. 

A larger sensor means the 

individual photosites are bigger, 

which gives a better low light 

performance. There’s no OLPF 

(optical low-pass filter) on the 

chip either, which maximises the 

image sharpness of the 645Z. 

The sensor is powered by a 

PRIME III image processor, giving an 

impressive ISO range of 100-204,800. 

The top shooting speed is a pedestrian 

3fps, but that’s because the camera is 

tasked with handling enormous 

volumes of data, and that’s one of the 

sacrifices you make when choosing a 

high resolution sensor. To focus there’s 

a SAFOX II AF module with 27 points, 

25 of which are the more advanced 

cross-type. The body is weather-

resistant, and on the rear there’s a 

3.2in 1037k-dot tilting screen. The 

645Z is heavy though, at 1470g, so 

you’ll need big, strong muscles or a 

sturdy tripod. ricoh-imaging.co.uk

High Resolution Cameras

Although this CSC isn’t a ‘true’ high 

resolution camera, it does allow you 

to capture 40MP high-res files while 

keeping your financial outlay low. 

This seems surprising when you 

consider it only sports a 16MP Micro 

Four Thirds sensor at its core, but it 

uses the built-in image stabilisation 

to expand the resolution. It works by 

shifting the sensor between each 

frame in an eight-image sequence. 

It then uses on-board processing to 

‘stitch’ the files into a single high 

resolution photo. There are, however, 

a number of drawbacks, as it only 

works effectively on subjects that 

don’t move, and also requires the 

use of a tripod. 

The E-M5 MkII is also the fastest, 

lightest and smallest camera in our 

high resolution round-up. The sensor 

is paired with the TruePic VII 

processor, and this gives it a top 

shooting speed of 10fps for 16 

RAWs. The 5-axis image stabilisation 

system keeps shots steady up to 

5 stops slower than would ordinarily 

be possible, and the ISO spans 

100-25,600. On the rear there’s a 3in 

1037k-dot vari-angle touchscreen, 

and the battery is good for 750 shots.

olympus.co.uk

PROS

40MP high 

resolution mode 

5-axis image 

stabilisation 

Affordable

CONS

16MP Micro 

Four Thirds chip

Contrast-

detect AF system

SPEC

Size:  

127x94x48mm

Weight: 417g

RATING

Above The 
Olympus E-M5 
MkII is the most 
affordable camera 
in our round-up.

Above With a 
51.4MP sensor, the 
Pentax 645Z offers 
the highest 
resolution here.

6  Olympus OM-D y p
 E-M5 MkII £749 

5 Pentax 645Z
£5999 

PROS

51.4MP 

medium-format  

Impressive ISO 

Weather & dust- 

resistant design

CONS

Slow top 

shooting speed

Expensive 

price-tag 

RATING

SPEC

Size: 

117x156x123mm

Weight: 1470g



PRACTICALPHOTOGRAPHY.COM  115

Get Into Gear

The Nikon D810 builds on the success of its 

forebear – the D800 – which was one of the first 

DSLRs to enter the megapixel territory of 

medium-format cameras. The FX format sensor has 

a resolution of 36.3MP, and this time Nikon has 

ditched the low-pass filter found on the D800 to 

increase image sharpness. The resolution, however, 

is actually the lowest of any of the full-frame cameras 

in our round-up, but still big enough to produce large 

prints or apply hefty digital crops. The sensor is 

partnered by an EXPEED 4 image processor, which 

allows for a respectable top shooting speed of 5fps, 

and you can continue firing the shutter for an unlimited 

number of JPEGs. This can be increased to 6fps when 

shooting in the DX crop mode, but doing so means 

images have a reduced resolution of 15.3MP. With the 

additional battery grip (£299), the increase in power lets 

you shoot at a speedy 7fps. 

ISO & autofocus

The D810 also offers the ability to shoot smaller-sized 

12-bit RAW files. One criticism of high resolution 

cameras is that image files are so large, they take up a 

lot of storage space and processing time. Also, such 

large files just aren’t necessary for many scenarios. 

With the D810 you can select RAW size S in the Image 

Size menu options and shoot smaller 9MP files. 

The D810 has a native ISO range of 64-12,800, 

which can be expanded to ISO 32-51,200. One of the 

advantages of having fewer pixels is a better low light 

performance, as each individual photosite is bigger, 

thus increasing the light-gathering potential of the 

sensor. And the D810 does do a good job of 

restricting noise when shooting at high sensitivities. 

The D810 uses the same 51-point Multi-CAM 

3500FX AF system found in the D4S. This was Nikon’s 

flagship DSLR in 2014, and is testament to the speed 

of the focusing system in the D810. It offers Group 

Area AF for easier focusing on smaller subjects 

framed against distracting backgrounds. The AF 

system also includes single-point, 9, 21 or 51-point 

dynamic-area, 3D-tracking and auto-area. 

Additional features

On the rear there’s a 3.2in 1229k-dot LCD, which can 

be used when capturing Full HD (1080p) movies at 

60fps. The body is sealed, making it both dust- and 

weather-resistant, and inside the deep finger grip 

there’s space for both CompactFlash and SD memory 

cards. The battery offers the best performance of any 

in our countdown, rated to last for 1200 shots from a 

full charge. In our own shooting experience with this 

camera, the battery keeps going for over 2000 frames.  

Priced at £2139, the D810 is one of the more 

affordable high-res cameras in this round-up, and if 

you’re already a Nikon user it’s definitely worthy of your 

consideration. nikon.co.uk

PROS

36.3MP 

full-frame sensor

Fast AF 

performance 

Good battery

CONS 

Lower 

resolution than 

competitors

Fairly low 

native ISO

RATING

SPEC

Size: 

146x123x81.5mm

Weight: 880g

4  Nikon D810 

£2139 

Above At 
36.3MP, the 
D810 is the 
highest 
resolution 
camera in the 
Nikon range.

Left The D810 
has no optical 
low-pass filter 
for sharper-
looking 
results.
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High Resolution Cameras

The Canon 5DS and 5DS R are the highest resolution 

DSLRs in the world, and both offer exactly the same 

specifications, except the latter doesn’t have an 

optical low-pass filter (OLPF) on the sensor. OLPFs 

are used to combat moiré, a banding effect that can 

sometimes occur when photographing repeating 

patterns, like those found in the weave of fabrics. 

The filters work by slightly blurring the image, and 

although it’s barely detectable, some photographers 

would prefer not to have an OLPF on their sensor to 

maximise sharpness, and instead run the risk of 

encountering moiré. Canon has aimed to please both 

sets of photographers with this dual release.

The sensor itself is a full-frame CMOS and offers a 

mighty resolution of 50.6MP, which ventures deep into 

medium-format territory and allows for mammoth 

prints of A0 size and beyond. If you don’t want to 

always shoot with such a high resolution – and 

accompanying large file size – you can select the 

1.3x and 1.6x cropped shooting modes. These offer 

images measuring 30.5MP and 19.6MP respectively, 

so are still ample in their own right. 

ISO & autofocus
To power the chip there’s a Dual DIGIC 6 processor, 

and this gives the 5DS/5DS R a top shooting speed of 

a decent 5fps. The camera can keep pace with the 

action for 510 JPEGs or for 14 RAWs. The ISO range 

is capped to a fairly low ISO of 100-6400, and even 

when expanded to its top H1 setting the sensitivity is 

only equivalent to ISO 12,800. This is understandable 

considering the number of photosites featured on the 

sensor, and as they are forced to be smaller they’re 

not as effective at absorbing light. A restricted ISO 

performance is one of the accepted sacrifices of 

having a higher resolution sensor in your camera.

The Canon 5DS/5DS R has a 61-point AF system, 

and 41 are the more advanced cross-type sensors for 

increased pace and precision. Focusing correctly is 

especially important when shooting with a really high 

resolution, as any mistakes are shown up in greater 

detail, but the 5DS performs well in all manner of light 

conditions. 

Additional features
Like the Nikon D810, the Canon also shoots Full HD 

movies (1080p at 30fps) and has a dual CompactFlash/

SD memory card slot to store more images. The body 

is fully weather-sealed giving you peace of mind in all 

manner of environments and conditions, and the 

battery is good for up to 700 shots. On the rear of the 

camera there’s a 3.2in 1040k-dot LCD, but unlike 

some contemporary DSLRs it doesn’t boast any touch 

or tilt functionality. 

The 5DS currently costs £2699, and the 5DS R is 

priced at £2899. Considering this camera offers a 

super high resolution of 50.6MP, it’s a good price 

when a medium-format camera with a similar 

resolution will cost you more than double that.

canon.co.uk

PROS

50.6MP 

full-frame sensor

Advanced 61 

point AF system 

Dual card slot

CONS

Limited ISO 

performance

Most 

expensive 

full-frame

RATING

SPEC

Size: 

152x116x76mm

Weight: 845g

3 Canon 5DS 
 & 5DS R £2699 

Above The 
5DS and 5DS 
R are the 
world’s 
highest 
resolution 
DSLRs.

Left The 
camera has  
a dual CF/SD 
memory card 
slot.
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Get Into Gear

If you want a big resolution, but are put off by a 

heavy and bulky DSLR, then you should certainly 

consider the Sony α7R II. It’s a CSC so is slim by 

nature, with a profile measuring 127x96x60mm and 

weighs just 582g.

Despite its diminutive casing, it features a 42.4MP 

full-frame sensor – the highest of any CSC on the 

market – and is only beaten for resolution in our 

round-up by the ground-breaking Canon and 

medium-format Pentax. Like most of the other 

cameras featured in this test, there’s no optical 

low-pass filter present on the sensor, so images are as 

sharp as can be. The sensor comes with a 5-axis 

image stabilisation system, which detects movement 

during the exposure and shifts the sensor to 

compensate. This can allow you to shoot up to 4.5 

stops slower than would ordinarily be possible without 

encountering the blur of camera shake.

ISO & autofocus
The imaging chip is supported by the BIONZ X image 

processor, and this gives the α7R II a native ISO range 

of 100-25,600, which can be expanded to ISO 

50-102,400. The processor also provides the speed, 

and like both the Nikon and Canon contenders the top 

shooting rate is capped to a respectable 5fps.

The Sony α7R II uses a Hybrid AF system to set the 

focus, and it features an enormous 399 AF points 

which cover 45% of the frame area. This makes it easy 

to lock onto and track moving subjects, even when set 

to record movies.

While all the high resolution cameras in our 

collection offer Full HD video recording, the α7R II is 

the only one here to offer 4K movie capture, which at 

8MP is 4x the resolution of Full HD. 

As this camera is a CSC there’s no optical viewfinder 

present. There is, however, a 0.5in EVF (electronic 

viewfinder) that features the highest magnification of 

any EVF at 0.78x and a resolution of 2359k-dot, 

helping the images to appear large and bright. On the 

rear there’s also a 2.95in 1228k-dot LCD, if you prefer 

to frame using Live View. The α7R MkII also comes 

with NFC and Wi-Fi, so you can use your smartphone 

or tablet as a viewfinder and remote shutter release, 

and one-touch sharing lets you transfer your photos 

and videos from your camera to your smart device, so 

you can quickly display your images online.

Additional features
As the α7R II uses either the EVF or Live View to frame 

up it’s fairly power hungry, so you may need a spare 

battery, as it’s only set to last for 290 shots from a 

single charge.

Despite being reasonably petite, the α7R II is 

extremely solid, and has a rugged feel thanks to the 

magnesium alloy design. It offers some unique 

features and is competitively priced at £2599. While 

there are comparatively few lenses available for Sony 

full-frame CSCs, it is possible to use Canon or Nikon 

lenses with the aid of a converter. sony.co.uk

PROS

42.4MP 

full-frame sensor

5-axis image 

stabilisation

4K video

CONS

Poor battery 

performance

No tilt or 

touchscreen

RATING

SPEC

Size: 

127x96x60mm

Weight: 582g

2 Sony nyα7R II 
£2599 

Above The 
smaller, 
lighter body 
of the α7R II 
makes it more 
portable, and 
therefore 
better for 
travel.

Left The Sony 
α7R II offers 
the biggest 
resolution of 
all the CSCs.

HIGHLY 
RATED
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Four last-gen bargains.Four last-gen bargains...

 Samsung NX1 £1100 

The NX1 is a top-spec CSC with a 28MP 

APS-C sensor. It’s fast, with a top burst 

rate of 15fps, and it can continue for 70 

JPEGs or 21 RAW files. The processor 

also allows for 4K video and an ISO range 

of 100-25,600. The AF system boasts 205 

phase-detection points (153 cross-type). 

samsung.co.uk

 D800 £1000 

The Nikon D800 is now discontinued, but 

you can pick up some great secondhand 

bargains, typically for around £1000. It 

features a 36.3MP full-frame sensor, has 

a top ISO sensitivity of 6400 and shoots 

up to 5fps. If your budget doesn’t stretch 

to the D810, this is a superb option.  

nikon.co.uk  Sony α7R £899 

If you prefer the portability of a CSC, the 

Sony α7R offers a 36.4MP full-frame 

sensor, housed in a robust magnesium 

alloy body and weighs just 474g. It 

shoots at 4fps, and matches the ISO of 

the α7R II with a sensitivity range of 

100-25,600, but has an inferior AF system. 

sony.co.uk

High Resolution Cameras

The Pentax K-1 doesn’t have the 

highest resolution of all the cameras 

in our round-up, but is an excellent 

all-rounder and very competitively 

priced for a full-frame camera. The 

sensor offers a 36.4MP resolution, 

which is easily big enough to create 

A2-sized prints, as well as enjoying the 

other benefits of cameras with high 

pixel counts. And, like most of the 

other contenders here, the K-1 is free 

from an optical low-pass filter to 

maintain maximum image clarity and 

sharpness. If you want to capture 

smaller resolution files to save space 

on your memory cards, you can set the 

K-1 to shoot in the 15MP APS-C Crop 

Mode. Built into the sensor is Pentax’s 

5-axis Shake Reduction II mechanism, 

so you can shoot up to 5 stops slower 

without encountering camera shake. 

ISO & autofocus
Partnering the sensor is a PRIME IV 

processor, and this lets the K-1 shoot 

up to 4.4fps for 70 JPEGs or 17 RAW 

files. This burst rate is only fractionally 

behind the pace of the Canon, Nikon 

and Sony offerings. The processor 

also allows for an ISO range of 

100-204,800, which matches the 

one medium-format camera in our 

round-up, the Pentax 645Z. To set the 

focus, the K-1 

employs the SAFOX 

12 AF system, 

which uses 33 

points, 25 of them 

being the superior 

cross-type AF 

sensors. The K-1 also 

lets you shoot movies, and you can 

record Full HD (1080p at 60fps), but 

there’s no 4K video capability. There is 

Wi-Fi though, so you can connect with 

your smartphone or tablet for remote 

operation or easy transfer of images. 

The built-in GPS isn’t just for location 

data, but works with the sensor’s 

stabilisation unit to follow the 

movements of the stars in the sky, 

allowing for longer and more detailed 

exposures of the heavens.

Additional features
The body is comfortable in the hand, 

rugged and weatherproof, making it 

ideal for all types of environment. On 

the rear there’s a 3.2in 1037k-dot LCD 

which tilts away from the body, to help 

with more challenging compositions. 

All this is available for just £1599, 

making it a very tempting option for 

anyone that’s not already invested in 

a rival system.

ricoh-imaging.co.uk

PROS

36.4MP 

full-frame sensor

Impressive 

native ISO range

Attractive price 

CONS

Slower frame 

rate than rivals

No 4K video 

functionality

SPEC

Size: 

110x136x85mm

Weight: 925g

1 Pentax K-1
£1599 

1037K-DOT 
TILT LCD

The 3.2in screen 
tilts diagonally, 
horizontally or 
vertically with a 

single action

RATING
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n High resolution images mean huge file sizes – a 

single RAW file can be over 50MB, so you’ll need a 

memory card that can handle the data. The Lexar 64GB 

1000x Professional UHS-II SDXC card writes files at a speedy 

150MB/s, will store over 1200 RAW files and costs £45. 

n The LaCie P9230 Desktop Drive offers 4TB of storage and 

costs £119, enough to store over 80,000 large RAW files. It’s 

compatible with USB 3.0 for speedy data 

transfers, and has an aluminium shell.

n To process your pics, you’ll need a 

computer that is designed to handle big 

files. The 13in MacBook Pro has a 2.9GHz 

processor, 8GB of memory and 512GB of 

flash storage and costs £1399. You can 

subscribe to Adobe’s Photography Plan 

for £8.57 a month and gain access to the 

latest versions of Lightroom and 

Photoshop. 

 Nokia Lumia 1020 £170 

While it may be a fairly obscure smartphone, 

the Nokia Lumia 1020’s camera boasts a 

41MP 2/3in sensor, image stabilisation and 

RAW capture. However, as it’s an ageing 

smartphone, the processing power is only 

sufficient to capture one high resolution 

image every four seconds. 

nokia.co.uk

Get Into Gear

5-AXIS 
IMAGE 

STABILISATION 
The K-1 lets you 

shoot up to 5 stops 
slower without the 

blur of camera 
shake

BUILT-
IN WI-FI 

It’s easy to 
connect the Pentax 
K-1 to your smart 

device, so you can 
instantly share 

your shots

“The body is 
comfortable, 
rugged and 
fully weather- 
sealed”

36.4MP 
SENSOR 

The full-frame 
sensor offers a high 

resolution and 
excellent image 
quality in low 

light

BEST IN 
TEST

Don’t forget your
digital storage
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Small photo accessories that will make a huge difference
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I
f you’re in the market for a camera to 
capture your adventures, you’re no longer 
restricted to GoPros. Over the past couple 
of years, there has been a huge influx of 
new action cams on the market from a 

range of manufacturers. The Olfi 4K HDR 
Action Camera, with its Sony Exmor back-
illuminated sensor, sets itself apart from the 
competition with its impressive range of 
features and surprisingly affordable price.  

The camera gives you a huge 
amount of control over the quality 
of your video, offering 4K at 
24fps, which is the standard 
frame rate for films, Full HD 
1080p at 60fps, and HD 720p at 
120fps. These higher frame rates allow you to 
slow your video down by 2x or 4x and yet still 
produce smooth footage, making it perfect for 
capturing exciting slow motion shots.

The sensors on the more compact cameras 
often tend to be smaller, which can lead to a 
limited dynamic range, but the Olfi boasts an 
impressive HDR setting for retaining more 
detail in the brightest and darkest parts of your 
videos. This means that you can shoot in tricky 
lighting conditions, such as at dusk and dawn, 
without compromising quality. The image 
quality itself may not be outstanding, but we 
found our results to be perfectly useable. 

The Olfi doesn’t have a built-in screen to 
display the videos and stills you’ve shot, but 
you can review them on your smartphone 
once it’s connected via the iOS/Android app. 
The app also allows you to control the camera 
remotely, so you can compose shots and 
change settings with ease. 

This action cam offers a range of useful 

features, including a time-lapse function, gyro 
stabilisation, time stamp functionality and ISO 
adjustment. There’s also the opportunity to 
adjust the colour modes, sharpness and 
fisheye effect removal. The camera comes 
supplied with a plastic housing which keeps 
the Olfi waterproof for up to 30m, making this 
device perfect for diving, snorkelling or other 
water sports. The housing’s rugged build 
protects the camera from potential damage, 
but annoyingly when fitted it covers up the 
camera’s recording light, which is a slight 
oversight on the design front. 

The controls are quite intuitive but the 
menus can be fiddly to navigate at first. The 
overall ergonomics, button layout and menu 
design is near identical to a GoPro, so anyone 
who has owned one of these in the past will be 
able to hit the ground running. 

The Olfi 4K HDR is compatible with a 
range of mounts to enable it to be attached to 
a variety of surfaces, and the compact nature 
of the camera means that you can easily slide 
it into a pocket or bag without a second 
thought. Battery life is up to 2 hours in 1080p 
at 60fps, or 1 hour 20 minutes in 4K at 24fps.

Verdict
The ultra-high resolution of 4K may not be 
essential for everyone at the moment, but 
having tomorrow’s technology today could 
represent a good investment. The lack of 
screen will frustrate some users, but there’s no 
denying this feature-packed model is top value 
at this price, and would make a great buy for 
those taking their first steps in the action 
camera market. olfi.co.uk

   Adventureproof shooting on a budget  

 OLFI 4K HDR 
 Action Cam £120

Above The included waterproof casing 
keeps the Olfi 4K HDR dry to 30m.

Above The Olfi has a very similar look and 
feel to a GoPro, but with a cheaper price-tag. 

Above The Olfi is 
perfect for extreme 
sports and fast-action 
motorsport shooting. 

tests
Small photo accessories that will make a huge difference

The camera gives you a huge
amountofcontroloverthequality
of your video, offering 4K at
24fps, which is the standard
frame rate for films, Full HD
1080p at 60fps, and HD 720p at

Above The Olfi has a very similar look and



l bridging the gap between two worlds, 
the Sigma MC-11 mount converter allows 
compatibility between Sony mirrorless 
cameras and Canon EOS mount and Sigma 
lenses. This vastly increases the number 
of lenses that can be used with cameras 
such as Sony’s α7R II, which have a 
limited native lens range. The mount 
enables full compatibility with Canon and 
Sigma lenses, including autofocus and 
TTL metering. The MC-11 also boasts an 
LED display to indicate if the mount will 
work in conjunction with the lens, and is 
updatable with  Sigma’s USB docking station. In 
testing, we found the autofocus speed to be very 
similar, if not the same, as when the lens was used natively. 
sigmaphoto.com

Get Into Gear

The Nissin i60 may be 

ultra-compact and 

extremely light, but it 

certainly doesn’t lack 

power, boasting a guide 

number of 60 (at ISO 

100, 200mm zoom 

head position). Its 

2.4GHz radio 

transmitter allows for 

slave TTL abilities, as 

well as offering full 

manual modes, and the 

colour LCD on the rear 

of the flashgun means 

settings can be easily 

viewed and adjusted. 

The zoom range 

covers 24-200mm, 

which can be expanded to 

16mm by using the built-in 

diffusion panel. Recycle times are 

impressive, varying from 0.1sec to 

5.5sec. Bouncing flash is also no problem, as this 

flashgun boasts the ability to rotate right or left by 

180 degrees and upwards by 90 degrees. 

Alternatively the built-in LED can be used to 

provide constant illumination. To reduce recycle 

times, an external power pack (£149) can be used 

instead of batteries. With the i60A, Nissin has 

incorporated complete control into a competitively 

priced and compact unit without compromising on 

power, reliability or quality. nissindigital.com

  Converter for Canon EOS & Sigma lenses  

 Sigma MC-11 mount  
 converter £219 

Above The Sigma MC-11 
mount converter boasts  
a stylish and compact 
design.

   Compact & powerful flashgun  

 Nissin i60A flashgun £239 
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  Durable memory cards 

 Sandisk Extreme 
 Plus from £19

Memory cards are such a crucial 

accessory, there’s little wonder that 

there are so many to choose from. The 

Sandisk Extreme Plus cards have a 

write speed of up to 60MB/s and a 

read speed of up to 90MB/s, meaning 

that your shots will be written almost 

instantly and you’ll save time 

uploading the files to your computer. 

The cards are durable in the harshest 

conditions, and are waterproof, 

shockproof and X-ray proof. They can 

also operate in temperatures ranging 

from -13°F to 185°F, so if extreme 

shooting is for you, then you can rely 

on your Extreme Plus card. They even 

come with the assurance of a limited 

lifetime warranty. sandisk.co.uk

Above The 
Nissin i60A 
flashgun is  
small and 
lightweight.

Below The rear 
LCD screen 
allows for 
quick settings 
adjustments.

This universal charger has a simple yet 

high quality design that will suit almost 

any user. It has the capacity to charge 

AA and AAA batteries, as well as most 

camera and video battery packs. For 

other devices, it has a USB 2.0 port 

that is compatible with digital cameras, 

smartphones and many more, which 

can be connected directly by USB. It 

charges batteries quickly, while 

protecting them from overvoltage and 

short circuit. It will also identify 

defective batteries. kenro.co.uk

  Universal battery charger 

 Kenro Universal 
 Charger £24 

HIGHLY 
RATED



l when it comes to portrait photography, 
full-frame users instinctively reach for their 
85mm lens, as this focal length tends to 
produce the most flattering results. Tamron’s 
latest release in its new-look range is a stylish 
85mm f/1.8 that boasts a sleek, clean design 
and a special coating that repels smudges, 
condensation, grime and fingerprints.

Features & performance
Compatible with full-frame and APS-C 
cameras (where it has an equivalent focal 
length of around 125mm), the standout feature 
on this lens is its Vibration Control image 
stabilisation. This helps users achieve 
shake-free shots when shooting handheld in 
low light, and in combination with the very 
fast aperture of f/1.8 makes the lens 
exceptionally capable in darker conditions. 

Sharpness is also very good, even at the 
widest apertures. At f/1.8 there’s slight 
softness in the corners of the frame, but the 
lens still performs very well compared with 
its competitors. Distortion is also negligible 
and Tamron has combated chromatic 
aberration well. Even at the widest apertures, 
the lens isn’t plagued by fringing issues, even 

in high contrast scenes. 
Autofocus is near-silent, quick and, on the 

whole, accurate. Manual focus override is 
possible at all times using the focus ring on 
the lens, which offers a smooth range of 
motion. The optical construction is 
comprised of 13 elements in nine groups, and 
a round aperture with a nine-blade diaphragm 
offers smooth and natural-looking bokeh that 
contrasts well with the sharpness of the 
in-focus subject. At wider apertures, there’s 
some vignetting but not enough for this to be 
a real issue, and it can easily be removed in 
post-processing. 

The design is extremely slick with a matte 
finish and ergonomic design, and as previously 
mentioned there is a very useful coating to 
repel most dust and dirt. The lens even comes 
with the assurance of a five-year warranty, so 
you can buy with confidence.

Verdict
Tamron has really pulled it out of the bag 
with this lens, which is likely to become a 
popular choice with professional portrait 
shooters. However, at £759 it’s considerably 
more expensive compared to its 85mm 

competitors, most of which come in around 
the £300 mark. However, the Tamron 85mm 
f/1.8 offers great image quality, excellent 
build quality and image stabilisation, making 
it a complete package. And even at wider 
apertures it performs very well. If you don’t 
already have an 85mm in your kit bag, this is 
a very wise investment. tamron.eu
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  Perfect lens for portraits  

 Tamron 85mm  
 f/1.8 £759

Above Tamron’s new-look range boasts  
a pared-back, slick and stylish design. 

SEE THIS  

LENS IN 

ACTION ON  

YOUR VIDEO 

DISC



l the new lykos daylight led 
panel boasts an impressive colour 
accuracy of >93% CRI at 5600K, 
and power output can be controlled 
manually  or  wirelessly  by 
Bluetooth or a smartphone app. It 
has an impressive brightness of 
1600lux at 1m and is dimmable 
from 0-100%. All this is offered 
in a compact, lightweight unit 
that’s easily portable and ideal 
for shoots in the studio or on 
location.  To add to the 
versatility of this unit, it’s 
mountable with a ball-head, 
hotshoe or tripod. The Lykos 
is mains or battery-powered, 
but frustratingly no battery is 
included. A bi-colour version of the 
light is also available, which has a 
variable colour temperature (3000K-
5600K). manfrotto.co.uk
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Get Into Gear

If you’re after a backpack that 

offers space and versatility, the 

Vanguard Havana 41 won’t 

disappoint. It has space for 

one DSLR, 1-2 extra lenses,  

a flash unit, tripod, water 

bottle, accessories, laptop 

and personal items, making 

it perfect for any activity 

from shooting in the city 

to hiking. The straps are 

adjustable for comfort 

and there’s a chest and 

waist strap for added 

stability. The Havana 41 

boasts a stylish design 

that has been well built 

for durability, and there 

are extra pockets on 

the exterior and 

interior for smaller 

items and extra 

padding.  

vanguardworld.co.uk

  Lightweight & compact lighting unit  

 Manfrotto Lykos 
 Daylight LED £299

  Camera bag for all scenarios  

 Vanguard Havana 
 41 backpack £80 

Photography and videography on 

mobile phones has become immensely 

popular. The Beastgrip Pro is the 

ultimate accessory for any serious 

‘phoneographer’, making the phone 

much easier to hold and allowing 

accessories to be attached, including 

tripods, cold-shoe mounts and 

microphones. Lenses can also be 

interchanged effortlessly to alter the 

field-of-view of your smartphone’s 

built-in lens. Several lens options are 

available on the Beastgrip website, all 

of which simply screw into the holder. 

You can also buy a Beastgrip Pro kit 

with one, two or three lenses included. 

We tested this grip using an iPhone 6 

and were astounded by the quality of 

images and the simplicity of use. The 

grip is ergonomic, sturdy and versatile 

and can be adapted 

to shooting any 

scene imaginable. 

beastgrip.com 

  iPhone videography grip  

 Beastgrip Pro £139Above The Manfrotto Lykos Daylight LED is 
very portable and offers impressive brightness.

Below The Havana 
41 backpack is 

perfect for a range 
of locations and 

activities.

This compact 360° 

pan head functions 

as a freestanding unit 

or on a tripod, and 

has quick flip-out 

legs for stability. It 

comes with a 

wireless 

remote and a 

variety of 

mounts so 

can be used 

with a vast 

range of 

cameras 

right up to 

small DSLR. The built-in battery is 

rechargeable from any USB port, with a 

single charge giving 5 hours of standby 

and 3 hours of runtime, and the head 

moves smoothly. With great results, the 

360° is ideal for smartphone and action 

cam photographers. polaroid.com

HIGHLY 
RATED

  Compact, stylish mount  

 Polaroid 360° £45 



Tel: 01803 852400
Email - info@mifsuds.com
www.mifsuds.com

Mifsuds Photographic Limited
27-29, Bolton Street, Brixham. Devon. TQ5 9BZ.

PHONE LINES OPEN  

MON -FRI 8am - 5pm,
SAT 9am - 4pm, 

SUN 10am - 1pm.
SHOP OPEN  

MON -FRI 9am - 5pm, 
SAT 9am - 4pm. SUN 10am - 1pm.

Tel:

U.K. Stock
Only

FREE COURIER DELIVERY FOR NEW ITEMS ORDERED ON-LINE (U.K. Mainland only)
Family Run Pro Dealership With Friendly, Knowledgeable Staff. Open 7 Days Per Week.  Prices Inc VAT - Correct 13/06/2016.  P&P Extra. E&OE.

16-300 f3.5/6.3 Di
II VC PZD £398

150-600 f5/6.3

SP VC USD £737

18-200 f3.5/6.3 Di II VC......... £16918-200 f3.5/6.3 Di II VC......... £169
Kenko ConvertersKenko Converters

1.4x Pro 300 converter......... £1491.4x Pro 300 converter......... £149
2x Pro 300 converter ............ £1492x Pro 300 converter ............ £149
Auto ext tube set ..................... .£99Auto ext tube set ..................... .£99

10-20 F3.5 EX DC HSM . . . £32910-20 F3.5 EX DC HSM . . . £329
18-35 F1.8 DC HSM Art . . £54918-35 F1.8 DC HSM Art . . £549
20 F1.4 DG HSM Art . . . . . £62920 F1.4 DG HSM Art . . . . . £629
24 F1.4 DG HSM Art . . . . . £59924 F1.4 DG HSM Art . . . . . £599
24-35 F2 DG HSM Art . . . . £69924-35 F2 DG HSM Art . . . . £699
35 F1.4 DG HSM Art . . . . . £59835 F1.4 DG HSM Art . . . . . £598
50 F1.4 EX DG HSM Art . . £56950 F1.4 EX DG HSM Art . . £569

50-100 F1.8 DC HSM Art . £82950-100 F1.8 DC HSM Art . £829

105 F2.8 EX DG OS HSM . £329105 F2.8 EX DG OS HSM . £329
150-600 F5/6.3150-600 F5/6.3
OS Contemporary . . . . . . . £739OS Contemporary . . . . . . . £739
150-600 F5/6.3 OS Sport£1199150-600 F5/6.3 OS Sport£1199

PART-EXCHANGE WELCOME
WE PART EXCHANGE, BUY FOR CASH OR COMMISSION SALE
FAIR PRICES OFFERED ~ QUOTED QUICKLY ~ COLLECTION CAN BE ARRANGED

For speediest response please email your equipment details to... info@mifsuds.com
CANON EF-S 
NON FULL FRAME  LENSES 
10-18 F4.5/5.6 IS STM . . . . . . .£178
18-55 F3.5/5.6 IS STM no box £139
18-135 F3.5/5.6 IS U Nano . . .£448
18-135 F3.5/5.6 IS STM no box £27918-135 F3.5/5.6 IS STM no box £279

24 F2.8 STM . . . . . . . . . . . . . . . .£12824 F2.8 STM . . . . . . . . . . . . . . . .£128

CANON EF 
FULL FRAME LENSES
11-24 F4 L USM . . . . . . . . . . . .£2649
16-35 F4 L IS USM . . . . . . . . . . .£679
17-40 F4 L USM . . . . . . . . . . . . .£498
20 F2.8 USM . . . . . . . . . . . . . . . .£36920 F2.8 USM . . . . . . . . . . . . . . . .£369
24 F1.4 L II USM . . . . . . . . . . . .£109824 F1.4 L II USM . . . . . . . . . . . .£1098
24 F2.8 IS USM . . . . . . . . . . . . . .£44924 F2.8 IS USM . . . . . . . . . . . . . .£449
24-70 F2.8 L II USM. . . . . . . . .£139924-70 F2.8 L II USM. . . . . . . . .£1399
24-70 F4 L IS USM . . . . . . . . . . .£67424-70 F4 L IS USM . . . . . . . . . . .£674
24-105 F3.5/5.6 IS STM . . . . . .£36924-105 F3.5/5.6 IS STM . . . . . .£369
24-105 F4 L IS USM no box . .£69924-105 F4 L IS USM no box . .£699
28 F2.8 IS USM . . . . . . . . . . . . . .£38828 F2.8 IS USM . . . . . . . . . . . . . .£388
35 F1.4 USM LII . . . . . . . . . . . .£167935 F1.4 USM LII . . . . . . . . . . . .£1679
35 F2 IS USM. . . . . . . . . . . . . . . .£37735 F2 IS USM. . . . . . . . . . . . . . . .£377
40 F2.8 STM . . . . . . . . . . . . . . . .£14840 F2.8 STM . . . . . . . . . . . . . . . .£148
50 F1.2 L USM . . . . . . . . . . . . . .£99450 F1.2 L USM . . . . . . . . . . . . . .£994
50 F1.4 USM . . . . . . . . . . . . . . . .£24950 F1.4 USM . . . . . . . . . . . . . . . .£249
50 F1.8 STM . . . . . . . . . . . . . . . . . £9650 F1.8 STM . . . . . . . . . . . . . . . . . £96
70-200 F2.8 IS LII USM. . . . . .£149870-200 F2.8 IS LII USM. . . . . .£1498

70-200 F2.8 non IS L USM. . . .£94470-200 F2.8 non IS L USM. . . .£944
70-200 F4 L IS USM. . . . . . . . . .£79670-200 F4 L IS USM. . . . . . . . . .£796
70-200 F4 L USM . . . . . . . . . . . .£43870-200 F4 L USM . . . . . . . . . . . .£438
70-300 F4/5.6 L IS USM . . . . . .£89370-300 F4/5.6 L IS USM . . . . . .£893
85 F1.2 USM L II . . . . . . . . . . . .£149885 F1.2 USM L II . . . . . . . . . . . .£1498
85 F1.8 USM . . . . . . . . . . . . . . . .£24985 F1.8 USM . . . . . . . . . . . . . . . .£249
100 F2.8 IS L USM macro . . . .£618100 F2.8 IS L USM macro . . . .£618
100 F2.8 Macro USM . . . . . . . .£372100 F2.8 Macro USM . . . . . . . .£372
100-400 F4.5/5.6 IS LII U . . . .£1749100-400 F4.5/5.6 IS LII U . . . .£1749
200-400 F4 IS L USM . . . . . . .£8399200-400 F4 IS L USM . . . . . . .£8399
200 F2.8 II L USM . . . . . . . . . . .£548200 F2.8 II L USM . . . . . . . . . . .£548
300 F2.8 IS L USM II . . . . . . . .£4499300 F2.8 IS L USM II . . . . . . . .£4499
300 F4 L IS USM. . . . . . . . . . . . .£958300 F4 L IS USM. . . . . . . . . . . . .£958
400 F2.8 IS L USM II . . . . . . . .£7499400 F2.8 IS L USM II . . . . . . . .£7499
400 F4 DO II IS USM . . . . . . . £6799400 F4 DO II IS USM . . . . . . . £6799
400 F5.6 L USM . . . . . . . . . . . . .£884400 F5.6 L USM . . . . . . . . . . . . .£884
500 F4 IS L U II . . . . . . . . . . . . £6699500 F4 IS L U II . . . . . . . . . . . . £6699

600 F4 IS L USM II . . . . . . . . . . £POA600 F4 IS L USM II . . . . . . . . . . £POA
1.4x III converter . . . . . . . . . . . .£3131.4x III converter . . . . . . . . . . . .£313
2x III converter. . . . . . . . . . . . . .£3132x III converter. . . . . . . . . . . . . .£313
12mm EF MKII ext tube. . . . £59.9912mm EF MKII ext tube. . . . £59.99
25mm EF MKII ext tube. . . . . .£11925mm EF MKII ext tube. . . . . .£119
MR-14EX MKII Ringflash . . . . .£449MR-14EX MKII Ringflash . . . . .£449
430EX III RT Speedlight . . . . . .£217430EX III RT Speedlight . . . . . .£217
600EX-RT Speedlight . . . . . . . .£428600EX-RT Speedlight . . . . . . . .£428

NIKON DX  
NON FULL FRAME LENSES
10.5 F2.8 DX Fisheye . . . . . . . .£548
10-24 F3.5/4.5 AFS G . . . . . . . .£638
16-80 F2.8/4 AFS ED VR. . . . . .£766
16-85 F3.5/5.6 AFS VR . . . . . . .£49816-85 F3.5/5.6 AFS VR . . . . . . .£498
18-55 F3.5/5.6 AFS VR . . . . . . . .£9918-55 F3.5/5.6 AFS VR . . . . . . . .£99
18-105 F3.5/5.6 AFS G no box£19918-105 F3.5/5.6 AFS G no box£199
18-140 F3.5/5.6 AFS VR . . . . . .£39918-140 F3.5/5.6 AFS VR . . . . . .£399
18-300 F3.5/6.3 AFS VR . . . . . .£54818-300 F3.5/6.3 AFS VR . . . . . .£548
35 F1.8 AFS G . . . . . . . . . . . . . . .£16935 F1.8 AFS G . . . . . . . . . . . . . . .£169
40 F2.8 AFS G macro . . . . . . . .£20940 F2.8 AFS G macro . . . . . . . .£209
55-300 F4.5/5.6 AFS VR . . . . . .£26855-300 F4.5/5.6 AFS VR . . . . . .£268

NIKON FX 
FULL FRAME LENSES
14-24 F2.8 AFS G ED. . . . . . . £1459
16 F2.8 AFD Fisheye . . . . . . . . . £624

16-35 F4 AFS VR . . . . . . . . . . . .£899
18-35 F3.5/4.5 AFS G . . . . . . . .£54918-35 F3.5/4.5 AFS G . . . . . . . .£549
20 F1.8 AFS G ED. . . . . . . . . . . .£57920 F1.8 AFS G ED. . . . . . . . . . . .£579
24 F1.4 AFS . . . . . . . . . . . . . . . £159924 F1.4 AFS . . . . . . . . . . . . . . . £1599
24 F1.8 AFS G ED. . . . . . . . . . . .£62924 F1.8 AFS G ED. . . . . . . . . . . .£629
24 F3.5 PCE . . . . . . . . . . . . . . . £146424 F3.5 PCE . . . . . . . . . . . . . . . £1464
24-70 F2.8 AFS G ED VR. . . . £174724-70 F2.8 AFS G ED VR. . . . £1747
24-70 F2.8 AFS G ED. . . . . . . £118924-70 F2.8 AFS G ED. . . . . . . £1189
24-85 F3.5/4.5 AFS VR . . . . . . .£39924-85 F3.5/4.5 AFS VR . . . . . . .£399
24-120 F4 AFS G ED VR . . . . . .£84924-120 F4 AFS G ED VR . . . . . .£849

28 F1.8 AFS . . . . . . . . . . . . . . . . .£49428 F1.8 AFS . . . . . . . . . . . . . . . . .£494
28-300 F3.5/5.6 AFS VR . . . . . .£72928-300 F3.5/5.6 AFS VR . . . . . .£729
35 F1.4 AFS G . . . . . . . . . . . . . £139935 F1.4 AFS G . . . . . . . . . . . . . £1399
35 F1.8 AFS G . . . . . . . . . . . . . . .£15435 F1.8 AFS G . . . . . . . . . . . . . . .£154
35 F2 AF-D. . . . . . . . . . . . . . . . . .£25435 F2 AF-D. . . . . . . . . . . . . . . . . .£254
50 F1.4 AFS G . . . . . . . . . . . . . . .£34950 F1.4 AFS G . . . . . . . . . . . . . . .£349
50 F1.8 AFS G . . . . . . . . . . . . . . .£17950 F1.8 AFS G . . . . . . . . . . . . . . .£179
58 F1.4 AFS G . . . . . . . . . . . . . £129958 F1.4 AFS G . . . . . . . . . . . . . £1299
60 F2.8 AFS . . . . . . . . . . . . . . . . .£43960 F2.8 AFS . . . . . . . . . . . . . . . . .£439
70-200 F2.8 AFS VRII . . . . . . £179870-200 F2.8 AFS VRII . . . . . . £1798
70-200 F4 AFS G ED VR . . . . £107970-200 F4 AFS G ED VR . . . . £1079
70-300 F4.5/5.6 AFS VR . . . . . .£43970-300 F4.5/5.6 AFS VR . . . . . .£439
80-400 F4.5/5.6 AFS G VR . . £179880-400 F4.5/5.6 AFS G VR . . £1798
85 F1.4 AFS G . . . . . . . . . . . . . £119885 F1.4 AFS G . . . . . . . . . . . . . £1198
85 F1.8 AFS G . . . . . . . . . . . . . . .£39985 F1.8 AFS G . . . . . . . . . . . . . . .£399
105 F2.8 AFS VR macro . . . . . .£659105 F2.8 AFS VR macro . . . . . .£659
200 F2 AFS ED VRII . . . . . . . . £4199200 F2 AFS ED VRII . . . . . . . . £4199
200-500 F5.6 AFS E ED VR. . £1097200-500 F5.6 AFS E ED VR. . £1097
300 F2.8 AFS ED VRII . . . . . . £3998300 F2.8 AFS ED VRII . . . . . . £3998
300 F4 AFS E PF ED VR. . . . . £1497300 F4 AFS E PF ED VR. . . . . £1497
400 F2.8 G E FL ED VR . . . . . £8888400 F2.8 G E FL ED VR . . . . . £8888
500 F4 E AFS FL ED VR . . . . . £8099500 F4 E AFS FL ED VR . . . . . £8099
600 F4 E AFS FL ED VR . . . . . £9494600 F4 E AFS FL ED VR . . . . . £9494
TC14EIII converter. . . . . . . . . . .£428TC14EIII converter. . . . . . . . . . .£428
TC17EII converter . . . . . . . . . . .£307TC17EII converter . . . . . . . . . . .£307
TC20EIII converter. . . . . . . . . . .£349TC20EIII converter. . . . . . . . . . .£349
SB700 flash . . . . . . . . . . . . . . . . .£228SB700 flash . . . . . . . . . . . . . . . . .£228
SB5000 flash. . . . . . . . . . . . . . . .£479SB5000 flash. . . . . . . . . . . . . . . .£479

X-Pro 2 body...................£1348
X-T1 blk + 18-135mm..£1079
X-T1 blk + 18-55mm ....£1049
X-T1 body Black................£805X-T1 body Black................£805
X-T10 + 18-55mm............£715X-T10 + 18-55mm............£715
X-T10 body Blk/silv..........£449X-T10 body Blk/silv..........£449
X-E2S + 18-55mm............£729X-E2S + 18-55mm............£729
X-E2S body.........................£548X-E2S body.........................£548
10-24mm F4 XF ................£76810-24mm F4 XF ................£768
14mm F2.8 XF R ..............£66814mm F2.8 XF R ..............£668
16mm F1.4 XF ...................£76816mm F1.4 XF ...................£768
16-55mm F2.816-55mm F2.8...................£848...................£848
18mm F2 XF.......................£42818mm F2 XF.......................£428

18-55mm F2.8/4 OIS ......£46818-55mm F2.8/4 OIS ......£468
18-135mm F3.5/5.6 XF...£61818-135mm F3.5/5.6 XF...£618
23mm F1.4 XF ...................£68823mm F1.4 XF ...................£688
27mm F2.8 XF ...................£27827mm F2.8 XF ...................£278
35mm F1.4 XF ...................£42835mm F1.4 XF ...................£428
35mm F2 R WR..................£29935mm F2 R WR..................£299
50-140mm F2.8 R OIS..£115850-140mm F2.8 R OIS..£1158
50-230 F4.5/6.7 OIS.........£24750-230 F4.5/6.7 OIS.........£247
55-200mm F3.5/4.855-200mm F3.5/4.8
OIS XF...................................£528OIS XF...................................£528
56mm F1.2 R APD.........£107856mm F1.2 R APD.........£1078
56mm F1.2 XF ...................£76856mm F1.2 XF ...................£768
60mm F2.4 XF ...................£45960mm F2.4 XF ...................£459

90 F2 R LM WR ..................£68890 F2 R LM WR ..................£688
100-400 F4/5.6 OIS WR ..£1448100-400 F4/5.6 OIS WR ..£1448
1.4x XF TC WR....................£3281.4x XF TC WR....................£328
2x XF TC WR .......................£3492x XF TC WR .......................£349
11mm Ext tube................... £6411mm Ext tube................... £64
16mm Ext tube................... £6416mm Ext tube................... £64
EF-20 flash............................ £98EF-20 flash............................ £98
EF-X20 flash .......................£168EF-X20 flash .......................£168
EF-42 flash..........................£168EF-42 flash..........................£168
X100T Black .......................£795X100T Black .......................£795
X100T Silver .......................£795X100T Silver .......................£795
X70 Black ............................£538X70 Black ............................£538
X70 Silver............................£538X70 Silver............................£538

X-Pro 2

X-E2S

100-400 f4/5.6More Sigma on website

Canon EOS 5Ds R
Full Frame

Body
only

£2888

Canon EOS 5D MKIII
Full Frame

Body only

£2149
BG-E11 Grip £215

Canon EOS 5Ds
Full Frame

Body
only

£2697

Body only

£1118
Plus 24-105 f3.5/5.6 IS £1498
BG-E13 Grip £129

Canon EOS 6D
Full Frame

BG-E16 Grip £198

Canon EOS 7D MKII
APS-C

Body only

£1177

Canon EOS 1300D
APS-C

Plus 18-55

IS II

£369

Body only 
price

£998

Canon EOS 80D
APS-C

NEW FROM CANON

Body only 
price

£5198

Canon EOS 
1DX MKII

Full Frame

Nikon D810
Full Frame

Body only
£2144

MBD-12 Grip (D810/800/E) £279

Body only £1388

Plus 24-120 f4 VR £1946
MBD-16 Grip £228

Nikon D750
Full Frame

Plus 18-55 VRII £555
Plus 18-140 VR £699

Nikon D5500
APS-C

Body only £489

Plus 18-105 VR £885
MBD-15 Grip £198

Nikon D7200
APS-C

Body only £713

Nikon 500mm
f4 AFS FL

ED VR

£8099

NEW FROM NIKON
Nikon D5
Full Frame

Body only 
price

£5198

Plus 16-80 VR £2479
MBD-17 Grip £427

Nikon D500
APS-C

Body only 
price

£1728

Nikon 200-500mm
f5.6 AFS E

ED VR

£1097

£8888

Nikon 400mm
f2.8 G E FL

ED VR

An excellent range

of new books

dealing with all

aspects ofaspects of

equipment andequipment and

photography arephotography are

available eitheravailable either

in-store or via ourin-store or via our

websitewebsite

Nikon 24-70mm
f2.8 AFS

G ED VR

£1747

Body only

£539

Canon EOS 760D
APS-C

BG-E18 Grip £115

Plus 18-55 STM £528
Plus 18-135 STM £699

Canon EOS 750D
APS-C

Body only £449
BG-E18 Grip £115

500mm

F4 IS L UII



5 x 4 USED
5x4 Amiga / Toyo kit........£249
Fuji 90 F8 SW......................£169......................£169
Fuji 180 F5.6Fuji 180 F5.6 .......................£169.......................£169
5x4 darkslides each5x4 darkslides each .....£16.95.....£16.95
BRONICA ETRS 645 USED
ETRSi + 75 F2.8 PE + RFH £399
40 F4 MC..............................£149..............................£149
50 F2.8 E50 F2.8 E...............................£149...............................£149
105 F3.5105 F3.5..................................£99..................................£99
135 F4 PE M- box135 F4 PE M- box..............£249..............£249
150 F3.5 E150 F3.5 E ..............................£99..............................£99
150 F3.5 PE M- Box...........£149150 F3.5 PE M- Box...........£149
200 F4.5 PE200 F4.5 PE..........................£199..........................£199
E14 or 28 ext tube eachE14 or 28 ext tube each ...£49...£49
120 RFH120 RFH..................................£69..................................£69
Polaroid BackPolaroid Back .......................£39.......................£39
Plain prismPlain prism ............................£59............................£59
Rotary prismRotary prism.......................£129.......................£129
Angle viewfinder EAngle viewfinder E...........£129...........£129
Winder earlyWinder early .........................£79.........................£79
Speed Grip ESpeed Grip E.........................£39.........................£39
Tripod adapter ETripod adapter E .................£39.................£39
Winder earlyWinder early .........................£49.........................£49
Metz SCA 386Metz SCA 386.......................£49.......................£49
BRONICA SQ 6x6 USED
SQB complete....................£399
40 F4 S ..................................£299..................................£299
50 F3.5 S50 F3.5 S...............................£149...............................£149
135 F4 PS M-135 F4 PS M-.......................£249.......................£249
150 F3.5 S150 F3.5 S ..............................£79..............................£79
150 F4 PS150 F4 PS ................... £149/199................... £149/199
200 F4.5 PS M- box200 F4.5 PS M- box ..........£199..........£199
2x PS converter M-2x PS converter M-...........£179...........£179
135N back135N back ...........................£139...........................£139
SQAi Polaroid back.............£79SQAi Polaroid back.............£79
SQAi 120 RFHSQAi 120 RFH.......................£79.......................£79
SQA 120 RFHSQA 120 RFH ........................£49........................£49
45° Prism box45° Prism box .....................£129.....................£129
Plain Prism S BoxedPlain Prism S Boxed ...........£69...........£69
AE Prism EarlyAE Prism Early ......................£79......................£79
ME Prism FinderME Prism Finder ..................£69..................£69
Metz SCA 386Metz SCA 386.......................£49.......................£49
Pro shade SPro shade S ...........................£59...........................£59
Lens Hood 65-80.................£20Lens Hood 65-80.................£20
SQAi MotorwinderSQAi Motorwinder ...........£149...........£149
Speed grip SSpeed grip S .........................£69.........................£69
BRONICA RF 645 USED
RF645 + 65 F4 ....................£649
CANON DIGITAL AF USED
1DX body box.................£3399
1D MKIV body box ........£1699........£1699
1D MKIII body box............£5991D MKIII body box............£599
1Ds MKII body....................£4991Ds MKII body....................£499
7D MKII body7D MKII body .....................£949.....................£949
7D body7D body ...............................£399...............................£399
5D MKIII b/o box5D MKIII b/o box £1399/1599£1399/1599
5D MKII body5D MKII body ..............£599/899..............£599/899
5D MKI body box5D MKI body box ......£399/499......£399/499
700D body M- box..............£349700D body M- box..............£349
450D body box450D body box ....................£149....................£149
400D body400D body ...............................£99...............................£99
300D body300D body ...............................£79...............................£79
70D body box70D body box.......................£549.......................£549
60D body60D body................................£399................................£399
50D body50D body................................£299................................£299
40D body40D body................................£169................................£169
20D body20D body................................£119................................£119
1100D body1100D body...........................£169...........................£169
BG-E2BG-E2..........................................£39..........................................£39
BG-ED3.......................................£39BG-ED3.......................................£39
BG-E4BG-E4..........................................£79..........................................£79
BG-E6BG-E6..........................................£89..........................................£89
BG-E7BG-E7..........................................£99..........................................£99
BG-E8BG-E8..........................................£69..........................................£69
BG-E13BG-E13 .....................................£119.....................................£119
BG-E16BG-E16 .....................................£169.....................................£169
G3X compact boxG3X compact box...............£499...............£499
G5X compact boxG5X compact box...............£399...............£399
CANON AF USED
EOS 650/600 body each...£39
EOS 50E/300V body each £29£29
EOS 500N/1000 b/o eachEOS 500N/1000 b/o each £29£29
10-22 F3.5/4.5 U10-22 F3.5/4.5 U................£299................£299
16-35 F2.8 USM L16-35 F2.8 USM L..............£799..............£799
17-40 F4 L17-40 F4 L............................£399............................£399
17-55 F2.8 EFS IS USM17-55 F2.8 EFS IS USM ....£399....£399
17-85 F4/5.617-85 F4/5.6........................£179........................£179
18-55 F3.5/5.6 IS EFS18-55 F3.5/5.6 IS EFS .........£89.........£89
18-55 F3.5/5.6 IS STM18-55 F3.5/5.6 IS STM............ £99............ £99
18-55 F3.5/5.6 EFS18-55 F3.5/5.6 EFS .................. £59.................. £59
18-135 F3.5/5.6 IS..................£21918-135 F3.5/5.6 IS..................£219
20-35 F3.5/4.5 USM20-35 F3.5/4.5 USM..............£199..............£199
24 f1.4 LII M- box24 f1.4 LII M- box...................£849...................£849
24 F2.8 IS USM24 F2.8 IS USM........................£369........................£369
24-70 F2.8 L USM box24-70 F2.8 L USM box.........£649.........£649
24-85 F3.5/4.5 USM24-85 F3.5/4.5 USM..............£169..............£169
24-105 F4 L24-105 F4 L...............................£549...............................£549
28 F1.8 USM box28 F1.8 USM box...............£259...............£259
28-90 F3.5/5.628-90 F3.5/5.6 ......................£79......................£79
28-135 F3.5/5.6 IS USM28-135 F3.5/5.6 IS USM ..£219..£219
28-200 F3.5/5.6 USM28-200 F3.5/5.6 USM .......£169.......£169
35 F1.4 L USM35 F1.4 L USM ....................£799....................£799
35-135 F3.5/4.535-135 F3.5/4.5....................£99....................£99

40 F2.8 STM40 F2.8 STM ........................... £119........................... £119
50 F1.4 USM50 F1.4 USM........................... £219........................... £219
50 F1.8 MKII50 F1.8 MKII ..............................£49..............................£49
55-250 F4/5.6 ISII M- box55-250 F4/5.6 ISII M- box....£129£129
70-200 F4 IS U L70-200 F4 IS U L ................£499................£499
70-200 F4 U L70-200 F4 U L .....................£299.....................£299
70-300 F4/5.6 L IS70-300 F4/5.6 L IS .............£599.............£599
75-300 F4/5.6 MKII75-300 F4/5.6 MKII .............£99.............£99
85 F1.8 M-85 F1.8 M-............................£199............................£199
100 F2 M- box100 F2 M- box....................£279....................£279
100 F2.8 IS L U100 F2.8 IS L U ...................£529...................£529
100-400 F4.5/5.6 L IS U100-400 F4.5/5.6 L IS U... £799... £799
135 F2 M- box135 F2 M- box....................£549....................£549
200 F2.8 LII U200 F2.8 LII U........................£429........................£429
300 F2.8 LI IS U..................£2799300 F2.8 LI IS U..................£2799
300 F4 L IS USM box300 F4 L IS USM box.........£649.........£649
400 F2.8 L IS U400 F2.8 L IS U.......£3999/4299.......£3999/4299
400 F4 DO400 F4 DO...........................£2399...........................£2399
400 F5.6 L box400 F5.6 L box............£599/699............£599/699
500 F4 L II IS USM500 F4 L II IS USM ............£5999............£5999
500 F4 LI IS USM...............£4499500 F4 LI IS USM...............£4499
1.4x extender MKII1.4x extender MKII ............£199............£199
2x extender MKII2x extender MKII................£199................£199
2x extender MKI2x extender MKI................£169................£169
Teleplus 2x DG convTeleplus 2x DG conv..........£89..........£89
Kenko ext tube set DGKenko ext tube set DG......... £89......... £89
LC-5 wireless kit boxLC-5 wireless kit box........£169........£169
LC-4 wireless kitLC-4 wireless kit ..................£89..................£89
PB-E2 drive fits EOS1/3PB-E2 drive fits EOS1/3...£149...£149
Tripod mnt adapt A (W)Tripod mnt adapt A (W)...£59...£59
SIGMA CAF USED
10-20 F4/5.6 HSM box .£199
12-24 F4.5/5.6 EX DG ..........£399..........£399
17-70 F2.8/4 DC OS HSM17-70 F2.8/4 DC OS HSM ..£199..£199
18-35 F1.8 DC M-......................£39918-35 F1.8 DC M-......................£399
18-200 F3.5/5.6 DC OS18-200 F3.5/5.6 DC OS .....£149.....£149
24-35 F2 DG Art M- box24-35 F2 DG Art M- box...£599...£599
24-70 F2.8 HSM24-70 F2.8 HSM....................£469....................£469
24-70 F2.8 EX.........................£24924-70 F2.8 EX.........................£249
50 F1.4 EX DC50 F1.4 EX DC........................£249........................£249
70-200 F2.8 EX DG HSM...£42970-200 F2.8 EX DG HSM...£429
70-300 F4/5.6 DG70-300 F4/5.6 DG................£79................£79
105 F2.8 EX DG105 F2.8 EX DG..................£199..................£199
120-300 F2.8 EX DG120-300 F2.8 EX DG.........£699.........£699
120-400 F4/5.6 DG120-400 F4/5.6 DG ...........£399...........£399
150 F2.8 macro150 F2.8 macro.....................£429.....................£429
150-500 F5/6.3 APO DG150-500 F5/6.3 APO DG.....£499.....£499
180 F3.5 EX macro180 F3.5 EX macro................£399................£399
2x EX DG conv2x EX DG conv........................£129........................£129
2x EX conv2x EX conv.................................. £89.................................. £89
Kenko Pro 300 1.4x convKenko Pro 300 1.4x conv..... £99..... £99
OTHER CAF USED
TAM 28-300 box................£179
TAM 45 F1.8 Di VC...............£399...............£399
TAM 70-300 F4/5.6TAM 70-300 F4/5.6 ............... £99............... £99
TAM 90 F2.8 Di VCTAM 90 F2.8 Di VC...............£299...............£299
TAM 90 F2.8 Di............£199/249TAM 90 F2.8 Di............£199/249
CANON FLASH USED
CP-E3 batt pack...................£49
ST-E2 transmitter ................£89................£89
430EXII430EXII..................................£169..................................£169
430EZ non digital430EZ non digital ...............£39...............£39
580EXII580EXII..................................£279..................................£279
580EX box580EX box ...........................£179...........................£179
600EX RT box600EX RT box .....................£329.....................£329
CANON FD USED
A-1 body ................................£99
T90 body................................£99................................£99
28 F2.828 F2.8 ....................................£49....................................£49
35-70 F3.5/4.535-70 F3.5/4.5 ......................£49......................£49
50 F1.450 F1.4 ...................................£99...................................£99
70-200 F470-200 F4...............................£79...............................£79
100-300 F5.6100-300 F5.6.........................£99.........................£99
299T or 300TL flash ea299T or 300TL flash ea......£29......£29
CONTAX MF USED
40-80 F3.5 AE .....................£199
FUJI DIGITAL USED
S5 Pro body ........................£249
X-T1 body graphite box .£699.£699
X-T1 body black.................£599X-T1 body black.................£599
X-T10 bodyX-T10 body..........................£349..........................£349
X-E1 body silverX-E1 body silver ................£199................£199
X-M1 body blk box...........£169X-M1 body blk box...........£169
16-50 F3.5/5.6 XC M-16-50 F3.5/5.6 XC M-.........£139.........£139
16-55 F2.8 box16-55 F2.8 box...................£599...................£599
23 F1.4 R box23 F1.4 R box......................£499......................£499
50-140 F2.8 R box50-140 F2.8 R box.............£899.............£899
55-200 F3.5/4.8 box55-200 F3.5/4.8 box.........£379.........£379
1.4x WR conv box1.4x WR conv box .............£269.............£269
Samyang 8 F2.8Samyang 8 F2.8.................£149.................£149
X100 silver boxX100 silver box ..................£379..................£379
X-Pro 1 leather caseX-Pro 1 leather case...........£69...........£69
X-T1 vertical gripX-T1 vertical grip...............£129...............£129
FUJI MED FORMAT USED
GSW690 III ...........................£599
HASSELBLAD XPAN USED

Centre filter 49mm.................£129
HASSELBLAD 6x6 USED
PM5 prism 45°....................£149
PME prism box...................£149
45° Prism late .....................£149.....................£149
45° Prism early45° Prism early.....................£69.....................£69
NC1 prism..............................£69NC1 prism..............................£69
WLF lateWLF late ...............................£110...............................£110

WLF chrome lateWLF chrome late.................£99.................£99
WLF earlyWLF early...............................£49...............................£49
A12 chrome latestA12 chrome latest............£299............£299
A12 late blk/chrA12 late blk/chr.................£129.................£129
Polaroid backPolaroid back .......................£79.......................£79
50 F4 CF FLE50 F4 CF FLE .......................£849.......................£849
50 F4 blk T*50 F4 blk T* .........................£349.........................£349
60 F3.5 chrome60 F3.5 chrome..................£399..................£399
60 F2.8 chrome60 F2.8 chrome..................£249..................£249
80 F2.8 CF80 F2.8 CF............................£479............................£479
100 F3.5 CF100 F3.5 CF .........................£549.........................£549
100 F3.5 Black T*100 F3.5 Black T*...............£399...............£399
140-280 F5.6 CF.................£899140-280 F5.6 CF.................£899
150 F4 chrome150 F4 chrome...................£199...................£199
250 F5.6 CF250 F5.6 CF .........................£399.........................£399
250 F5.6 chrome250 F5.6 chrome ...............£199...............£199
Vivitar 2x convVivitar 2x conv .....................£69.....................£69
Lens hoods variousLens hoods various..... £20/50..... £20/50
LEICA M COMPACT USED
IIIg body chrome ..............£849
5cm F3.5 ..............................£299..............................£299
35 F2 M- box (M39)35 F2 M- box (M39).......£1499.......£1499
50 F1.4 6 bit50 F1.4 6 bit.....................£1199.....................£1199
LEICA SLR USED
R7 body black ....................£449
R5 body black ....................£249....................£249
LEICA BINOCULARS USED
Trinovid 10x42...................£799
Ultravid 10x50 HD............£999............£999
LIGHTMETERS USED
Minolta Flashmeter V......£199
Minolta Spotmeter M......£199
Sekonic L308sSekonic L308s ......................£99......................£99
MAMIYA 645 MF USED
Plain prism (645 Super)....£39
Polariod Back HP401 .........£29.........£29
Polaroid backPolaroid back .......................£29.......................£29
120 Insert...............................£20120 Insert...............................£20
HA401 120 RFH BoxHA401 120 RFH Box...........£49...........£49
120 Back120 Back.................................£39.................................£39
WinderWinder....................................£79....................................£79
50 F4 shift50 F4 shift............................£349............................£349
55-110 F4.5 box.................£29955-110 F4.5 box.................£299
120 F4 macro120 F4 macro .....................£299.....................£299
150 F2.8 A150 F2.8 A............................£249............................£249
150 F3.5 N150 F3.5 N .............................£79.............................£79
210 F4 N M-210 F4 N M- ..........................£79..........................£79
Ext Tube 1, 2, 3S eachExt Tube 1, 2, 3S each .......£29.......£29
Teleplus 2x converterTeleplus 2x converter........£49........£49
Vivitar 2x converter............£39Vivitar 2x converter............£39
MAMIYA TLR 6x6 USED
C330 F Body + WLF ..........£149
55 F4.5 ..................................£199..................................£199
65 F3.5 box late65 F3.5 box late .................£199.................£199
65 F3.5 serviced.................£14965 F3.5 serviced.................£149
80 F2.8 late serviced80 F2.8 late serviced........£139........£139
180 F4.5180 F4.5................................£149................................£149
250 f4.5 late serviced.......£249250 f4.5 late serviced.......£249
250 f4.5 early serviced250 f4.5 early serviced .£179.£179
PrismPrism .......................................£99.......................................£99
ParamenderParamender ..........................£49..........................£49
PorrofinderPorrofinder............................£59............................£59
MAMIYA 7 RF 6x7 USED
50 F4.5 L + VF.....................£699
80 F4.5 L M- box................£699
150 F4.5 M-150 F4.5 M- .........................£399.........................£399
Panoramic kitPanoramic kit .......................£49.......................£49
MAMIYA RB 6x7 USED
Pro S + 90 + RFH + WLF .£449
Pro SD comp M-................£649................£649
Pro S bodyPro S body...........................£149...........................£149
Pro S body scruffyPro S body scruffy ..............£99..............£99
WLFWLF..........................................£79..........................................£79
Chimney...............................£179Chimney...............................£179
120 645V back120 645V back .....................£99.....................£99
90 F3.5 KL90 F3.5 KL ............................£249............................£249
127 F3.5 KL127 F3.5 KL..........................£299..........................£299
Ext tube 2Ext tube 2.................................... £49.................................... £49
MAMIYA RZ 6x7 USED
RZ ProII + 90 + WLF
+ 120 RFH............................£499
RZRZ Pro bodyPro body ........................£149........................£149
120 RFH Pro II120 RFH Pro II.......................£99.......................£99
120 RFH Pro I120 RFH Pro I........................£49........................£49
WLFWLF..........................................£79..........................................£79
FE701 AE prismFE701 AE prism .................£179.................£179
Winder IIWinder II.................................£69.................................£69
50 F4.5 W50 F4.5 W .............................£199.............................£199
65 F4 box M-65 F4 box M- ......................£399......................£399
90 F3.5 W M- box90 F3.5 W M- box..............£299..............£299
127 F3.5 box127 F3.5 box.......................£299.......................£299
180 F4.5 W box180 F4.5 W box..................£199..................£199
Pro shadePro shade...............................£49...............................£49
MINOLTA/SONY DIGITAL USED
Sony A7R body...................£799
Sony A700 body.................£199.................£199
Sony A350 bodySony A350 body.................£149.................£149
Sony VGC1EMSony VGC1EM .....................£149.....................£149
Sony VGB30AMSony VGB30AM .....................£79.....................£79
Sony VGC70AMSony VGC70AM ..................£139..................£139
Sony HVL-F58AMSony HVL-F58AM.................. £179.................. £179
Sony HV56AMSony HV56AM........................ £179........................ £179
Sony F42AMSony F42AM............................ £149............................ £149
Sony HVL-F32XSony HVL-F32X.........................£69.........................£69

SONY NEX USED 
Sony A6000 body.................£329
NEX 5 body..............................£129..............................£129
FE 16-35 F4 ZA OSS..............£849FE 16-35 F4 ZA OSS..............£849
FE 24-70 F4 ZA OSS..............£599FE 24-70 F4 ZA OSS..............£599
FE 35 F1.8 OSS boxFE 35 F1.8 OSS box...............£279...............£279
FE 50 F1.8 OSS EFE 50 F1.8 OSS E....................£169....................£169
FE 70-200 F4 GSSFE 70-200 F4 GSS ..................£749..................£749
Samyang 85 F1.4Samyang 85 F1.4...................£199...................£199
Samyang 100 F2.8 macroSamyang 100 F2.8 macro.£249.£249
Sigma 60 F2.8 boxSigma 60 F2.8 box.................. £99.................. £99
MINOLTA/SONY AF USED
9000 body .............................£79
800Si body ............................£69............................£69
7xi body7xi body .................................£49.................................£49
Dynax 5 bodyDynax 5 body...........................£39...........................£39
505Si Super505Si Super ............................ £25............................ £25
300Si body300Si body ............................£19............................£19
SPXi bodySPXi body ..............................£19..............................£19
20 F2.820 F2.8 ..................................£199..................................£199
20-35 F3.5/4.5 M- box20-35 F3.5/4.5 M- box.....£249.....£249
24-50 F424-50 F4 .................................£99.................................£99
28 F2.828 F2.8 ....................................£99....................................£99
28-80 F4/5.628-80 F4/5.6..........................£39..........................£39
28-85 F3.5/4.528-85 F3.5/4.5 ......................£99......................£99
28-100 F3.5/5.6 D28-100 F3.5/5.6 D ...............£49...............£49
35-70 F435-70 F4 .................................£39.................................£39
35-70 F3.5/4.535-70 F3.5/4.5........................... £25........................... £25
35-80 f4/5.635-80 f4/5.6................................ £25................................ £25
35-105 F3.5/4.535-105 F3.5/4.5 ........................ £99........................ £99
50 F2.8 macro50 F2.8 macro.........................£149.........................£149
75-300 F4.5/5.675-300 F4.5/5.6 ........................ £99........................ £99
100-300 F4.5/5.6 APO100-300 F4.5/5.6 APO.........£149.........£149
500 F8 mirror500 F8 mirror...........................£349...........................£349
VC700 gripVC700 grip.................................. £39.................................. £39
RC1000S/L cordRC1000S/L cord ....................... £15....................... £15
AW90AW90............................................. £49............................................. £49
MD90 + BP90-MMD90 + BP90-M...................... £79...................... £79
Angle finder VN........................ £89Angle finder VN........................ £89
SONY LENSES USED
16-35 F2.8 ZA SSM box......£899
16-50 F2.8 DT SSM................£279
18-55 F3.5/5.6 SAM18-55 F3.5/5.6 SAM................ £59................ £59
18-200 F3.5/6.3 DT18-200 F3.5/6.3 DT ...............£199...............£199
24-70 F2.8 ZE SSM24-70 F2.8 ZE SSM................£699................£699
55-200 F4/5.6 DT SSM55-200 F4/5.6 DT SSM .......... £79.......... £79
70-400 F4/5.6 G70-400 F4/5.6 G
SSMII boxSSMII box ...............................£1299...............................£1299
85 F1.4 ZA85 F1.4 ZA.................................£799.................................£799
SIGMA MIN/SONY AF USED
28-135 F3.8/5.6......................£79
28-300 F3.5/6.3 macro.....£149.....£149
50 F1.450 F1.4....................................£149....................................£149
50 F2.8 EX DG macro50 F2.8 EX DG macro .......£169.......£169
55-200 F4/5.655-200 F4/5.6 .........................£69.........................£69
70-300 F4/5.6 DG OS70-300 F4/5.6 DG OS ......£189......£189
150-500 F5./6.3 DG150-500 F5./6.3 DG ..........£499..........£499
170-500 F5/6.3170-500 F5/6.3...................£299...................£299
1.4x EX conv1.4x EX conv .........................£99.........................£99
TAM 10-24 F3.5/4.5 DiIITAM 10-24 F3.5/4.5 DiII ..£239..£239
TAM 70-300 F4.5/5.6TAM 70-300 F4.5/5.6
Di box......................................£79Di box......................................£79
TAM 70-300 F4.5/5.6TAM 70-300 F4.5/5.6..........£99..........£99
TAM 90 F2.8TAM 90 F2.8 .............. £179/249.............. £179/249
Teleplus 1.4x convTeleplus 1.4x conv..............£69..............£69
Teleplus 2x convTeleplus 2x conv .................£79.................£79
Kenko 1.4x Pro 300DGKenko 1.4x Pro 300DG....£149....£149
Min 5400HSMin 5400HS ..........................£69..........................£69
Min 5600HSD M-.................£99Min 5600HSD M-.................£99
NIKON DIGITAL AF USED
D3X body box.................£2199
D3 body box...........£999/1199...........£999/1199
D2Xs body boxD2Xs body box..................£379..................£379
D800 bodyD800 body .......................£1199.......................£1199
D700 body boxD700 body box..................£599..................£599
D600 bodyD600 body ..........................£699..........................£699
D300 body boxD300 body box..................£299..................£299
D200 body boxD200 body box..................£199..................£199
D100 body boxD100 body box....................£99....................£99
D7100 body boxD7100 body box ...............£449...............£449
D7000 bodyD7000 body.............. £299/349.............. £299/349
D5100 bodyD5100 body........................£249........................£249
D5000 bodyD5000 body........................£169........................£169
D90 bodyD90 body.............................£169.............................£169
D80 bodyD80 body.............................£149.............................£149
MBD-14 grip boxMBD-14 grip box ..............£149..............£149
MBD-12 gripMBD-12 grip .......................£229.......................£229
MBD-10 grip M- boxMBD-10 grip M- box........£149........£149
MBD-200 boxMBD-200 box .......................£79.......................£79
MBD-100MBD-100................................£49................................£49
NIKON AF USED
F4 body ................................£349
F4E body..............................£299..............................£299
F801s bodyF801s body ...........................£39...........................£39
F801 bodyF801 body ...................... £29/59...................... £29/59
F100 body + MB-15F100 body + MB-15 .........£199.........£199
F601 bodyF601 body .............................£29.............................£29
10.5 F2.8 AFS DX10.5 F2.8 AFS DX...............£439...............£439
10-24 F3.5/4.5 AFS DX10-24 F3.5/4.5 AFS DX ....£529....£529
12-24 F4 DX12-24 F4 DX ........................£399........................£399
14-24 F2.8 AFS14-24 F2.8 AFS ................£999................£999
16-85 F3.5/5.6 AFS VR16-85 F3.5/5.6 AFS VR ...£299...£299
17-35 F2.8 AFS17-35 F2.8 AFS ......................£699......................£699
17-55 F2.8 AFS17-55 F2.8 AFS ......................£499......................£499

18-55 F3.5/5.6 VRII18-55 F3.5/5.6 VRII..................£99..................£99
18-70 F3.5/4.5 AFS18-70 F3.5/4.5 AFS ..............£119..............£119
18-140 F3.5/5.6 VR DX M-18-140 F3.5/5.6 VR DX M- £249£249
18-200 F3.5/5.6 AFS VRII18-200 F3.5/5.6 AFS VRII...£399...£399
18-200 F3.5/5.6 AFS VRI18-200 F3.5/5.6 AFS VRI....£199....£199
20 F2.8 AF20 F2.8 AF................................£279................................£279
24 F2.8 AFD24 F2.8 AFD........................................................£299£299
24-70 F2.8 AFS box24-70 F2.8 AFS box.............£849.............£849
24-120 f4 AFS VR24-120 f4 AFS VR...................£699...................£699
28 F1.8 AFS G28 F1.8 AFS G..........................£399..........................£399
28 F2.8 AFD28 F2.8 AFD..............................£129..............................£129
28-80 F3.3/5.6 G28-80 F3.3/5.6 G....................... £69....................... £69
28-100 F3.5/5.6 AF G28-100 F3.5/5.6 AF G............. £69............. £69
35 F1.8 AFS DX box35 F1.8 AFS DX box.............£129.............£129
40 F2.8 AFS DX M- box40 F2.8 AFS DX M- box.......£149.......£149
50 F1.8 AFD...........................£9950 F1.8 AFD...........................£99
50 F1.8 AF50 F1.8 AF..............................£79..............................£79
55-300 F4.5/5.6 AFS VR55-300 F4.5/5.6 AFS VR...£199...£199
60 F2.8 AFD.........................£24960 F2.8 AFD.........................£249
60 F2.8 AF60 F2.8 AF............................£199............................£199
70-200 F2.8 AFS VRII70-200 F2.8 AFS VRII.....£1299.....£1299
70-300 F4/5.6 VR M-70-300 F4/5.6 VR M- ........£329........£329
70-300 F4/5.6 AFD70-300 F4/5.6 AFD ...........£129...........£129
70-300 F4 G...........................£7970-300 F4 G...........................£79
80-200 F2.8 AFD80-200 F2.8 AFD................£349................£349
85 F1.4 AFS M- box85 F1.4 AFS M- box ..........£979..........£979
85 F1.4 AFD.........................£49985 F1.4 AFD.........................£499
85 F1.8 AFD.........................£24985 F1.8 AFD.........................£249
85 F3.5 DX M- box85 F3.5 DX M- box............£269............£269
105 F2.8 AFD105 F2.8 AFD......................£369......................£369
180 F2.8 AFD M- box180 F2.8 AFD M- box.......£449.......£449
200-400 F4 AFS VRII200-400 F4 AFS VRII......£3999......£3999
300 F2.8 AFS VRII M-300 F2.8 AFS VRII M-.....£3499.....£3499
300 F2.8 AFS VRI300 F2.8 AFS VRI ............£2799............£2799
300 F2.8 AFS300 F2.8 AFS....................£1699....................£1699
300 F4 AFS M- box300 F4 AFS M- box ...........£699...........£699
300 F4 AFS box300 F4 AFS box..................£599..................£599
500 F4 AFS VR500 F4 AFS VR .................£4699.................£4699
500 F4 AFS Mk1500 F4 AFS Mk1..............£1999..............£1999
600 F4 AFS VR600 F4 AFS VR .................£5999.................£5999
600 F4 AFS II non VR.....£4299600 F4 AFS II non VR.....£4299
TC17EIITC17EII..................................£249..................................£249
TC20EIII M- boxTC20EIII M- box .................£249.................£249
TC20EIITC20EII..................................£199..................................£199
TC20ETC20E ....................................£149....................................£149
SIGMA NAF USED
12-24 F4.5/5.6 EX DG ..........£379
18-50 F2.8 EX DC Mac.........£199
28-300 F3.5/6.3 early..........£12928-300 F3.5/6.3 early..........£129
50 F1.4 DG Mint50 F1.4 DG Mint ......... £199/239......... £199/239
50-500 F4/6.3 DG50-500 F4/6.3 DG..............£399..............£399
70-300 F4/5.6 APO DG70-300 F4/5.6 APO DG......£99......£99
120-300 F2.8 OS Sport120-300 F2.8 OS Sport.£1899.£1899
135-400 F4.5/5.6135-400 F4.5/5.6....................£299....................£299
150-500 F5/6.3 DG OS150-500 F5/6.3 DG OS........£499........£499
150-600 F5/6.3 OS Sport150-600 F5/6.3 OS Sport...£999...£999
500 F4 EX DG500 F4 EX DG .......................£2299.......................£2299
1.4x EX DG M-1.4x EX DG M-.........................£119.........................£119
2x EX DG conv2x EX DG conv........................£159........................£159
TAMRON NAF USED
10-24 F3.5/4.5 DiII.................£239
17-50 F2.8 XR Di.....................£199
18-250 F3.5/6.318-250 F3.5/6.3 ......................£149......................£149
28-300 F3.5/6.328-300 F3.5/6.3 ...............£99/169...............£99/169
70-300 F4/5.6 Di VC USD70-300 F4/5.6 Di VC USD...£249...£249
70-300 F4/5.670-300 F4/5.6............................ £79............................ £79
OTHER NAF USED
TOK 10-17 F3.5/4.5 ATX..£249
TOK 12-24 F4 ATX pro.....£299.....£299
TOK 12-28 F4 ATX DXTOK 12-28 F4 ATX DX......£399......£399
FLASH / ACCESSORIES USED
SB-24.........£49 SB-25..............£49
SB-26............................................. £69............................................. £69
SB-80DXSB-80DX....................................... £79....................................... £79
SB-400 boxSB-400 box................................. £79................................. £79
SB-600.........................................£149SB-600.........................................£149
SB-700 boxSB-700 box...............................£199...............................£199
SB-900.........................................£269SB-900.........................................£269
SD-8 batt packSD-8 batt pack.......................... £49.......................... £49
DR-3 angle finderDR-3 angle finder.................... £69.................... £69
MB-16 M- boxMB-16 M- box........................... £89........................... £89
MB-23 (fits F4)MB-23 (fits F4)........................... £79........................... £79
MC-36A remoteMC-36A remote....................... £89....................... £89
MC-30 remoteMC-30 remote .......................... £39.......................... £39
MF-23 (date back F4)MF-23 (date back F4) ............ £79............ £79
Coolscan LS-50 boxCoolscan LS-50 box .............£399.............£399
NIKON MF USED
F3 body ................................£199
FM2n body chr box..........£349
FM2n body chrFM2n body chr ..................£249..................£249
15 F3.5 AIS...........................£89915 F3.5 AIS...........................£899
28 F3.5 AIS.............................£9928 F3.5 AIS.............................£99
28 F2.8 E box28 F2.8 E box........................£69........................£69
28-85 F3.5/4.5 AIS.............£19928-85 F3.5/4.5 AIS.............£199
35-70 F3.3/4.5 AIS.............£14935-70 F3.3/4.5 AIS.............£149
35-70 F3.5 AIS35-70 F3.5 AIS ......................£99......................£99
35-105 F3.5/4.5 AIS35-105 F3.5/4.5 AIS............£99............£99
50 F1.8 AIS.............................£8950 F1.8 AIS.............................£89
50 F1.8 AIS pancake.........£13950 F1.8 AIS pancake.........£139
50 F1.8 E50 F1.8 E.................................£59.................................£59
105 F2.8 AIS macro105 F2.8 AIS macro ..........£249..........£249
180 F2.8 AIS ED scruffy180 F2.8 AIS ED scruffy...£179...£179
200 F4 AIS macro200 F4 AIS macro..............£249..............£249
200 F4 AIS............................£149200 F4 AIS............................£149

200 F4 AI200 F4 AI................................£99................................£99
500 F8 early500 F8 early ........................£279........................£279
TC200TC200......................................£49......................................£49
TC301TC301....................................£169....................................£169
SC-17 TTL leadSC-17 TTL lead.....................£25.....................£25
DW-3 WLF find fit F3DW-3 WLF find fit F3 .........£99.........£99
DW-4 6x mag find fit F3DW-4 6x mag find fit F3...£99...£99
DW-21 fits F4DW-21 fits F4......................£149......................£149
Nikon bellows II boxNikon bellows II box..........£99..........£99
OLYMPUS DIGITAL USED
E3 body box........................£329
11-22 F2.8/3.5 M-..............£379
12-60 F2.8/4 SWD12-60 F2.8/4 SWD.............£379.............£379
14-42 F3.5/5.614-42 F3.5/5.6 ......................£49......................£49
14-45 F3.5/5.614-45 F3.5/5.6 ......................£79......................£79
14-50 F3.8/5.614-50 F3.8/5.6 ....................£199....................£199
14-54 F2.8/3.514-54 F2.8/3.5 ....................£149....................£149
35 F3.535 F3.5 ....................................£99....................................£99
40-150 F4/5.640-150 F4/5.6 .......................£49.......................£49
50 F2 macro50 F2 macro........................£279........................£279
25mm ext tube....................£7925mm ext tube....................£79
OLYMPUS PEN USED
OMD-EM1 body M- box .£499
OMD E-M5 body box.......£299
OMD-EM10 bodyOMD-EM10 body..............£299..............£299
Pen E-PM1 + 14-42 M-Pen E-PM1 + 14-42 M- ....£149....£149
Pen E-PM1 bodyPen E-PM1 body..................£99..................£99
12-40 F2.8 Pro12-40 F2.8 Pro....................£549....................£549
40-150 F2.8 Pro40-150 F2.8 Pro .................£799.................£799
40-150 F4/5.640-150 F4/5.6 .....................£119.....................£119
300 F4 IS Pro300 F4 IS Pro....................£1799....................£1799
1.4x converter1.4x converter....................£249....................£249
HLD-7 grip boxHLD-7 grip box..................£129..................£129
OLYMPUS OM USED
OM-4Ti body ......................£249
OM-2SP body.....................£149.....................£149
OM-2n bodyOM-2n body .......................£149.......................£149
OM-1n bodyOM-1n body .......................£149.......................£149
24 F2.824 F2.8 ..................................£169..................................£169
28 F3.528 F3.5 ....................................£49....................................£49
35-70 F3.5/4.535-70 F3.5/4.5 ......................£79......................£79
35-105 F3.5/4.535-105 F3.5/4.5....................£99....................£99
50 F3.5 macro50 F3.5 macro ......................£89......................£89
200 F4200 F4 .....................................£79.....................................£79
300 F4300 F4 ...................................£169...................................£169
PANASONIC DIGITAL USED
G3 body box.......................£129
G1 body box.........................£99.........................£99
GX1 body boxGX1 body box....................£149....................£149
GF1 bodyGF1 body ................................. £79................................. £79
14 F2.514 F2.5 ..................................£199..................................£199
14-42 F3.5/5.614-42 F3.5/5.6 ......................£79......................£79
14-45 F3.5/5.614-45 F3.5/5.6 ....................£149....................£149
45-200 F4/5.6 box45-200 F4/5.6 box ............£199............£199
LVF2 boxLVF2 box ..............................£149..............................£149
BG-GH3 gripBG-GH3 grip .........................£99.........................£99
PENTAX DIGITAL AF USED
K5 II body box....................£399
K7 body................................£199................................£199
PENTAX 35mm AF USED
MZ5N body...........................£69
10-17 F3.5/4.5 ED .............£239.............£239
16-45 F416-45 F4 ...............................£199...............................£199
16-50 F2.816-50 F2.8............................£379............................£379
17-70 F4 SDM M- box17-70 F4 SDM M- box .....£299.....£299
18-55 F3.5/5.618-55 F3.5/5.6 ......................£29......................£29
28-80 F3.5/5.628-80 F3.5/5.6 ......................£49......................£49
50-135 F2.8 SDM50-135 F2.8 SDM...............£379...............£379
50-200 F4/5.650-200 F4/5.6 .......................£99.......................£99
55 F1.4 SDM M-55 F1.4 SDM M-.................£469.................£469
55-300 F4/5.8 ED box55-300 F4/5.8 ED box......£229......£229
70 F2.8 Limited70 F2.8 Limited..................£349..................£349
70-300 F4/5.670-300 F4/5.6 .......................£79.......................£79
100-300 F4.5/5.6100-300 F4.5/5.6 .................£99.................£99
SIGMA PKAF USED
24-70 F2.8 EX DG mac ....£249
28-300 F3.5/6.3 DG mac...£99
PENTAX 645AF USED
645N body ..........................£399
45 F2.8 FA ............................£399............................£399
75 F2.875 F2.8 ..................................£169..................................£169
150 F2.8 FA150 F2.8 FA..........................£499..........................£499
AF500FTZ flashAF500FTZ flash....................£99....................£99
PENTAX 645MF USED
645 + 75 F2.8......................£249
645 body + insert .............£199.............£199
55 F2.855 F2.8 ..................................£249..................................£249
150 F3.5 EX++150 F3.5 EX++....................£149....................£149
200 F4200 F4 ..................................£149..................................£149
120 Insert M- box120 Insert M- box................£49................£49
PENTAX 67 USED
200 F4 latest .......................£169
200 F4 early.............................£99.............................£99
300 F4 early scruffy300 F4 early scruffy............. £99............. £99
Pentax rear conv 1.4xPentax rear conv 1.4x........£249........£249
2x rear converter2x rear converter...............£179...............£179
Auto ext tubesAuto ext tubes .....................£49.....................£49
Vivitar 2x convVivitar 2x conv .....................£49.....................£49
SAMSUNG USED
50-200 F4/5.6 III M- box....£99
TAMRON ADII USED
500 F8 ...................................£169
VOIGTLANDER USED
15 F4.5 + VF M- box.........£269

Although we are the best stocked dealer in the West Country,  
we cannot always have every item listed in stock at all times, so 
we are happy to reserve new & used items for customers 
planning to visit. Prices correct 13/06/2016 but subject to 
change without notice. See website for up to date prices. E&OE.

ITEM YOU REQUIRE NOT LISTED? PLEASE GIVE US DETAILS OF WHAT YOU ARE LOOKING FOR AND WE WILL CONTACT YOU WHEN THAT  ITEM BECOMES AVAILABLE.
Mail order used items sold on 10 day approval. Return in ‘as received’ condition for refund if not satisfied (postage not included - mail order only). E&OE.

QUALITY USED EQUIPMENT. See website for full list. Call us to check condition. 6 Month warranty on most secondhand.

Website altered daily inc. manufacturers cashback & promotions

www.mifsuds.com
Subscribe to our newsletter -  send your email address to info@mifsuds.com.

Used Nikon
300mm f2.8 AFS VRII M-

£3499

Used Fuji X
X-T1 body Graphite
box

£699

Used Sony
70-400 F4/5.6 G

SSMII

box

£1299

Used Canon
EOS 1DX
body
box

£3399

Used Canon
35mm

f1.4 L

USM

£799

Used Canon
300mm f2.8 L IS USM

£2799

Used Canon
300mm f4 L IS USM
box

£649

Used Canon
400mm f2.8 L IS USM

£3999/4299

Used Canon
1D MKIV
body
box

£1699

Used Canon
EOS 5D

MKIII

body

£1399/1599

Used Canon

24mm

f1.4 LII

M- box

£849

Used Sony
16-35mm

f2.8 ZA
SSM box

£849

Used Canon
100-400mm f4.5/5.6 L
IS USM

£799

Used Canon
400mm f4 DO

£2399

Used Canon
24-70mm

f2.8 L USM

box

£649

Used Canon
500mm f4 LII IS USM

£5999

Used Canon

16-35 f2.8

USM

L

£799

Used Canon
EOS 7D

MKII

body

£949

Used Hasselblad
50mm f4 CF FLE

£849

Used Nikon
D3X

body

box

£2199

Used Leica
1IIg body
chrome

£849

Used Nikon
D600

body

£699

Used Nikon
14-24mm f2.8 AFS

£999

Used Nikon
500mm f4 AFS MKI

£1999

Used Nikon
85mm f1.4 AFS M- box

£979

Used Nikon
300mm f2.8 AFS VRI

£2799

Used Nikon
300mm f4 AFS

£599/699

Used Nikon
D3

body

box

£999/1199

Used Nikon
D800 E

body

box

£999

Used Nikon
500mm f4 AFS VR

£4699

Used Leica
35mm f2

M39

M- box

£1499

Used Nikon
200-400mm f4 AFS VRII

£3999

Used Leica
Ultravid

10x50 HD

Binoculars

£999

Used Nikon
600mm f4 AFS II

non VR

£4299

Used Nikon
300mm f2.8 AFS

£1699

Used Nikon
600mm f4 AFS VR

£5999



www.premier-ink.co.uk    Telephone: 01926 339977 or 0800 1077 211    Premier Ink & Photographic 12 Longfield Road, Leamington Spa, Warwickshire CV31 1XB

We are a small, family owned and run company, specialising in photographic 
consumables – and proud winners of multiple Good Service Awards. 

We are located in Leamington Spa, in the heart of Warwickshire. 
If you’re passing, please pop into our shop and meet Cooper – our office dog!

Lowering the cost of printing...

01926 339977   www.premier-ink.co.uk

E&EO. Prices may be subject to change, but hopefully not!

We carry one of the largest ranges of printer ink cartridges 
in the UK, with cartridges in stock for practically every inkjet 
printer. We always stock Original cartridges, which are made 
by your printer manufacturer, and in many cases we also 
offer Compatible cartridges, which are usually made by a UK 
company called Jet Tec. Using Jet Tec Compatibles is a way 
of saving money, without compromising on the quality of 
your prints. 

Here are the results 
from two independent 
ink tests that agree...

Ink Cartridges Albums & Frames
We now stock a comprehensive range of frames, mounts, albums 
and accessories. The full range can be viewed on our website, 
with detailed close-up images of each product to help you 
choose the perfect way to display your printed photographs. 
Below is just a tiny sample of what we offer:

Memo Style Albums:
Grace 6x4 100 photos £5.99
Grace 6x4 200 photos £9.99
Grace 6x4 300 photos £14.99
Grace 7x5 100 photos £7.99
Grace 7x5 200 photos £13.99
Grace A4 100 photos £15.99
Grafton 6x4 200 photos £9.99
Grafton 7x5 200 photos £13.99
Baby 6x4 200 photos £9.99
Travel 6x4 200 photos £8.99
Traditional Style Albums:
Grace 29x32cm 100 pages £14.99
Grafton 29x32cm 100 pgs £14.99
Baby 29x32cm 100 pages £12.99
Accessories:
Photo Corners Pack of 250 £2.99
Photo Stickers Pack of 500 £1.99

Plastic Bevel, Glass Front:
Frisco 6x4 seven colours £1.99
Frisco 7x5 seven colours £2.29
Frisco 8x6 seven colours £2.79
Frisco 9x6 seven colours £3.49
Frisco 10x8 seven colours £3.79
Frisco 12x8 seven colours £4.59
Frisco A4 seven colours £3.99
Frisco A3 seven colours £8.99
Wood Bevel, Glass Front:
Emilia 6x4 two colours £4.99
Emilia 7x5 two colours £5.99
Emilia 8x6 two colours £6.99
Emilia 10x8 two colours £7.99
Emilia 12x8 two colours £8.99
Rio 6x4 four colours £5.99
Rio 7x5 four colours £6.99
Rio 8x6 four colours £7.99
Rio 10x8 four colours £8.99
Rio 12x8 four colours £9.99

More Ink Cartridges...

Photo Glossy 160gsm:
6x4 50 sheets +50 FREE £3.99
A4 100 sheets £12.99
Photo Satin 200gsm:
6x4 100 sheets +100 FREE £9.99
A4 100 sheets +100 FREE £19.99
Photo Glossy 200gsm:
6x4 100 sheets +100 FREE £9.99
A4 20 sheets £6.99
Premium Pearl 270gsm:
6x4 50 sheets +50 FREE £6.99
A4 20 sheets +20 FREE £8.99
Premium Gloss 270gsm:
A4 25 sheets OFFER £8.99
A3 25 sheets OFFER £15.99
A3+ 25 sheets OFFER £19.99
Smooth Pearl 310gsm:
6x4 100 sheets £14.99
7x5 100 sheets £17.99
A4 25 sheets £12.99
A4 100 sheets £39.99
A4 250 sheets £84.99
A3 25 sheets £25.99
A3+ 25 sheets £35.99
17” Roll 30 metres £69.99
24” Roll 30 metres £96.99
Smooth Gloss 310gsm:
6x4 100 sheets £14.99
7x5 100 sheets £17.99
A4 25 sheets £12.99
A4 100 sheets £39.99
A3 25 sheets £25.99
A3+ 25 sheets £35.99
Premium Matt Duo 200 gsm:
A4 50 sheets £12.99
A3+ 50 sheets £34.99
Heavy Duo Matt 310gsm:
A4 50 sheets £17.99
A3+ 50 sheets £44.99
Gold Fibre Silk 310gsm:
A4 50 sheets £37.99
A3+ 50 sheets £89.99
Gold Mono Silk 270gsm:
A4 25 sheets £16.99
A3+ 25 sheets £42.99

Smooth Pearl 290gsm:
6x4 100 sheets £12.99
7x5 100 sheets £16.99
A4 50 sheets £17.99
A3 50 sheets £34.99
A3+ 25 sheets £25.99
Panoramic 25 sheets £26.99
17” Roll 30 metres £68.99
24” Roll 30 metres £85.99
PF Lustre 275gsm:
6x4 100 sheets £12.99
7x5 100 sheets £16.99
A4 50 sheets £17.99
A3 25 sheets £35.99
A3+ 50 sheets £47.99
Panoramic 25 sheets £26.99
17” Roll 30 metres £69.99
24” Roll 30 metres £86.99
PF Gloss 270gsm:
A4 50 sheets £17.99
A3 50 sheets £35.99
A3+ 50 sheets £47.99
Panoramic 25 sheets £26.99
Matt Ultra 240gsm:
A4 50 sheets £12.99
A3 50 sheets £26.99
A3+ 50 sheets £35.99
Fine Art / Fibre Base Papers:
Baryta A4 20 sheets £21.99
Bartya A3 20 sheets £42.99
Etching A4 25 sheets £19.99
Etching A3 25 sheets £34.99
Smooth Cotton A4 25 sh £24.99
Smooth Cotton A3 25 sh £51.99

PP-201 Plus Glossy II 275gsm:
6x4 50 sheets £9.99
7x5 20 sheets £11.99
A4 20 sheets £11.99
A3 20 sheets £27.99
A3+ 20 sheets £36.99
PT-101 Pro Platinum 300gsm:
6x4 20 sheets £7.99
A4 20 sheets £16.99
A3 20 sheets £37.99
A3+ 10 sheets £24.99
SG-201 Semi-Gloss 260gsm:
6x4 50 sheets £9.99
A4 20 sheets £11.99
A3 20 sheets £27.99
A3+ 20 sheets £42.99
LU-101 Pro Lustre 260gsm:
A4 50 sheets £14.99
A3 50 sheets £32.99
A3+ 50 sheets £49.99

Smooth Pearl 280gsm:
6x4 100 sheets £12.99
7x5 100 sheets £18.99
A4 50 sheets £18.99
A4 50 sheets £18.99
A3 50 sheets £35.99
A3+ 25 sheets £28.99
17” Roll 30 metres £64.99
24” Roll 30 metres £89.99
Ultra Pearl 295gsm:
6x4 100 sheets £14.99
7x5 100 sheets £20.99
A4 25 sheets £12.99
A3 25 sheets £22.99
A3+ 25 sheets £30.99
13” Roll 10 metres £21.99
17” Roll 30 metres £68.99
24” Roll 30 metres £92.99
Titanium Lustre 280gsm:
A4 25 sheets £22.99
A3 25 sheets £44.99
A3+ 25 sheets £62.99
Oyster 271gsm:
6x4 100 sheets £12.99
7x5 100 sheets £18.99
A4 50 sheets £18.99
A3 25 sheets £22.99
A3+ 25 sheets £28.99
13” Roll 10 metres £26.99
17” Roll 30 metres £64.99
24” Roll 30 metres £89.99
Gloss 271gsm:
6x4 100 sheets £12.99
7x5 100 sheets £18.99
A4 50 sheets £18.99
A3 25 sheets £22.99
A3+ 25 sheets £28.99
13” Roll 10 metres £26.99
17” Roll 30 metres £64.99
24” Roll 30 metres £89.99
Matt Plus 240gsm:
6x4 100 sheets £10.99
7x5 100 sheets £13.99
A4 50 sheets £13.99
A3 25 sheets £17.99
A3+ 25 sheets £22.99
13” Roll 10 metres £24.99
17” Roll 30 metres £42.99
24” Roll 30 metres £58.99
Matt Proofing 160gsm:
A4 150 sheets £18.99
A3 75 sheets £22.99
17” Roll 30 metres £26.99
24” Roll 30 metres £36.99
Double Sided Matt 250gsm:
A4 100 sheets £24.99
A3 50 sheets £27.99
Fine Art / Fibre Base Papers:
FB Gold Silk A4 25 sh £23.99
FB Gold Silk A3 25 sh £47.99
FB Distinction A4 25 sh £25.99
FB Distinction A3 25 sh £48.99
FB Royal A4 25 sheets £28.99
FB Royal A3 25 sheets £56.99
FB Gloss A4 25 sheets £26.99
FB Gloss A3 25 sheets £51.99
FB Matt A4 25 sheets £19.99
FB Matt A3 25 sheets £38.99
Artist A4 25 sheets £22.99
Artist A3 25 sheets £39.99
Museum A4 25 sheets £25.99
Museum A3 25 sheets £48.99
Parchment A4 25 sheets £22.99
Parchment A3 25 sheets £39.99
Omega A4 25 sheets £24.99
Omega A3 25 sheets £46.99
Portrait A4 25 sheets £26.99
Portrait A3 25 sheets £53.99
Portrait White A4 25 sh £26.99
Portrait White A3 25 sh £49.99

Premium Gloss 255gsm:
6x4 40 sheets +40 FREE £9.99
7x5 30 sheets £9.99
A4 15 sheets +15 FREE £9.99
A3 20 sheets £29.99
A3+ 20 sheets OFFER £24.99
Ultra Gloss 300gsm:
6x4 50 sheets £9.99
7x5 50 sheets £12.99
A4 15 sheets £11.99
Premium Semi-Gloss 251gsm:
6x4 50 sheets £8.99
A4 20 sheets £14.99
A3 20 sheets £29.99
A3+ 20 sheets OFFER £24.99
Archival Matte 192gsm:
A4 50 sheets £14.99
A3 50 sheets £33.99
A3+ 50 sheets £44.99
Heavyweight Matte 167gsm:
A4 50 sheets £11.99
A3 50 sheets £34.99
A3+ 50 sheets £44.99

Originals:
No.38 Colours 27ml each £26.99
No.62XL Black 12ml £21.99
No.62XL Colour 11.5ml £23.99
No.300 Black 4ml £10.99
No.300 Colour 4ml £12.99
No.301 Black 3ml £9.99
No.301 Colour 3ml £11.99
No.301XL Black 8ml £18.99
No.301XL Colour 6ml £18.99
No.350 Black 4.5ml £11.99
No.351 Colour 3.5ml £14.99
No.363 Black 6ml £13.99
No.363 C/M/Y/PC/PM each £9.99
No.363 SET OF 6 £39.99
No.364 Black 6ml £7.99
No.364 PB/C/M/Y 3ml each £6.99
No.364 SET OF 4 £21.99
No.364XL Black 14ml £13.99
No.364XL PB/C/M/Y 6ml each£12.99
No.364XL SET OF 4 £49.99
No.920XL SET OF 4 £46.99
No.932XL SET OF 4 £43.99
No.950XL SET OF 4 £69.99

Compatibles:
No.15 Black 46ml £4.99
No.21 Black 10ml £7.99
No.22 Colour 21ml £11.99
No.45 Black 45ml £4.99
No.56 Black 24ml £9.99
No.57 Colour 24ml £12.99
No.78 Colour 36ml £9.99
No.110 Colour 12ml £10.99
No.300XL Black 18ml £14.99
No.300XL Colour 18ml £16.99
No.301XL Black 15ml £14.99
No.301XL Colour 18ml £16.99
No.337 Black 21ml £10.99
No.338 Black 21ml £10.99
No.339 Black 34ml £12.99
No.343 Colour 21ml £12.99
No.344 Colour 21ml £14.99
No.348 Photo 21ml £12.99
No.350XL Black 30ml £14.99
No.351XL Colour 20ml £16.99
No.363 Black 20ml £6.99
No.363 Colours 6ml each £4.99
No.363 SET OF 6 £24.99
No.364 Black 10ml £4.99
No.364 Colours 5ml each £3.99
No.364 SET OF 4 £15.99
No.364XL Black 18ml £8.99
No.364XL Colours 11ml each £7.99
No.364XL SET OF 4 £31.99
No.920XL SET OF 4 £19.99
No.932XL SET OF 4 £29.99
No.940XL SET OF 4 £29.99
No.950XL SET OF 4 £29.99

T0711-T0714
Cheetah Inks
Originals:
Set of 4 £32.99
Black 7.4ml £8.99
Colours 5.5ml each £8.99
Compatibles:
Set of 4 £14.99
Black 7.4ml £4.99
Colours 5.5ml each £3.99

T0791-T0796
Owl Inks
Originals:
Set of 6 £72.99
Colours 11.1ml each £12.99
Compatibles:
Set of 6 £19.99
Colours 11.1ml each £3.99

T0801-T0806
Hummingbird Inks
Originals:
Set of 6 £49.99
Colours 7.4ml each £8.99
Compatibles:
Set of 6 £19.99
Colours 7.4ml each £3.99

T0871-T0879
Flamingo Inks
Originals:
Set of 8 £66.99
Colours 11.4ml each £9.99
Compatibles:
Set of 8 £27.99
Colours 11.4ml each £3.99

T0961-T0969
Husky Inks
Originals:
Set of 8 £69.99
Colours 11.4ml each £8.99
Compatibles:
Set of 8 £27.99
Colours 11.4ml each £3.99

T1571-T1579
Turtle Inks
Originals:
Set of 8 £149.99
Colours 25.9ml each £18.99

T7601-T7609
Killer Whale
Originals:
Set of 9 £169.99
Colours 25.9ml each £18.99

Photo Papers
We carry a massive range of papers (sheets & rolls) at competitive 
prices. Below are some examples of the selection we stock. 

Grace Albums
Available in 

Burgundy 
or Blue.

Travel 
Albums
Over a dozen 
designs in stock.

Grafton
Albums

Available in 
Burgundy 

or Blue.

Emilia Frames
Distressed wood 
shabby chic 
effect. 
Blue or White.

Rio Frames
Handcrafted solid wood with 

30mm wide profile, in four 
colours.

Baby
Albums
Multiple 
different 
designs 
available.

Frisco Frames
Simple, 
basic design 
available in a 
huge range 
of sizes & 
colours. 

“Jet Tec’s colours were superb, with 
single greys and blacks very close to 

Epson... so Jet Tec wins!”
- Total Digital Photography Magazine

“What we’re looking at here is not only 
the best choice of ink for the R300 

printer, but also the best choice of ink 
in this group test, period. There’s just 

no getting away from the superb com-
bination of performance and pricing.”

- Computer Upgrade Magazine

Ink Test 
Winner

PGi29
Pixma Pro 1
Originals:
Set of 12 £229.99
Colours 36ml each £19.99

PGi72
Pixma Pro 10
Originals:
Set of 10 £94.99
Colours 14ml each £9.99

CLi42
Pixma Pro 100
Originals:
Set of 8 £74.99
Colours 13ml each £9.99
Compatibles:
Set of 8 £27.99
Colours 14ml each £3.99

CLi8
Pixma Pro 9000
Originals:
Set of 8 £74.99
Colours 14ml each £9.99
Compatibles:
Set of 8 £27.99
Colours 14ml each £3.99

PGi9
Pixma Pro 9500
Originals:
Set of 10 £84.99
Colours 14ml each £8.99
Compatibles:
Set of 10 £44.99
Colours 14ml each £4.99

More Canon Inks...
Originals:
PGi520/CLi521 Set of 5 £42.99
PGi520 Black 19ml £9.99
CLi521 Colours 9ml £8.99
PGi525/CLi526 Set of 5 £42.99
PGi525 Black 19ml £9.99
CLi526 Colours 9ml £8.99
PGi550/CLi551 Set of 5 £37.99
PGi550 Black 15ml £9.99
CLi551 Colours 7ml £7.99
PGi550/CLi551XL Set of 5 £54.99
PGi550XL Black 22ml £11.99
CLi551XL Colours 11ml £10.99
PG540 Black 8ml £10.99
PG540XL Black 21ml £15.99
CL541 Colour 8ml £13.99
CL541XL Colour 15ml £15.99
PG545XL Black 15ml £13.99
CL546XL Colour 13ml £15.99
Compatibles:
PGi5 Black 27ml £4.99
CLi8 Colours 13ml £3.99
PGi5/CLi8 Set of 5 £19.99
PGi520 Black 19ml £4.99
CLi521 Colours 9ml £3.99
PGi520/CLi521 Set of 5 £19.99
PGi525 Black 19ml £4.99
CLi526 Colours 9ml £3.99
PGi525/CLi526 Set of 5 £19.99
PGi550XL Black 25ml £4.99
CLi551XL Colours 12ml £3.99
PGi550/CLi551XL Set of 5 £19.99
BCi6 Colours 15ml £2.99
PG40 Black 28ml £12.99
CL41 Colour 24ml £16.99
PG50 Black 28ml £12.99
CL51 Colour 24ml £14.99
PG510 Black 11ml £13.99
CL511 Colour 11ml £15.99
PG512 Black 18ml £13.99
CL513 Colour 15ml £15.99
PG540XL Black 21ml £13.99
CL541XL Colour 15ml £14.99
PG545XL Black 15ml £11.99
PG546XL Black 21ml £12.99

Many more in stock! Many more in stock!More Epson inks >>>

No.16
Fountain Pen Inks
Originals:
No.16 Set of 4 £22.99
No.16 Black 5.4ml £7.99
No.16 Colours 3.1ml each £5.99
No.16XL Set of 4 £42.99
No.16XL Black 12.9ml £14.99
No.16XL Colours 6.5ml each £11.99
Compatibles:
No.16 Set of 4 £14.99
No.16 Black 12ml £3.99
No.16 Colours 12ml each £3.99

No.18
Daisy Inks
Originals:
No.18 Set of 4 £22.99
No.18 Black 5.2ml £7.99
No.18 Colours 3.3ml each £5.99
No.18XL Set of 4 £42.99
No.18XL Black 11.5ml £14.99
No.18XL Colours 6.6ml each £11.99
Compatibles:
No.18 Set of 4 £14.99
No.18 Black 12ml £3.99
No.18 Colours 12ml each £3.99

No.24
Elephant Inks
Originals:
No.24 Set of 6 £41.99
No.24 Colours 4.6ml each £7.99
No.24XL Set of 6 £64.99
No.24XL Colours 8.7ml each £11.99
Compatibles:
No.24 Set of 6 £22.99
No.24 Black 7ml £3.99
No.24 Colours 7ml each £3.99

No.26
Polar Bear Inks
Originals:
No.26 Set of 4 £29.99
No.26 Black 6.2ml £8.99
No.26 Colours 4.5ml each £7.99
No.26XL Set of 4 £49.99
No.26XL Black 12.1ml £14.99
No.26XL Colours 9.7ml each £13.99
Compatibles:
No.26 Set of 4 £14.99
No.26 Black 10ml £3.99
No.26 Colours 7ml each £3.99

T0481-T0486
Seahorse Inks
Originals:
Set of 6 £69.99
Colours 13ml each £16.99
Compatibles:
Set of 6 £19.99
Colours 13ml each £3.99

T0541-T0549
Frog Inks
Originals:
Set of 8 £105.99
Colours 13ml each £14.99
Compatibles:
Set of 8 £27.99
Colours 13ml each £3.99

T0591-T0599
Lily Inks
Originals:
Set of 8 £89.99
Colours 13ml each £11.99
Compatibles:
Set of 8 £27.99
Colours 13ml each £3.99



Orders are shipped promptly by Royal Mail 1st class post, for which we charge just £1.99 per 
order. All prices include VAT, and a full VAT receipt is provided with every order. Payment 
accepted credit/debit card, cheque or postal order. Orders accepted securely online, 
www.premier-ink.co.uk, over the telephone 01926 339977, by post, or by visiting our shop: 
Premier Ink & Photographic, Longfield Road, Sydenham Ind Estate, Leamington Spa CV31 1XB.

Lowering the cost of photography

01926 339977   www.premier-ink.co.uk

www.premier-ink.co.uk    Telephone: 01926 339977 or 0800 1077 211    Premier Ink & Photographic 12 Longfield Road, Leamington Spa, Warwickshire CV31 1XB E&EO. Prices may be subject to change, but hopefully not!

Straps & Accessories

Tripods & Monopods

The ingenious 
Peak Design 
Clutch, Slide, 
Leash, Cuff & 
Capture Clip 

System. Entire 
range in stock. 

Sling Straps 
from £29.99

Manfrotto
Carbon Fibre Monopod

Only £59

Action Cameras

A massive range of GoPro 
Cameras, Batteries, Memory 

Cards and Accessories in stock 
at competitive prices!

Genuine GoPro
Hero £CALL US
Hero+ £CALL US
Hero3+ Black £CALL US
Hero4 Silver £CALL US
Hero4 Black £CALL US
Hero4 Session £CALL US
Battery Hero3+ £14
Battery Hero4 £14
Dual Charger Hero3+ £25
Dual Charger Hero4 £39
Battery BacPac £39
LCD Touch BacPac £59
Blackout Housing £39
Tripod Mounts £7
Chest Harness £29
Head Strap £14
Helmet Strap £12
Handlebar Mount £14
The Handler £21

Camera Bags

™

Entire range of 
ThinkTank bags 
in stock, from 

just £25.99

Mind Shift bags 
from £27

A big range of Billingham bags 
starting at £109

NEW Manfrotto 
190 & 055 tripods 

from just £149

Triad 30 
Tripod with 

BH30 
Ball Head 
Only £39

Replacement rechargeable 
Li-ion batteries, manufactured 
by Hahnel or Blumax. All come 
with a two-year guarantee. 

NB-2L/LH for Canon £9.99
NB-4L for Canon £9.99
NB-5L for Canon £9.99
NB-6L for Canon £9.99
NB-7L for Canon £9.99
NB-9L for Canon £9.99
NB-10L for Canon £12.99
NB-11L for Canon £12.99
BP-511 for Canon £12.99
LP-E5 for Canon £9.99
LP-E6 for Canon £16.99
LP-E8 for Canon £12.99
LP-E10 for Canon £12.99
LP-E12 for Canon £12.99
NP45 for Fuji £9.99
NP50 for Fuji £9.99
NP95 for Fuji £9.99
NPW126 for Fuji £12.99
NP400 for Fuji £12.99
EN-EL3E for Nikon £14.99
EN-EL5 for Nikon £9.99
EN-EL9 for Nikon £12.99
EN-EL10 for Nikon £9.99
EN-EL11 for Nikon £9.99
EN-EL12 for Nikon £9.99
EN-EL14 for Nikon £19.99
EN-EL15 for Nikon £24.99
EN-EL19 for Nikon £12.99
EN-EL20 for Nikon £12.99
EN-EL21 for Nikon £12.99
Li10B/12B for Olympus £9.99
Li40B/42B for Olympus £9.99
Li50B for Olympus £9.99
BLM-1 for Olympus £12.99
BLN-1 for Olympus £24.99
BLS-1 for Olympus £12.99
BLS-5 for Olympus £15.99
CGR-S006 for Panasonic £9.99
CGA-S007 for Panasonic £9.99
DMW-BCG10 Panasonic £19.99
DMW-BCM13 Panasonic £19.99
DMW-BLB13 Panasonic £27.99
DMW-BLC12 Panasonic £23.99
DMW-BLD10 Panasonic £23.99
DMW-BLG10 Panasonic £22.99
DMW-BMB9 Panasonic £22.99
D-Li90 for Pentax £12.99
D-Li109 for Pentax £12.99
SLB-1137D for Samsung £9.99
SLB-1674 for Samsung £12.99
BG-1 for Sony £19.99
BX-1 for Sony £14.99
BY-1 for Sony £12.99
NP-FM500H for Sony £19.99
NP-FH50 for Sony £19.99
NP-FW50 for Sony £24.99

Battery Chargers
Universal Chargers
Unipal ORIGINAL £19.99
Unipal PLUS £24.99
Unipal EXTRA £29.99

AA & AAA Chargers
Hahnel TC Novo inc. 4xAA £8.99
Energizer Pro inc. 4xAA £14.99
Energizer 1 Hr inc. 4xAA £22.99

Other Batteries
Pre-Charged Rechargables
AA GP Recyko 3+1 FREE £5.24
AAA GP Recyko 3+1 FREE £5.24
AA Energizer Extreme (4) £8.99
AAA Energizer Extreme (4) £6.99

Standard Rechargeables
AA GP 2600mAh (4) £9.99
AA Lloytron 1300mAh (4) £3.99
AA Lloytron 2700mAh (4) £6.99
AAA Lloytron 1100mAh (4) £3.99

Lithium Batteries
AA Energizer Ultimate (4) £5.99
AAA Energizer Ultimate (4) £5.99
CR123A Energizer (1) £1.99
CR2 Energizer (1) £1.99
2CR5 Energizer (1) £3.99
CRP2 Energizer (1) £3.99
CRV3 Energizer (1) £5.99
A544 Energizer Alkaline (1) £1.99
A23 Energizer Alkaline (1) £1.99
LR44 Energizer Alkaline (2) £1.99
CR2025, CR2032 etc £1.99

Batteries

Battery Grips
Professional battery 
grips, made by 
Hahnel.
5DMkII for Canon £84.99
5DMkIII for Canon £84.99
6D for Canon £84.99
7D for Canon £84.99
70D for Canon £84.99
650D/700D for Canon £84.99
D600 for Nikon £84.99
D800/D810 for Nikon £84.99
D3300/D5300 for Nikon £74.99
D7100 for Nikon £84.99

Compact Flash
Lexar Professional
800X (120MB/s)
8GB £19.99
16GB £27.99
32GB £36.99
64GB £56.99

1066X (160MB/s)
16GB £33.99
32GB £56.99
64GB £99.99
128GB £192.99

Sandisk Ultra
333X (50MB/s)
8GB £11.99
16GB £15.99
32GB £24.99

Sandisk Extreme
800X (120MB/s)
16GB £26.99
32GB £32.99
64GB £47.99
128GB £94.99

Sandisk Extreme Pro
1066X (160MB/s)
16GB £33.99
32GB £47.99
64GB £82.99
128GB £149.99

XQD Cards
Lexar Professional
1333X (200MB/s)
32GB £69.99
64GB £99.99

MicroSDHC & SDXC
Lexar Professional
633X (95MB/s)
32GB £21.99
64GB £43.99

Delkin Professional
375X (56MB/s)
32GB £16.99
64GB £32.99

Sandisk Ultra
320X (48MB/s)
16GB £6.99
32GB £12.99
64GB £24.99

The full range of Sandisk and 
Lexar memory cards at very 
competitive prices.

SDHC & SDXC
Lexar Professional
633X (95MB/s)
16GB £8.99
32GB £15.99
64GB £27.99
128GB £54.99

1000X (150MB/s)
16GB £14.99
32GB £22.99
64GB £35.99
128GB £63.99

2000X (300MB/s)
32GB £51.99
64GB £95.99

Sandisk Blue
33X (5MB/s)
4GB £3.49
8GB £3.99
16GB £5.99

Sandisk Ultra
266X (40MB/s)
8GB £4.99
16GB £6.99
32GB £12.99
64GB £24.99

Sandisk Extreme
400X (60MB/s)
16GB £10.99
32GB £17.99
64GB £34.99

Sandisk Extreme Pro
633X (95MB/s)
16GB £17.99
32GB £23.99
64GB £42.99
128GB £82.99

1866X (280MB/s)
16GB £49.99
32GB £79.99
64GB £129.99

Readers & Cases
Lexar USB3 Card Reader £22.99
Lexar HR1 Workflow Hub £49.99
Delkin USB2 Card Reader £9.99
Delkin USB3 Card Reader £19.99
Delkin SD Card (x8) Case £6.99
Delkin CF Card (x4) Case £6.99

Memory

EVO3
IS HERE

Vyv £149
Rick £199
Brian £349

KOOD Slim Frame
UV Filters
37mm £4.99
40.5mm £4.99
46mm £4.99
49mm £4.99
52mm £4.99
55mm £5.99
58mm £6.99
62mm £7.99
67mm £8.99
72mm £9.99
77mm £11.99
82mm £14.99
86mm £19.99

KOOD Slim Frame
Circular Polarisers
37mm £12.99
40.5mm £12.99
46mm £12.99
49mm £12.99
52mm £14.99
55mm £15.99
58mm £17.99
62mm £19.99
67mm £22.99
72mm £26.99
77mm £29.99
82mm £34.99
86mm £39.99

KOOD
ND4 & ND8 Filters
52mm £26.99
58mm £34.99

Marumi DHG Slim 
Frame Multi-coated
Clear Protectors
37mm £10.99
43mm £10.99
46mm £10.99
49mm £10.99
52mm £10.99
55mm £11.99
58mm £12.99
62mm £14.99
67mm £15.99
72mm £17.99
77mm £19.99
82mm £22.99

Marumi DHG Slim 
Frame Multi-coated
UV Filters
52mm £13.99
58mm £15.99
62mm £17.99
67mm £19.99
72mm £21.99
77mm £24.99

Marumi DHG Slim 
Frame Multi-coated
Circular Polarisers
52mm £31.99
58mm £35.99
62mm £39.99
67mm £44.99
72mm £49.99
77mm £54.99
82mm £69.99

Hoya HMC 
Slim Frame
UV Filters
37mm £12.99
40.5mm £12.99
46mm £12.99
49mm £11.99
52mm £11.99
58mm £14.99
62mm £16.99
67mm £18.99
72mm £21.99
77mm £25.99
82mm £29.99

HOYA Pro-1D Slim 
Frame Multi-coated
Clear Protectors
52mm SPECIAL £16.99
58mm £28.99
62mm £31.99
67mm £35.99
72mm £39.99
77mm SPECIAL £29.99
82mm £49.99

HOYA Pro-1D Slim 
Frame Multi-coated
Circular Polarisers
52mm £52.99
58mm £60.99
62mm £67.99
67mm £75.99
72mm £90.99
77mm SPECIAL £79.99
82mm £120.99

Filters
One of the largest ranges of screw-in threaded 
filters in the UK, from Hoya, Kood and Marumi. 
We carry sizes from 24mm, up to 105mm, and offer Clear 
Protectors, UVs, Skylights, Circular Polarisers, ND4s, ND8s, ND16s, 
ND32s, ND64s, ND500s, ND1000s, Variable NDs, Starbursts, Close 
Up Sets and more! Below are just a few examples...

Square Filters
We stock three widths of square filters: 
A-type (67mm wide), P-Type (84mm wide) 
and Z-Type (100mm wide). Made in the UK, Kood square filters 
are optically flat, with excellent colour density, neutrality and 
stability. They received a maximum 5 star rating from Digital 
Camera Magazine.

P-Type: 84mm wide filters

Standard Holder £5.99
Wide Angle Holder £6.99
Filter Wallet for 8 filters £9.99
Adapter Rings 49-82mm £4.99
Circular Polariser £27.99
ND2 Solid £12.99
ND2 Soft Graduated £13.99
ND2 Hard Graduated £13.99
ND4 Solid £12.99
ND4 Soft Graduated £13.99
ND4 Hard Graduated £13.99
ND8 Solid £14.99
ND8 Soft Graduated £15.99
ND8 Hard Graduated £15.99
Light Blue Graduated £12.99
Dark Blue Graduated £12.99
Light Tobacco Graduated £12.99
Dark Tobacco Graduated £12.99
Light Sunset Graduated £14.99
Dark Sunset Graduated £14.99
Starbursts x4, x6, x8 £17.99
Red/Green/Yellow each £14.99
Six-piece ND Filter Kit £59.99
A popular kit containing an ND2, ND2 
Soft Grad, ND4, ND4 Soft Grad, Filter 
Holder, plus Adapter Ring of your 
choice (49-82mm).

Z-Type: 100mm wide filters

Pro Holder £24.99
Adapter Rings 52-95mm £8.99
ND2 Solid £16.99
ND2 Soft Graduated £17.99
ND2 Hard Graduated £17.99
ND4 Solid £16.99
ND4 Soft Graduated £17.99
ND4 Hard Graduated £17.99
ND8 Solid £18.99
ND8 Soft Graduated £19.99
ND8 Hard Graduated £19.99
Light Blue Graduated £17.99
Dark Blue Graduated £17.99
Light Tobacco Graduated £17.99
Dark Tobacco Graduated £17.99
Light Sunset Graduated £18.99
Dark Sunset Graduated £18.99

A-Type: 67mm wide filters
Standard Holder £4.99
Adapter Rings 37-62mm £8.99
ND2 Solid £10.99
ND2 Graduated £11.99
ND4 Solid £10.99
ND4 Graduated £11.99
ND8 Solid £11.99
ND8 Graduated £12.99

Bayonet-Fit Lens Hoods
ES-62 Canon 50/1.8 £9.99
ES-71II Canon 50/1.4 £9.99
ET-60 Canon 75-300/4-5.6 £9.99
ET-65B Canon 70-300/4-5.6 £9.99
ET-67 Canon 100/2.8 Macro £9.99
ET-67B Canon 60/2.8 £9.99
EW-60C Canon 18-55 IS £7.99
EW-63C Canon 18-55 IS STM £9.99
EW-73B Canon 18-55 IS £9.99
EW-78BII Canon 28-135 IS £9.99
EW-78D Canon 18-200 IS £9.99
EW-78E Canon 15-85 IS £12.99
EW-83E Canon 17-40/4.0 £12.99
HB-32 Nikon 18-105 VR £7.99
HB-45 Nikon 18-55 VR £7.99

Stepping Rings
25mm to 105mm
160 different sizes           £4.99-5.99

Reversing Rings
52mm to 77mm
Canon, Nikon, Sony, Olympus 
and Pentax                       £9.99-19.99

Coupling Rings
49mm-77mm         £9.99-£11.99

Screw-Fit Lens Hoods
37mm Rubber Hood £3.99
40.5mm Rubber Hood £3.99
43mm Metal Hood £5.99
46mm Rubber Hood £3.99
46mm Metal Hood £5.99
49mm Rubber Hood £3.99
49mm Shaped Petal Hood £6.99
52mm Rubber Hood £3.99
52mm Shaped Petal Hood £6.99
55mm Rubber Hood £3.99
55mm Shaped Petal Hood £6.99
58mm Rubber Hood £3.99
58mm Shaped Petal Hood £6.99
62mm Rubber Hood £4.99
62mm Shaped Petal Hood £7.99
67mm Rubber Hood £4.99
67mm Shaped Petal Hood £7.99
72mm Rubber Hood £5.99
72mm Shaped Petal Hood £9.99
77mm Rubber Hood £5.99
77mm Shaped Petal Hood £9.99

Lens Caps
Lens Caps Centre-Pinch £2.99
Body & Rear Lens Caps £3.99

Lens Accessories

From 
£15.99

Neoprene 
Straps 

from £11.99

Manfrotto 
XPRO 
3 Way 
Head £99



Finance example: 12mths, 0% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £110.62, Total Amount Payable £1475. • 24mths, 9.9% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £60.93, Total Amount Payable £1608.82
36mths, 19.5% APR: Cash Price £1475, 10% Deposit £147.50, Monthly Payment £47.95, Total Amount Payable £1873.70 See website for details: www.uttings.co.uk/Information/Finance. Finance is subject to status, terms & conditions apply.*

*Consumer credit service provided by Pay4Later in association with Close Brothers Retail Finance. Pay4Later is licensed by the Financial Conduct Authority (Consumer Credit Licence: 0616240) Finance provided by Close Brothers Retail Finance is a trading name of Close Brothers Limited10 Crown Place, London EC2A 4FT.
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See website for Remotes, Batteries &   Chargers

See website for more lenses

See our website for full details & specifications



130  PRACTICAL PHOTOGRAPHY

Thestorybehindtheshot
Melanie 

Kern-Favilla is a 

locomotive 

engineer based in 

New York. She 

caught the 

photography bug while chasing 

severe weather across the Great 

Plains in 2005. Although her 

speciality is floral, macro and 

storm photography, she tends to 

shoot anything that captures her 

interest. Her long-term goal is to 

have her work shown in a gallery. 

mkfphotos.com

l i’ve always been a bit of a pack rat. i tend to 
save items of interest until I grow weary of them, 
and then I toss them away in a fit of urgency. That 
pack rat mentality is how I came to produce this 
image. It was created not with a camera and lens, 
but with a flatbed scanner. Creating images with a 
scanner (also known as scanography) gives the 
photographer the ability to structure subjects in 
such a way that wouldn’t be possible with a 
standard setup. The photographer has total control 
of subject placement, and there’s a real onus on 
precision and attention to detail. The scanner also 
provides a soft quality of light that can be 
challenging to achieve in a studio environment. 

I usually scan fresh flowers, trying to capture 
every detail as I see it in my mind. Once I’m done 
scanning the flowers, I don’t have much use for 
them, as the stems are usually removed for 
scanning. But how can I just throw away something 
so beautiful? So I put them in a box on my desk – 
surely I could find a use for them later. Normally, 
this would be a ridiculous notion, as there’s not 
much use for dead flowers. But on this day, 
I decided to go through my box of decaying flora.  
I found that the skeletal remains of these flowers 
had a unique beauty, and I didn’t want them to have 
died in vain – I wanted to showcase their beauty! 
When scanning, you have to visualise in reverse 
because you can’t see what the scanner is seeing. 

This is a challenge for me, so I often have to produce 
multiple scans before I find an arrangement that 
works. This was the case on this occasion and I 
produced several scans with different arrangements 
before settling on this pattern. 

When scanning flowers, every movement you 
make creates a dust storm of pollen on the scanner 
glass. This is especially true when working with 
dead flowers, as they’re very brittle – the slightest 
tap of the stamen yields a flurry of pollen. One must 
be fastidious when scanning dead flowers, but that 
personality trait isn’t a part of my DNA, so I spend 
a decent amount of time in Photoshop cleaning the 
black background. This image in particular was a 
full-bed scan, so it took quite a bit of time to tidy up. 
I duplicate my Background Layer in Photoshop, 
select the Dust & Scratches option and then mask 
the flowers back in at full opacity. I also want a 
near-black background, so I select the flowers, 
invert the selection and create a Curves Adjustment 
Layer, dropping the shadows down to black. I then 
spend time with the Spot Healing Brush and 
Content Aware Fill, fixing any small areas on the 
flowers themselves.

I’ve had mixed responses to this image. Some 
love the detail and layout, while one person told me 
that the image makes them sad and reminds them 
of death. I suppose if my image evokes a feeling, 
even a negative one, then I’ve done my job. 

“If my image 
evokes a 

feeling, even  
a negative 

one, then I’ve 
done my job”

Melanie Kern-Favilla creates eye-catching images using a flatbed scanner...






